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Searching — People

The Search dialog box will appear whenever you click . It will also appear if you select Search 
Directory from the Edit Menu. The People tab of the dialog box will allow you to look for people within the 
directory.

The Search dialog box will look slightly different depending on where you opened it from. There are three 
different versions of the Search dialog box:

· Single User Selection: This version of the Search dialog box opens when you click  in a dialog 
box where you can only select one person or resource (for example, when you want to search for a 
user name in the Open an Agenda dialog box).

· Multiple User Selection: This version opens when you click  in a dialog box where you can select 
several people or resources (for example, when you are using a People/Resources list, which can be 
found in many dialog boxes).

· Directory Search: This version opens when you choose Search Directory from the Edit Menu. In this 
case, you can only inform yourself about people and resources in your system.

Single User Selection

When you have chosen to search in a dialog box where you can only select one user (such as the Sign-in 
dialog box, or the Open an Agenda dialog box), the bottom half of the Search dialog box will look like this:

To search for and select a person, use the People tab of the dialog box and follow the steps below.

1. Type the person's last name. You do not have to type the whole name—a few letters are normally 
enough. If you don't type in any characters, your Agenda may give you the entire directory list. On 
some systems, however, you may get the message, "Surname string too short", in which case you will 
need to enter a few letters to start your search.

You can also use any other search parameter, such as Organization unit, or domain.

2. Choose Search. The result of your search will then be listed in the Found list box.

· Those users appearing with an (F) next to their name are foreign users. They don't have an 
Agenda. You can still invite them to Entries—they will receive an e-mail notice of the invitation.



· Those users appearing with an (R) or other notes in brackets next to their name are remote 
users. They are on a different server. Often the note in brackets will indicate on what server or in 
what department the user is located.

· You can print the result of your search by choosing Print.
· To find out more about a person, highlight the person's name in the list box and choose 

Information.
· If your Agenda finds more than 100 people, only a hundred names at a time will be listed. You can 

use the double arrow buttons next to the Search button to toggle back and forth between the lists 
of the first hundred names, the second hundred names and so on.

3. To select a person, highlight the person's name in the Found list box and choose OK.

Multiple User Selection

When you have chosen to search in a dialog box where you can select several users (for example, on the 
General tab of the New Agenda Entry dialog box), the bottom half of the Search dialog box will look like 
this:

To search for and select one or several persons, use the People tab of the dialog box and follow the steps 
below.

1. Type in one or more search parameters, such as a name, an Organization unit, or a domain. 
If you choose to use a name as your search parameter, you do not have to type the whole name—a 
few letters are normally enough. If you don't type in any characters, your Agenda may give you the 
entire directory list. On some systems, however, you may get the message, "Surname string too 
short", in which case you will need to enter a few letters to start your search.

2. Choose Search. The result of your search will then be listed in the Found list box.

· Those users appearing with an (F) next to their name are foreign users. They don't have an 
Agenda. You can still invite them to Entries—they will receive an e-mail notice of the invitation.

· Those users appearing with an (R) or other notes in brackets next to their name are remote 
users. They are on a different server. Often the note in brackets will indicate on what server or in 
what department the user is located.

· To find out more about a person, highlight the person's name in the list box and choose 
Information. 

· If your Agenda finds more than 100 people, only a hundred names at a time will be listed. You can 
use the double arrow buttons next to the Search button to toggle back and forth between the lists 
of the first hundred names, the second hundred names and so on.

3. To select users, highlight their names in the Found list box and click Add. The selected names will 



then appear in the Selected list box to the right.

· You can highlight more than one name in the Found list box. To highlight a number of consecutive 
names in the list, hold down the Shift key and click the first and the last of the names. To highlight 
a number of non-consecutive names, hold down the Ctrl key when you click them. Once all the 
names that you want to select are highlighted, click Add.

· If you want to select all the listed names, choose Add All.
· You can also remove names that you have added. Highlight the name in the Selected list box and 

choose Remove.
· You can print a list of the people and resources that you have selected so far by choosing Print.

4. When you have finished working on the People tab in the Multiple User version of the Search dialog 
box, you can go on to the other tabs to select resources and groups. The people that you have 
selected on this tab of the dialog box will remain listed in the Selected list box throughout, unless you 
remove them (which you can still do while working on another tab in the dialog box).

5. Once all the people and resources that you want to select are listed in the Selected list box, choose 
OK, and they will automatically be included on the list of people/resources that you were working on 
when you opened the Search dialog box.

Directory Search

When you have opened the Search dialog box with the command Search Directory from the Edit Menu, 
the bottom half of the dialog box will look like this:

In this version of the Search dialog box you can not select a person's name to use it in a list or an edit 
box. The Search Directory command simply gives you quick access to the System Directory, so that you 
can inform yourself about the people, resources and groups on your system.

To search for a person, use the People tab of the dialog box and follow the steps below.

1. Type the person's last name. You do not have to type the whole name—a few letters are normally 
enough. If you don't type in any characters, your Agenda may give you the entire directory list. On 
some systems, however, you may get the message, "Surname string too short", in which case you will 
need to enter a few letters to start your search.

You can also use any other search parameter, such as Organization unit, or domain.

2. Choose Search. The result of your search will then be listed in the Found list box.

· Those users appearing with an (F) next to their name are foreign users. They don't have an 



Agenda. You can still invite them to Entries—they will receive an e-mail notice of the invitation.
· Those users appearing with an (R) or other notes in brackets next to their name are remote 

users. They are on a different server. Often the note in brackets will indicate on what server or in 
what department the user is located.

· You can print the result of your search by choosing Print.
· To find out more about a person, highlight the person's name in the list box and choose 

Information. 
· If your Agenda finds more than 100 people, only a hundred names at a time will be listed. You can 

use the double arrow buttons next to the Search button to toggle back and forth between the lists 
of the first hundred names, the second hundred names and so on.

3. Choose Done when you are done with your Directory Search

See Also:

Searching — Resources 
Searching — Groups 
Selecting Several Users



Searching — Resources

The Search dialog box will appear whenever you click . It will also appear if you select Search 
Directory from the Edit Menu. The Resource tab of the dialog box will allow you to look for resources 
within the directory.

The Search dialog box will look slightly different depending on where you opened it from. There are three 
different versions of the Search dialog box:

· Single User Selection: This version of the Search dialog box opens when you click  in a dialog 
box where you can only select one person or resource (for example, when you want to search for a 
user name in the Open an Agenda dialog box).

· Multiple User Selection: This version opens when you click  in a dialog box where you can select 
several people or resources (for example, when you are using a People/Resources list, which can be 
found in many dialog boxes).

· Directory Search: This version opens when you choose Search Directory from the Edit Menu. In this 
case, you can only inform yourself about people and resources in your system.

Single User Selection

When you have chosen to search in a dialog box where you can only select one user (such as the Sign-in 
dialog box, or the Open an Agenda dialog box), the bottom half of the Search dialog box will look like this:

To search for and select a resource, use the Resources tab of the dialog box and follow the steps below.

1. Type the resource's name or number as the search parameter.
You do not have to type the whole name—a few letters are normally enough. Your Agenda will also 
accept searches for resources without search parameters. If you don't type in any characters, your 
Agenda will list all available resources.

2. Select the Local resources only check box if you don't want to display remote resources.

3. Choose Search. The result of your search will then be listed in the Found list box.

· Those resources appearing with an (R) or other notes in brackets next to their name are remote 
resources. They are on a different server. Often the note in brackets will indicate on what server 



or in what department the resource is located.
· You can print the result of your search by choosing Print.
· To find out more about a resource, highlight the resource's name in the list box and choose 

Information.

4. To select a resource, highlight the resource's name in the Found list box and choose OK.

Multiple User Selection

When you have chosen to search in a dialog box where you can select several users (for example, on the 
General tab of the New Agenda Entry dialog box), the bottom half of the Search dialog box will look like 
this:

To search for and select one or several resources, use the Resources tab of the dialog box and follow the 
steps below.

1 Type a resource's name or number as the search parameter.
You do not have to type the whole name—a few letters are normally enough. Your Agenda will also 
accept searches for resources without search parameters. If you don't type in any characters, your 
Agenda will list all available resources.

2. Select the Local resources only check box if you don't want to display remote resources.

3. Choose Search. The result of your search will then be listed in the Found list box.

· Those resources appearing with an (R) or other notes in brackets next to their name are remote 
resources. They are on a different server. Often the note in brackets will indicate on what server 
or in what department the resource is located.

· To find out more about a resource, highlight the resource's name in the list box and choose 
Information.

4. To select resources, highlight their names in the Found list box and click Add. The selected names 
will then appear in the Selected list box to the right.

· You can highlight more than one name in the Found list box. To highlight a number of consecutive 
names in the list, hold down the Shift key and click the first and the last of the names. To highlight 
a number of non-consecutive names, hold down the Ctrl key when you click them. Once all the 
names that you want to select are highlighted, click Add.

· If you want to select all the listed names, choose Add All.
· You can also remove names that you have added. Highlight the name in the Selected list box and 

choose Remove.



· You can print a list of the people and resources that you have selected so far by choosing Print.

5. When you have finished working on the Resources tab in the Multiple User version of the Search 
dialog box, you can go on to the other tabs to select people and groups. The resources that you have 
selected on this tab of the dialog box will remain listed in the Selected list box throughout, unless you 
remove them (which you can still do while working on another tab in the dialog box).

6. Once all the people and resources that you want to select are listed in the Selected list box, choose 
OK, and they will automatically be included on the list of people/resources that you were working on 
when you opened the Search dialog box.

Directory Search

When you have opened the Search dialog box with the command Search Directory from the Edit Menu, 
the bottom half of the dialog box will look like this:

In this version of the Search dialog box you can not select a resource's name to use it in a list or an edit 
box. The Search Directory command simply gives you quick access to the System Directory, so that you 
can inform yourself about the people, resources and groups on your system.

To search for a resource, use the Resources tab of the dialog box and follow the steps below.

1. Type the resource's name or number as the search parameter.
You do not have to type the whole name—a few letters are normally enough. Your Agenda will also 
accept searches for resources without search parameters. If you don't type in any characters, your 
Agenda will list all available resources.

2. Select the Local resources only check box if you don't want to display remote resources.

3. Choose Search. The result of your search will then be listed in the Found list box.

· Those resources appearing with an (R) or other notes in brackets next to their name are remote 
resources. They are on a different server. Often the note in brackets will indicate on what server 
or in what department the resource is located.

· You can print the result of your search by choosing Print.
· To find out more about a resource, highlight the resource's name in the list box and choose 

Information.

4. Choose Done when you are done with your Directory Search



See Also:

Searching — People 
Searching — Groups 
Selecting Several Users



Searching — Groups

The Search dialog box will appear whenever you click . It will also appear if you select Search 
Directory from the Edit Menu. The Group tab of the dialog box will allow you to look for groups within the 
directory.

The Search dialog box will look slightly different depending on where you opened it from. There are three 
different versions of the Search dialog box:

· Single User Selection: This version of the Search dialog box opens when you click  in a dialog 
box where you can only select one person or resource (for example, when you want to search for a 
user name in the Open an Agenda dialog box).

· Multiple User Selection: This version opens when you click  in a dialog box where you can select 
several people or resources (for example, when you are using a People/Resources list, which can be 
found in many dialog boxes).

· Directory Search: This version opens when you choose Search Directory from the Edit Menu. In this 
case, you can only inform yourself about people and resources in your system.

Single User Selection

When you have chosen to search in a dialog box where you can only select one user (such as the Open 
an Agenda dialog box), the bottom half of the Search dialog box will look like this:

To search for groups and select a member of a group, use the Groups tab of the dialog box and follow the 
steps below.

1. Choose the group types you want to display by selecting the appropriate check boxes.

2. Choose Search. The result of your search will then be listed in the Groups available list box.

3. Select a group by clicking it in the Groups available list box. Its members are displayed in the 
Members list box.

· Those users appearing with an (F) next to their name are foreign users. They don't have an 
Agenda. You can still invite them to Entries—they will receive an e-mail notice of the invitation. 

· Those users appearing with an (R) or other notes in brackets next to their name are remote 



users. They are on a different server. Often the note in brackets will indicate on what server or in 
what department the user is located.

· You can print a list of the selected group's members by choosing Print.
· To find out more about a group member, highlight the member's name in the list box and choose 

Information.

4. To select a group member, highlight the member's name in the Members list box and choose OK.

Multiple User Selection

When you have chosen to search in a dialog box where you can select several users (for example, on the 
General tab of the New Agenda Entry dialog box), the bottom half of the Search dialog box will look like 
this:

To search for groups and select one or several members of a group, use the Groups tab of the dialog box 
and follow the steps below.

1. Choose the group types you want to display by selecting the appropriate check boxes.

2. Choose Search. The result of your search will then be listed in the Groups available list box.

3. Select a group by clicking it in the Groups available list box. Its members are displayed in the 
Members list box

.
· Those users appearing with an (F) next to their name are foreign users. They don't have an 

Agenda. You can still invite them to Entries—they will receive an e-mail notice of the invitation. 
· Those users appearing with an (R) or other notes in brackets next to their name are remote 

users. They are on a different server. Often the note in brackets will indicate on what server or in 
what department the user is located.

· To find out more about a group member, highlight the member's name in the list box and choose 
Information.

4. To select group members, highlight their names in the Members list box and click Add. The selected 
names will then appear in the Selected list box to the right.

· You can highlight more than one name in the Found list box. To highlight a number of consecutive 
names in the list, hold down the Shift key and click the first and the last of the names. To highlight 
a number of non-consecutive names, hold down the Ctrl key when you click them. Once all the 
names that you want to select are highlighted, click Add.

· Choose Add All to select the whole group.
· You can also remove names that you have added. Highlight the name in the Selected list box and 



choose Remove.
· You can print a list of the people and resources that you have selected so far by choosing Print.

5. When you have finished working on the Groups tab in the Multiple User version of the Search dialog 
box, you can go on to the other tabs to select resources and people. The group members that you 
have selected on this tab of the dialog box will remain listed in the Selected list box throughout, 
unless you remove them (which you can still do while working on another tab in the dialog box).

6. Once all the people and resources that you want to select are listed in the Selected list box, choose 
OK, and they will automatically be included on the list of people/resources that you were working on 
when you opened the Search dialog box.

Directory Search

When you have opened the Search dialog box with the command Search Directory from the Edit Menu, 
the bottom half of the dialog box will look like this:

In this version of the Search dialog box you can not select a group member's name to use it in a list or an 
edit box. The Search Directory command simply gives you quick access to the System Directory, so that 
you can inform yourself about the people, resources and groups on your system.

To search for groups, use the Groups tab of the dialog box and follow the steps below.

1. Choose the group types you want to display by selecting the appropriate check boxes.

2. Choose Search. The result of your search will then be listed in the Groups available list box.

3. Select a group by clicking it in the Groups available list box. Its members are displayed in the 
Members list box.

· Those users appearing with an (F) next to their name are foreign users. They don't have an 
Agenda. You can still invite them to Entries—they will receive an e-mail notice of the invitation. 

· Those users appearing with an (R) or other notes in brackets next to their name are remote 
users. They are on a different server. Often the note in brackets will indicate on what server or in 
what department the user is located.

· You can print a list of the selected group's members by choosing Print.
· To find out more about a group member, highlight the member's name in the list box and choose 

Information.

4. Choose Done when you are done with your Directory Search



See Also:

Searching — People 
Searching — Resources 
Selecting Several Users



Selecting Several Users
You have three search options in the Search Dialog box for selecting user names. You can select user 
names from a list of people, a list of resources, or a list of groups. Each search option has a tab that you 
can click.

Selecting from a list of people

1. Type a the person's last name. You do not have to type the whole name—a few letters are normally 
enough. If you do not type in any characters, your Agenda may give you the entire directory list. On 
some systems, however, you may get the message, "Surname string too short", in which case you will 
need to enter a few letters to start your search.

You can also use any other search parameter, such as Organization unit, or domain.

2. Choose Search. The result of your search is then listed in the Found list box.

3. Highlight one or several names in the Found list box, and choose Add to select them. To highlight a 
number of consecutive names in the list, hold down the Shift key and click the first and the last of the 
names. To highlight a number of non-consecutive names, hold down the Ctrl key when you click 
them.
Those users appearing with an (F) next to their name are foreign users. They don't have an Agenda. 
You can still invite them to Entries—they will receive an e-mail notice of the invitation.
Those users appearing with an (R) or other notes in brackets next to their name are remote users. 
They are on a different server. Often the note in brackets will indicate on what server or in what 
department the user is located.
If you want to select all the listed names, choose Add All.
You can also remove names that you have added. Highlight the name in the Selected list box and 
choose Remove.

Selecting from a list of resources

1. Type the resource name or number as the search parameter.
You do not have to type the whole name—a few letters are normally enough.

2. Select the Local resources only check box if you don't want to display remote resources.

3. Choose Search. The result of your search is then listed in the Found list box.

4. Highlight one or several resource names in the Found list box, and choose Add to select them. To 
highlight a number of consecutive resources in the list, hold down the Shift key and click the first and 
the last of the resources. To highlight a number of non-consecutive resources, hold down the Ctrl key 
when you click them.
Those resources appearing with an (R) or other notes in brackets next to their name are remote 
resources. They are on a different server. Often the note in brackets will indicate on what server or in 
what department the user is located.
If you want to select all the listed resources, choose Add All.
You can also remove resources that you have added. Highlight the resource's name in the Selected 
list box and choose Remove.

Selecting from a group

1. Select the group types you want to display.



2. Choose Search. The result of your search is then listed in the Groups available list box.

3. Select a group in the Groups available list box.

4. Select group members. Highlight one or several names in the Members list box, and choose Add to 
select them. To highlight a number of consecutive names in the list, hold down the Shift key and click 
the first and the last of the names. To highlight a number of non-consecutive names, hold down the 
Ctrl key when you click them.
Choose Add All to select the whole group.
Those users appearing with an (F) next to their name are foreign users. They don't have an    Agenda. 
You can still invite them to Entries—they will receive an e-mail notice of the invitation.
Those users appearing with an (R) or other notes in brackets next to their name are remote users. 
They are on a different server. Often the note in brackets will indicate on what server or in what 
department the user is located.
You can remove names that you have added. Highlight the name in the Selected list box and choose 
Remove.



Signing In
When you open your Agenda, you will see a dialog box asking you to sign in.

You can work on your Agenda on-line or off-line. To use your Agenda on-line, you must be connected to 
your server. To be able to use your Agenda off-line, you must first configure your Off-line Agenda. This 
you can do in the Off-line Agenda Configuration dialog box when opening the Off-line Agenda for the first 
time, or in the Off-line Preferences dialog box while you are working on-line.

Working On-line 

1. Enter your user name (the name by which the system knows you).

You can search for your name by choosing .

2. Enter your password.

3. Enter the name of your server. You can either type it in yourself, or select one of the servers from the 
pull-down menu that will appear when you click the arrow to the right of the edit box.

4. Choose OK.

Working Off-line

1. Enter your user name.

2. Enter your password.

3. Choose "Off-line" from the pull-down menu that appears when you click the arrow to the right of the 
server edit box.

See Also:

Off-line Preferences
Searching for Your User Name 
Off-line Agenda Configuration 



Signing in from your Off-line Agenda
If you choose to switch to your On-line Agenda while working in your Off-line Agenda, you will be asked to 
sign in again. This will connect you to the server and open your On-line Agenda.

1. Enter your user name (the name by which the system knows you).

You can search for your name by choosing .

2. Enter your password.

3. Enter the server name. You can either type it in yourself, or select one from the pull-down menu that 
will appear when you click the arrow to the right of the edit box.

4. Choose OK.

See Also:

Searching for Your User Name 



Searching for Your User Name

If you are unsure of your User Name, click  in the Sign-In dialog box to search for it.

You can open an Agenda under another person's or a resource's user name. Note, however, that you 
must be able to supply the correct password.

Selecting from a list of people

1. Type the person's last name. You do not have to type the whole name—a few letters are normally 
enough. If you do not type in any characters, your Agenda may give you the entire directory list. On 
some systems, however, you may get the message, "Surname string too short", in which case you will 
need to enter a few letters to start your search.

You can also use any other search parameter, such as Organization unit, or domain.

2. Choose Search.

3. Select your user name from the Found list box.
Those users appearing with an (R) or other notes in brackets next to their name are remote users. 
They are on a different server. Often the note in brackets will indicate on what server or in what 
department the user is located.

4. Choose OK.

Selecting from a list of resources

1. Type the resource's name or number as the search parameter.
You do not have to type the whole name—a few letters are normally enough.

2. Choose Search.

3. Select a name from the Found list box.
Those resources appearing with an (R) or other notes in brackets next to their name are remote 
resources. They are on a different server. Often the note in brackets will indicate on what server or in 
what department the user is located.

4. Choose OK.



Managing Groups
The Group Management dialog box (Edit Menu, Manage Groups) allows you to add and modify groups of 
users.

Creating a New Group

1. To create a new group, type the group's name in the Add group edit box. Specify what type of group it 
will be, choose one of the alternatives from the pull-down menu that appears when you click the arrow 
to the right of the edit box.

2. Choose  to accept the addition. This will add the name to the list of groups available.

Choose  to cancel the addition. This will erase the group name from the edit box. It will not be 
added to the list of groups available.

Modifying an Existing Group's Name and/or Group Type

1. To edit a group, select it from the list in the list box. It's name and group type will then appear in the 
Modify selected group edit box, where you can edit them.

2. Choose  to accept the changes. This will modify the group's name and/or group type on the list of 
groups available.

Choose  to cancel the changes. This will erase the group name from the edit box. No changes will 
be made to the list of groups available.

Adding Members to a New or Existing Group

1. To add members to a new or existing group, select a group from the list in the list box.

2. Add group members to a new or existing group using the edit box to the right. Enter the names of the 
people or resources you wish to add to the group into the edit box one at a time.
Those users appearing with an (R) or other notes in brackets next to their name are remote users. 
They are on a different server. Often the note in brackets will indicate on what server or in department 
the user is located.

3. Choose  to accept the addition. This will add the user to the list of group members.

Choose  to cancel the addition. This will erase the name from the edit box. No change will be 
made to the list of group members.

4. To print out a list of groups, choose Print Groups. The print-out will contain a list of all groups, with a 
list of each group's members (up to a maximum of 50 members).

 
5. To print out a list of the members of    a specific group, select the group and choose Print members. 

The print-out will contain a list of all the group's members.

6. Choose OK.



Deleting Members from an Existing Group

1. To delete members from an existing group, select the group from the list in the list box.

2. A list of the group's members will appear in the right-hand list box.

3. Select the name of the person or resource you want to delete from the group.

4. Choose Delete Member.

Deleting a Group

1. To delete a group, select the group from the list in the list box.

2. Choose Delete Group.

See Also:

Adding Names



Off-line Preferences — Location
You can use your Agenda on-line or off-line. Before you can use your Agenda off-line you must configure 
your Off-line Agenda, which you can do either here while working on-line, or when you sign in to the Off-
line Agenda for the first time. 

The Off-line Preferences dialog box (Edit Menu, Preferences, Off-line) lets you choose preferences for 
your Off-line Agenda.

To be able open your Agenda off-line, you must first determine the off-line file name. You can use the 
Location tab of the dialog box to do this.

1. Choose where to store your Off-line Agenda. You can store the file in any directory. 
Click Browse if you want to look for directories and files.

2. Choose "Create directory if none exists" if you want to place your downloaded file in a new directory.

Choose OK only when you've finished with all the tabs of the dialog box.

See Also:

Off-line Preferences — People/Resources 
Off-line Preferences — Download Preferences 
Off-line Preferences — Groups 
Off-line Reconciliation Preferences 



Adding Names
Whenever you need to create or modify a list of people, groups or resources (such as when you are 
inviting people or resources to an Entry), you will see this:

To add a person:
Type the person's name or initials in the Add edit box. If you do not know the name, but you do have other 

information (such as an organizational unit or part of the name), you can choose  to open the Search 
dialog box. 

You can also enter Organization units with the user's name. Organization units must be separated from 
the name and from each other by slashes. For example:

· John Smith/CORP/MKTG/EXT
or
· John Smith/OU1=CORP/OU2=MKTG/OU3=EXT.

If you do not include the "OU=", the Organization units must be entered in their correct sequence. If you 
enter:

· John Smith/EXT

your Agenda will assume EXT is the first Organization unit. However, if you enter:

· John Smith///EXT

your Agenda will understand that EXT is the third Organization unit. The spaces provided by the other two 
slashes insert two empty Organization units.

Depending on your set-up, a person may have as many as four Organization units.

Once you have entered the name or initials in the edit box:

· Choose  to accept the addition. This will add the person to the list of people/resources you are 
creating or editing.

· Choose  to cancel the addition. This will erase the person's name from the edit box. They will not 
be added to the list of people/resources you are creating or editing.

If your Agenda can't find one unique name with the search parameters you have entered, a dialog box 
containing a list of possible names will open. Select the correct name from this list and choose OK. The 
selected name will be added to the list you are working on.

NOTE: If a person's name has a blank character in it, either in the person's first name (like "Mary Jane") 
or in his or her surname (like "Wilson Smith"), you must type in a ^ character (Shift + 6) instead of the 
blank space when you enter that person's name. Otherwise your Agenda will not understand which name 
is which. For example:

· Write Mary^Jane Johnson, instead of Mary Jane Johnson; 

· Write Peter Wilson^Smith, instead of Peter Wilson Smith.



To add a resource:

To add a resource to the list, type r:, re:, or res: followed by the resource's name. If you do not know the 
resource's name, but you do have other information (such as an organizational unit or part of the name), 

you choose  to open the Search dialog box. 

You can also enter the resource's number, with or without its name. The number must be separated from 
the resource name by a slash. For example:

· r:Meeting Room/R3535-1

If you wish to enter only the resource number, without the resource name, it must be preceded by a slash. 
For example:

· r:/R3535-1

Once the name is in the edit box:

· Choose  to accept the addition. This will add the resource to the list of people/resources you are 
creating or editing.

· Choose  to cancel the addition. This will erase the resource's name from the edit box. They will 
not be added to the list of people/resources you are creating or editing.

To add a group:

To add a group to the list, type g:, gr:, or grp: followed by the group's name.

Once the name is in the edit box:

· Choose  to accept the addition. This will add all members of the group to the list of 
people/resources you are creating or editing.

· Choose  to cancel the addition. This will erase the group's name from the edit box. They will not 
be added to the list of people/resources you are creating or editing.

You can also choose  to select a group.

Or, choose , which will open the Search dialog box, allowing you to search for the group you wish to 
invite.

See Also:

Searching—People
Searching—Resources
Searching—Groups
Select a Group
Group Management



Several Names Match
When you sign in to your Agenda, or when you're adding a name to a list, several names may match the 
one you have entered. For instance, if you type in only SMITH, you may find there are several Smiths, a 
Smitham and a Smithson with Agendas in your company. If this is the case, your Agenda will display a 
dialog box telling you the name is not unique, and ask you to select one from the list of possibilities.
Those users appearing with an (R) or other notes in brackets next to their name are remote users. They 
are on a different server. Often the note in brackets will indicate on what server or in what department the 
user is located.

Simply select the correct name and choose OK.



Time Selection

The Time Control is displayed when you click  next to a Time box.

This is another way of setting the time in a Time box:

1. Select the left or right arrow, until the blue arrow is aligned with the desired time—the Time Control is 
set to move in one-hour intervals when you click the arrows. The time you have selected will be 
displayed in the corresponding Time box.

You can also click the blue arrow and drag it until it points at the desired time. When you choose to do 
this, the Time Control moves in 15-minute intervals.
Finally, if the desired time is visible in the Time Control, you can simply click it directly on the Time 
scale to select it.

2. Choose OK.



Replying to an Invitation
You can reply to Agenda Entries that appear in your In-tray, stating whether or not you will attend. For Day 
Events, Daily Notes and Holidays you can decide whether or not to keep them in your Agenda. 

When you double-click an Entry in your In-tray, you will either get to a reply dialog box or to the View 
Entry dialog box, depending on how you have set your Preferences (Edit Menu, Preferences, In-tray).

If you are replying to an Agenda Entry:

1. Select the appropriate message from the list. (I will attend, I will not attend, or I will confirm later).
The message "I would prefer another time" can accompany any of the options.

To send an e-mail message with your reply, click .

2. Choose OK.

If you are replying to a Day Event, Daily Note or Holiday:

1. Select from the list one of the three options:

· Keep in Agenda.
· Remove from Agenda.
· Decide later.

2. Choose OK.

See Also:

Mail Message
In-tray Preferences — New Entries 



Adding Holidays
You can only enter Holidays into the Agenda if you have been given special authorization to do so.

On your Daily and Weekly Agenda pages, Holidays will be displayed in the Notes View. They will appear 
next to the date on the Monthly Agenda page. This icon indicates a Holiday: . Holidays received from 
others will appear in the New Entries folder of your In-tray, where you can decide whether or not to keep 
them in your Agenda.

If you are authorized to add and delete company Holidays, you can do this in the Holidays dialog box, 
which is displayed when you choose Holidays from the Edit Menu.

1. Type the name of the Holiday in the Title box.

2. Enter the date by either:

· using the arrows to the right of the date box to scroll the date up or down; or,
· choosing the calendar button to the right of the date box.

3. Choose  to accept the new Holiday. This will add the Holiday to the list of Holidays in the system.

Choose  to cancel the new Holiday. This will erase the Holiday from the edit box. It will not be 
added to the list of Holidays in the system.

4. Your Holidays will appear in the list box. You can sort them by date or by title.

Select the appropriate button:
· Sort by date
· Sort by title.

5. Delete a Holiday by selecting it in the list box and choosing Delete.

6. Choose OK when you have finished.

NOTE: You can not edit Holidays. If you want to make changes to a Holiday, you have to delete it and add 
a new version of it.

See Also:

Replying to an Invitation



Name Formats
You can choose your name and resource formats using the Names tab of the General Preferences dialog 
box (Edit Menu, Preferences, General).

1. Set the format in which you want names to appear. Click the arrow to the right of the box to see the 
format option. Select one. Check the Generation box if you want the Agenda to include any possible 
generational suffix when displaying names (for example: John Smith III).

2. Select how you want your Organization units and other organizational information displayed. You can 
choose between:

· Use Separator: items will be separated from the name and each other by slashes, without codes 
for what they indicate.

· Display Org. Field: items will include codes for what they indicate (i.e. OU# = for Organization 
units, C= for Country, A= for Administrative Domain, etc.)

3. Select which Organization units and what other information (Organization, Country and Domains) you 
want to appear next to the name. Check the appropriate boxes.

4. Set the format in which you want resources to appear. You can chose between having the Agenda 
display only the resource's name, or both its name and number in the order of your choice. Check the 
box you prefer. 

Choose OK only when you have finished with all the tabs of the dialog box.



Selecting a Group

The Select a Group dialog box is displayed when you click  next to an Add edit box (for instance, 
when you invite people/resources to an Entry). Here you can choose a group you want included in the list 
of people/resources underneath the Add edit box.

1. In the Groups Displayed box, you select the group types you want to see.

2. Select a group from the Groups Available list box. The group members' names will appear in the 
Group Members box.

3. To print out a list of groups, choose Print Groups. The print-out will contain a list of all groups, with a 
list of each group's members (up to a maximum of 50 members).

 
4. To print out a list of the members a specific group, select the group and choose Print members. The 

print-out will contain a list of all the group's members.

5. Choose OK to include the selected group's members on the list of people/resources you are working 
on.

See Also:

Adding Names 
Group Management



The Print Dialog Box
This dialog box lets you choose a print layout, the range of dates for which you want your Agenda pages 
printed, and which types of Agenda pages you want printed.

Your Agenda will print the Agenda you have selected. For example, if you have your own Agenda and the 
Agendas of other users opened at the same time, the Agenda that is active will be printed when you 

choose Print from the File Menu or  on the toolbar.

1. Select the layout you want to use. Click the arrow to the right of the box to see the available format 
choices. Select one.

2. If you want to customize your layout, choose Options. This will call up the Layout Options dialog box. 

3. Choose the range of dates for which you want to print Agenda pages. Set each date either by using 
the two arrows to the right of the box, or by choosing the calendar button.

4. Choose which types of Agenda pages you want to print, by clicking the appropriate check boxes near 
the bottom of the dialog box.

5. To change your printer set-up, choose Setup.

6. To preview your print-out before printing, choose Preview.

7. Choose OK when you have made all your selections.

See Also:

Printing



Scheduling Preferences
By choosing Preferences from the Edit Menu, you can set the hours during which you want the Agenda to 
look for available times when you use its Suggest a Date/Time function.

1. Select the day of the week for which you want to set your preferences.

2. Set your normal hours by entering the Start and End times in the appropriate boxes. Make changes to 
the Start time and End time by using the arrow keys to the right of the box or by choosing the clock 
button.

3. Set your extended hours by entering the Start and End times in the appropriate boxes. Make changes 
to the Start time and End time by using the arrow keys to the right of the box or by choosing the clock 
button.

4. Select the next day of the week for which you want to set preferences.

5. If you want to use the same settings throughout the week, choose Apply to All. 
If you want to set different settings for certain days of the week, choose OK when you have set all 
your preferences.

See Also:

Agenda Preferences — Display



Agenda Preferences — Display
You can choose to set up your Agenda display using the Display tab of the Agenda Preferences dialog 
box (Edit Menu, Preferences, Agenda).

1. Set the Day Start and Day End times. These are the times that will be displayed on the first and last 
time slots of your Agenda. However, when Agenda Entries have been scheduled at an earlier time 
than your Start time, your Agenda page will be opened showing the time slot where the earliest 
Agenda Entry is scheduled.

Make changes to the Start time and End time by using the arrow keys to the right of the box or by 
choosing the clock button. 

2. In the Interval box, select the size of your time slots by clicking the arrow key to the right of the box 
and selecting the desired interval.

3. Choose your preferred time format.
· Select the AM/PM button if you prefer displaying times in the AM/PM format.
· Select the 24-Hour button if you prefer displaying times in the 24-hour format (00:00 to 23:59).

4. Select the first day of your week by clicking the arrow on the right-hand side of the box and selecting 
the desired day. The day you select will be displayed first on your Weekly and Monthly Agenda pages.

5. Select the Show Saturday check box to include Saturdays in your Agenda. Remove the selection if 
you don't want to include Saturdays.

6. Select the Show Sunday check box to include Sundays in your Agenda. Remove the selection if you 
don't want to include Sundays.

7. Select the color coding system you prefer. Your Agenda Entries can be color coded either according 
to the Importance level, Attendance Status, or Ownership. To view the options, click the arrow to the 
right of the box. Select one.

8. Select display options.
There are five options that affect the way Agenda Entries are displayed, and which Agenda Entries 
you will see, in your Agenda. Select the check boxes for those options you want your Agenda to 
display:

· Declined Agenda Entries: Agenda Entries that you have declined will still be displayed on your 
Agenda pages.

· Unconfirmed Agenda Entries: Agenda Entries that you have not yet replied to will be displayed 
not only in your In-tray, but also on your Agenda pages.

· Location: If an Agenda Entry's location has been specified, it will be displayed in the Entry on your 
Agenda pages.

· Start and End times: Agenda Entries' Start and End times will be displayed in the Entry on your 
Agenda pages.

· Icons: Certain icons (such as the bell for Reminder or the Description/Comments icon) will be 
displayed in your Agenda.

Choose OK only when you have finished with both tabs of the dialog box.

See Also:

Color Coding 



Agenda Preferences — Notification
You can set up the Notification function of your Agenda using the Notification tab of the Agenda 
Preferences dialog box (Edit Menu, Preferences, Agenda). This function will let other users notify you by 
e-mail when they create Entries that you are invited to. 

You also decide whether or not your Agenda should ask if you want to send messages to other users 
when you create, modify, or delete Entries to which you have invited others.

Here, you can moreover choose to have your Agenda check for new Entries at regular intervals.

1. To receive e-mail notifications from other users about new Entries that you have been invited to, 
simply select Receive notification of new Entries by e-mail.

2. To check your Agenda for new Entries at regular intervals, select Check for new Entries. Type in the 
time interval in the box below (there is a minimum of 15 minutes). When your Agenda finds new 

Entries in your In-tray, this icon will appear in the Status bar: .

3. You can also choose in which cases your Agenda will ask whether you want to send an e-mail 
message to other users. There are three choices available, from which you can select some, all or 
none.

· Mail to attendees on Entry creation: You will be asked whether you want to send an e-mail 
message every time you invite other users to an Entry you have created. (The notification 
preferences of the invited users control which people are included on the distribution list for this 
message by default.)

· Mail to attendees on Entry modification: You will be asked whether you want to send an e-mail 
message every time you modify an Entry to which you have invited other users.

· Mail to attendees on Entry deletion: You will be asked whether you want to send an e-mail 
message every time you delete an Entry to which you have invited other users.

Choose OK only when you have finished with both tabs of the dialog box.



In-tray Preferences — New Entries
You can set up your preferences for each In-tray folder by choosing Preferences from the Edit Menu and 
selecting In-tray.

By double-clicking a new Entry you can either reply to the Entry or view it.

· Choose Fast reply to the Entry if you want to answer the Entries you receive without viewing them 
first.

· Choose View the Entry if you want to read the Entries you receive before responding.

Choose OK only when you have finished with all the tabs of the dialog box.

See Also:

All about the In-tray
New Entries
Entry Defaults — Agenda Entries



In-tray Preferences — Accepted Entries
You can set up your preferences for each In-tray folder by choosing Preferences from the Edit Menu and 
selecting In-tray.

You can view and access the Entries you have accepted in different ways. 

1. By double-clicking an Entry you have accepted, you can either reply to the Entry or view it.

· Select Fast reply to the Entry if you want to answer the Entries you have accepted without 
viewing them.

· Select View the Entry if you want to read the Entries you have accepted when you choose them.

2. You can either view all of the Entries you have accepted, or you can set a limited range.

· Select Show all Entries dated from today to the next... if you want to limit the number of Entries 
displayed. Once you select the button, you can set the interval. Click the arrow next to the right-
hand box to see the options. You can choose to view Entries from a period of days, weeks, 
months or years. Type the appropriate number in the left-hand box.

· Select Show Entries dated from today onwards if you want to view every Entry you have 
accepted.

Choose OK only when you have finished with all the tabs of the dialog box.

See Also:

All about the In-tray
Entry Defaults — Agenda Entries



In-tray Preferences — Entries Sent
You can set up your preferences for each In-tray folder by choosing Preferences from the Edit Menu and 
selecting In-tray.

You can either view all the Entries you have sent, or you can set a limited range. 

1. Select Show Entries dated from the last...to the next... if you want to limit the number of Entries 
displayed. Once you select the button, you can set the interval. Click the arrow next to the right-hand 
boxes to see the options. You can choose to view Entries from a period of days, weeks, months or 
years. Type the appropriate numbers in the left-hand boxes.

2. Select Show Entries dated from today onwards if you want to view every Entry you have sent.

Choose OK only when you have finished with all the tabs of the dialog box.

See Also:

All about the In-tray



In-tray Preferences — Refused Entries
You can set up your preferences for each In-tray folder by choosing Preferences from the Edit Menu and 
selecting In-tray.

You can view and access the Entries you have refused in different ways. 

1. By double-clicking an Entry you have refused, you can either reply to the Entry or view it.

· Select Fast reply to the Entry if you want to answer the Entries you have refused without viewing 
them.

· Select View the Entry if you want to read the Entries you have refused when you choose them.

2. You can either view all of the Entries you have refused, or you can set a limited range.

· Select Show all Entries dated from today to the next... if you want to limit the number of Entries 
displayed. Once you select the button, you can set the interval. Click the arrow next to the right-
hand box to see the options. You can choose to view Entries from a period of days, weeks, 
months or years. Type the appropriate number in the left-hand box.

· Select Show all Entries from today onwards if you want to view every Entry you have refused.

Choose OK only when you have finished with all the tabs of the dialog box.

See Also:

All about the In-tray



Editing an Agenda Entry — General
Use the Edit Entry dialog box to make changes to an Agenda Entry you've proposed. This dialog box is 
called up when you select the Agenda Entry on the Agenda page and choose Open Entry from the Edit 
Menu (or double-click the Entry).

If other users have been invited to the Agenda Entry, the changes you make will automatically appear in 
their Agendas as well. If you change the time or date of the Agenda Entry, it will appear as a new Entry in 
their In-tray.

Use the General tab of the dialog box to make any of the changes below.

1. Make changes to the Title of the Agenda Entry in the Title box.

2. To make a tentative Agenda Entry official, uncheck the Tentative box.

3. Change the date for the Agenda Entry by either:
· using the arrows to the right of the date box to scroll the date up or down; or,

· choosing the calendar button to the right of the date box.

4. Make changes to the Start time and End time by typing in the new time or using either the arrow keys 
or the clock button. The duration will adjust itself accordingly.
You can also choose to adjust the duration of the Agenda Entry by using the arrows to the right of the 
Duration box. Your Agenda will automatically adjust the End Time for you.

5. Use the People and resources part of the tab to invite or delete people and resources for your Agenda 
Entry. 

· To invite a user, type the name in the Add edit box.
If you want to invite a resource, type r:, re:, or res: followed by the resource's name.
If you want to add a group, type g:, gr:, or grp: followed by the group's name.

· Once the correct name is in the edit box, press Enter on your keyboard to add the name in the list 
of invited people and resources below.

· Choose  to search for people, groups or resources.

· Choose  to select a group for your list.
· To delete a name, select it from the list box and choose Delete.
· If only one single resource is included on the list of people and resources, it will automatically be 

entered in the Location edit box (on the Summary tab) if you haven't already written a location for 
your Agenda Entry there. Deleting this resource from the list will also delete it from the Location 
edit box.

6. Next to each person or resource in the list box, an icon will appear:

the person or resource will attend;
the person or resource will not attend;

the person or resource has not yet responded;
the person or resource will attend, but would prefer another time;
the person or resource will not attend, but would attend if the time were changed.

7. Your Agenda can also suggest another date and time for the Entry and check for scheduling conflicts. 
Choose Suggest a Date/Time for rescheduling suggestions.

8. Choose Check conflicts to see if your Agenda Entry creates conflicts for you and/or other attendees.



NOTE #1: In order for your Agenda to detect conflicts in other users' Agendas, you must have access 
rights to view the Agenda Entries that cause the conflict with your Agenda Entry. If you don't have this 
right, your Agenda will not detect the conflict.

Choose OK only when you have made all your changes (on all the tabs of the dialog box).

NOTE #2: Each time you create or modify an Entry to which other users have been invited, your Agenda 
may display a message box asking you if you want to send the other users an e-mail message. (This 
depends on your Preferences, which you can set using Edit Menu, Preferences, Agenda, Notification.)

· If you want to send an e-mail message, choose Yes. Your Agenda will then display the Mail Message 
dialog box for you.

· If you do not want to send an e-mail message, choose No. Your Entry will still appear in the In-trays 
and Agendas of the other users.

See Also:

Editing an Agenda Entry — Summary 
Editing an Agenda Entry — Details
Editing an Agenda Entry — Reminders
Editing an Agenda Entry — Linked Tasks
Editing an Agenda Entry — Reply 
Suggest a Date or Time
Adding Names
Selecting a Group



Editing an Agenda Entry — Details
Use the Edit Entry dialog box to make changes to an Agenda Entry that you have proposed. This dialog 
box is called up when you select the Agenda Entry on the Agenda page and choose Open Entry from the 
Edit Menu (or double-click the Entry).

If other users have been invited to the Agenda Entry, the changes you make will automatically appear in 
their Agendas as well. If you change the time or date of the Agenda Entry, it will appear as a new Entry in 
their In-tray.

Use the Details tab of the dialog box to make changes to your Agenda Entry description. If you have not 
written an Agenda Entry description you can add one. You can also attach an entire file to your Entry (or 
remove an earlier Attachment).

You can cut and paste text from other applications into your Agenda Entry description using the standard 
Ctrl-C (copy), Ctrl-X (cut) and Ctrl-V (paste) commands.

To attach a file, do the following:

1. Click Attach.
2. Select the file you wish to attach to your Entry in the dialog box that opens.
3. Click OK in the dialog box that opens.

You can remove the Attachment by clicking Remove.
If you are working off-line, you cannot attach files, nor access a file that has been attached earlier.

Choose OK only when you have made all your changes (on all the tabs of the dialog box).

NOTE: Each time you create or modify an Entry to which other users have been invited, your Agenda 
may display a message box asking you if you want to send the other users an e-mail message. (This 
depends on your Preferences, which you can set using Edit Menu, Preferences, Agenda, Notification.)

· If you want to send an e-mail message, choose Yes. Your Agenda will then display the Mail Message 
dialog box for you.

· If you do not want to send an e-mail message, choose No. Your Entry will still appear in the In-trays 
and Agendas of the other users.

See Also:

Editing an Agenda Entry — General 
Editing an Agenda Entry — Summary
Editing an Agenda Entry — Reminders
Editing an Agenda Entry — Linked Tasks
Editing an Agenda Entry — Reply 



Editing an Agenda Entry — Linked Tasks
Use the Edit Entry dialog box to make changes to an Agenda Entry that you have proposed. This dialog 
box is called up when you select the Agenda Entry on the Agenda page and choose Open Entry from the 
Edit Menu (or double-click the Entry).

If other users have been invited to the Agenda Entry, the changes you make will automatically appear in 
their Agendas as well. If you change the time or date of the Agenda Entry, it will appear as a new Entry in 
their In-tray.

Use the Linked Tasks tab of the dialog box to make changes to already linked Tasks, or to create new 
Tasks and link them to the Agenda Entry.

· To make changes to existing Tasks, double-click it in the list box. This calls up the Task Edit dialog 
box, where you can modify the Task.

· To create and link a new Task, choose New. This will call up the Task Create and Link dialog box.

· To delete a Task, select the Task in the list box and choose Delete. 

· To unlink a Task from the Agenda Entry, select the Task and choose Unlink. An unlinked Task is not 
deleted. It will simply no longer be connected to the Entry.

When you print out an Entry (using the Print Selected Entry command in the File Menu) that has Tasks 
linked to it, those Tasks will be included in the print-out.

Choose OK only when you have made all your changes (on all the tabs of the dialog box).

NOTE: Each time you create or modify an Entry to which other users have been invited, your Agenda 
may display a message box asking you if you want to send the other users an e-mail message. (This 
depends on your Preferences, which you can set using Edit Menu, Preferences, Agenda, Notification.)

· If you want to send an e-mail message, choose Yes. Your Agenda will then display the Mail Message 
dialog box for you.

· If you do not want to send an e-mail message, choose No. Your Entry will still appear in the In-trays 
and Agendas of the other users.

See Also:

Creating & Editing Tasks — General
Editing an Agenda Entry — General 
Editing an Agenda Entry — Summary
Editing an Agenda Entry — Details
Editing an Agenda Entry — Reminders
Editing an Agenda Entry — Reply 
Entry Defaults — Tasks
The Task Display



Editing an Agenda Entry — Reminders
Use the Edit Entry dialog box to make changes to an Agenda Entry that you have proposed. This dialog 
box is called up when you select the Agenda Entry on the Agenda page and choose Open Entry from the 
Edit Menu (or double-click the Entry).

If other users have been invited to the Agenda Entry, the changes you make will automatically appear in 
their Agendas as well. If you change the time or date of the Agenda Entry, it will appear as a new Entry in 
their In-tray.

Use the Reminders tab of the dialog box to change the Reminder settings for your Agenda Entry.

1. Select the Reminder ON button to turn on the Reminders function. Select the No Reminder (OFF) 
button to turn it off. 
Once you select the Reminder ON button, you can set the Reminders options.

2. Set how you wish to be reminded. You can either be reminded by a Pop-up window or you can have 
the Entry appear as an Upcoming Note in the Notes View of your Agenda (at the bottom of the Daily 
and Weekly Agenda pages). 
Click the arrow next to the display box and select one of the two options.

3. Set when you want to be reminded. You can choose to be reminded minutes, hours, days, weeks, 
months or years in advance. To view your options and select one, click the arrow to the right of the 
box. Then type the appropriate number in the left-hand box.

Choose OK only when you have made all your changes (on all the tabs of the dialog box).

NOTE: Each time you create or modify an Entry to which other users have been invited, your Agenda 
may display a message box asking you if you want to send the other users an e-mail message. (This 
depends on your Preferences, which you can set using Edit Menu, Preferences, Agenda, Notification.)

· If you want to send an e-mail message, choose Yes. Your Agenda will then display the Mail Message 
dialog box for you.

· If you do not want to send an e-mail message, choose No. Your Entry will still appear in the In-trays 
and Agendas of the other users.

See Also:

Editing an Agenda Entry — General 
Editing an Agenda Entry — Summary
Editing an Agenda Entry — Details
Editing an Agenda Entry — Linked Tasks
Editing an Agenda Entry — Reply 
Using the Reminders
Entry Defaults — Agenda Entries



Creating & Editing Tasks — General
The New/Edit Task dialog box (File Menu, New Task/Edit Menu, Open Selected Task) allows you to create 
or edit a Task.

Choose OK when you have completed creating/editing your Task (which may require more than one of 
the tabs on the New/Edit Task dialog box).

On the General tab of the dialog box you give your Task a Description (title). You can also (although you 
don't have to) give your Task a Due date, Due time, Start date and Start time.

1. Type the name of your Task in the Description box.

2. If your Task has a Due date, select the Due date box and enter the date using the arrows or choose 
the calendar button. You can set the Start date and Completion date in the same way.

3. If your Task has a Due time, select the Due time box and enter the time using the arrows or choose 
the clock button. You can set the Start time in the same way.

4. Type the Task's priority in the Priority box or use the arrow keys to the right of the box.

5. Choose or change the access level of the Task using the arrow to the right of the box. Select the 
appropriate access level in the scroll-down menu.

6. Use the arrow keys to the right of the Completed box to indicate how much of your Task has been 
completed.

See Also:

Creating & Editing Tasks — Details
Creating & Editing Tasks — Reminders
Entry Defaults — Tasks
The Task Display 



Creating & Editing Tasks — Details
The New/Edit Task dialog box (File Menu, New Task/Edit Menu, Open Selected Task) allows you to create 
or edit a Task.

Choose OK when you have completed creating/editing your Task (which may require more than one of 
the tabs on the New/Edit Task dialog box).

Use the Details tab of the dialog box to write comments on your Task. The comments can be one 
sentence or several pages. You can also attach an existing file to your Task here.

You can cut and paste text from other applications into your Task's comments by using the standard Ctrl-
C (Copy), Ctrl-X (Cut) and Ctrl-V (Paste) commands. 

To attach a file to your Task, do the following: 

1. Click Attach.
2. Select the file you wish to attach to your Entry in the dialog box that opens.
3. Click OK in the dialog box that opens.

You can remove the Attachment by clicking Remove.
If you are working off-line, you cannot attach files, nor access a file that has been attached earlier.

See Also:

Creating & Editing Tasks — General
Creating & Editing Tasks — Reminders



Creating & Editing Tasks — Reminders
The New/Edit Task dialog box (File Menu, New Task/Edit Menu, Open Selected Task) allows you to create 
or edit a Task.

Choose OK when you have completed creating/editing your Task (which may require more than one of 
the tabs on the New/Edit Task dialog box).

You can set Reminders for both your Task's Start date and/or its Due date on the Reminders tab of the 
dialog box. Both Reminders are set in the same way.

1. Select the Reminder ON button to turn on the Reminders function. Select the No Reminder (OFF) 
button to turn it off. 
Once you select the Reminder ON button, you can set the Reminders options.

2. Set how you wish to be reminded. You can either be reminded by a Pop-up window or you can have 
the Task appear as an Upcoming Note in the Notes View of your Agenda (at the bottom of the Daily 
and Weekly Agenda pages). 
Click the arrow next to the display box and select one of the two options.

3. You can choose to be reminded minutes, hours, days, weeks, months or years in advance. To view 
your options and select one, click the arrow to the right of the box. Then type the appropriate number 
in the left-hand box.

See Also:

Using the Reminders
Creating & Editing Tasks — General
Creating & Editing Tasks — Details
Entry Defaults — Tasks



Creating an Agenda Entry — General
The New Agenda Entry dialog box can be opened in three ways. You can select New Agenda Entry from 

the File Menu, click  on the toolbar or double-click a time slot on the Daily and Weekly Agenda pages, 
or a day's grid square on the Monthly Agenda page.

The General tab of the dialog box allows you to create a new Agenda Entry. However, do not choose 
Create until you have completed creating your Entry (which may require using several tabs of the New 
Agenda Entry dialog box). You also use this tab of the dialog box to invite people or resources for your 
Agenda Entry.

1. Type the Title of your Agenda Entry in the Title box.

2. Check the Tentative box if you don't wish to make your Agenda Entry official yet. (You can make it 
official later by choosing Open Entry from the Edit Menu.) When you choose Tentative, a (T) will 
appear next to the title of your Entry, indicating that it is a tentative Entry.

3. Enter the date of your Agenda Entry in the Date box. Use the arrows to the right of the box or choose 
the calendar button.

4. In the Start time box, set the Start time of your Agenda Entry. Use the arrows to the right of the box or 
choose the clock button.

5. In the End Time box, set the time your Agenda Entry will finish. Use the arrows to the right of the box 
or choose the clock button. 

Notice that the duration of the Agenda Entry will appear in the Duration box. You can adjust the 
duration of the Agenda Entry by using the arrows to the right of the box. Your Agenda will 
automatically adjust the End Time for you.

6. Invite people and resources to your Agenda Entry with the Add edit box.

· To invite a user, type the name in the Add edit box.
If you want to invite a resource, type r:, re:, or res: followed by the resource's name.
If you want to add a group, type g:, gr:, or grp: followed by the group's name.

· Once the correct name is in the edit box, press Enter on your keyboard to include the name on 
the list of invited people and resources that you are creating. The name will then be added in the 
list box below.

· Choose  to search for people, groups or resources.

· Choose  to select a group for your list.
· To delete a name, select it from the list box and choose Delete.
· If only one single resource is included on the list of people and resources, it will automatically be 

entered in the Location edit box (on the Summary tab) if you haven't already written a location for 
your Agenda Entry there. Deleting this resource from the list will also delete it from the Location 
edit box.

7. Choose Check Conflicts to see if your Agenda Entry conflicts with other Entries in your or any invited 
user's Agenda. If there are conflicts, they will be displayed.

· If any conflicts are detected, they will be indicated by an 'X':  next to the Agenda Entry in the list 
box at the bottom of the dialog box. To see details of the conflict, double-click the Entry in the list 
box.

· If no conflicts are found, a checkmark:  will be displayed next to the Agenda Entry.



NOTE #1: In order for your Agenda to detect conflicts in other users' Agendas, you must have access 
rights to view the Agenda Entries that cause the conflict with your Agenda Entry. If you don't have this 
right, your Agenda will not detect the conflict.

8. Choose Suggest date/time if you want your Agenda to find another time and date for your Agenda 
Entry.

9. If you make this a recurring Agenda Entry (by going to the Repeating tab of this dialog box), the dates 

will be listed in the display box at the bottom. If you have checked for conflicts, a  or a 
 will appear next to each occasion. These indicate whether the Entry conflicts with other Entries in your 

or any other invited user's Agenda on that recurrence. 

Double-click an occasion in the list box to see the details of the conflicts.

An Apply to All button will also appear if you have created a recurring Entry. This way you can apply 
any changes you make (time, tentative or not, etc.) to all the recurrences of your Entry.

NOTE #2: Each time you create or modify an Entry to which other users have been invited, your Agenda 
may display a message box asking you if you want to send the other users an e-mail message. (This 
depends on your Preferences, which you can set using Edit Menu, Preferences, Agenda, Notification.)

· If you want to send an e-mail message, choose Yes. Your Agenda will then display the Mail Message 
dialog box for you.

· If you do not want to send an e-mail message, choose No. Your Entry will still appear in the In-trays 
and Agendas of the other users.

See Also:

Creating an Agenda Entry — Summary 
Creating an Agenda Entry — Details
Creating an Agenda Entry — Reminders
Creating an Agenda Entry — Repeating 
Entry Defaults — Agenda Entries



Creating an Agenda Entry — Summary
The New Agenda Entry dialog box can be opened in three ways. You can select New Agenda Entry from 

the File Menu, click  on the toolbar or double-click a time slot on the Daily and Weekly Agenda pages, 
or a day's grid square on the Monthly Agenda page.

The Summary tab of the dialog box provides a summary of your Agenda Entry. It lists certain information 
about the Entry and lets you enter other information.

1. The following information is listed here:

· Title;
· Who proposed the Entry;
· People invited;
· The description of the Entry (Details);
· Creator.

2. If you want to, you can type in where your Agenda Entry will take place in the Location box. If only 
one single resource has been included on the list of people and resources (on the General tab), it will 
automatically be entered in the Location edit box if you haven't already written a location for your 
Agenda Entry here.

3. Select the Agenda Entry's importance level in the Importance edit box. Click the arrow to the right of 
the box to see the alternatives and select one.

4. Select the access level in the Access edit box. Click the arrow to the right of the box to see the 
alternatives and select one.

5. If you make this a recurring Agenda Entry (by going to the Repeating tab of this dialog box), the dates 
will be listed in the display box at the bottom. An Apply to All button will also appear. This way you 
can apply any changes you make (Access, Importance, etc.) to all the recurrences of your Entry.

6. Choose OK to finish working on this tab and go back to the General tab, where you can create the 
Agenda Entry.

See Also:

Creating an Agenda Entry — General
Creating an Agenda Entry — Details
Creating an Agenda Entry — Reminders
Creating an Agenda Entry — Repeating
Entry Defaults — Agenda Entries



Creating an Agenda Entry — Reminders
The New Agenda Entry dialog box can be opened in three ways. You can select New Agenda Entry from 

the File Menu, click  on the toolbar or double-click a time slot on the Daily and Weekly Agenda pages, 
or a day's grid square on the Monthly Agenda page.

You can be reminded of your Agenda Entry by setting Reminders for it on the Reminders tab of the dialog 
box.

1. Select the Set Reminder button to turn on the Reminders function. Select the No Reminder button to 
turn it off. 
Once you select the Set Reminder button, you can set the Reminders options.

2. Set how you wish to be reminded. You can either be reminded by a Pop-up window or you can have 
the Entry appear as an Upcoming Note in the Notes View of your Agenda (at the bottom of the Daily 
and Weekly Agenda pages). 
Click the arrow next to the display box and select one of the two options.

3. Set when you want to be reminded. You can choose to be reminded minutes, hours, days, weeks, 
months or years in advance. To view your options and select one, click the arrow to the right of the 
box. Then type the appropriate number in the left-hand box.

4. If you are creating a recurring Agenda Entry, a list box will display all the dates on which your Entry 
has been scheduled. The Reminders you have set will apply only to the selected dates.

· To apply the Reminders to all recurrences of the Entry, choose Apply to All.
· To select several consecutive dates in the list box, hold down the Shift key and click the first and 

the last of the dates. Once all the appropriate dates are selected, set your Reminders.
· To select several non-consecutive dates in the list box, hold down the Ctrl key when you click 

them. Once all the appropriate dates are selected, set your Reminders.

5. Choose OK to finish working on this tab and go back to the General tab, where you can create the 
Agenda Entry.

See Also:

Creating an Agenda Entry — General
Creating an Agenda Entry — Summary 
Creating an Agenda Entry — Details
Creating an Agenda Entry — Repeating
Entry Defaults — Agenda Entries



Creating an Agenda Entry — Details
The New Agenda Entry dialog box can be opened in three ways. You can select New Agenda Entry from 

the File Menu, click  on the toolbar or double-click a time slot on the Daily and Weekly Agenda pages, 
or a day's grid square on the Monthly Agenda page.

Use the Details tab of the dialog box to write a description of your Agenda Entry. It can be one sentence 
or several pages. You can also attach an entire file to your Entry here.

You can cut and paste text from other applications into your Agenda Entry description using the standard 
Ctrl-C (copy), Ctrl-X (cut) and Ctrl-V (paste) commands.

To attach a file, do the following:

1. Click Attach.
2. Select the file you wish to attach to your Entry in the dialog box that opens.
3. Click OK in the dialog box that opens.

Should you change your mind, you can remove the file by clicking Remove.
If you are working off-line, you cannot attach files.

Choose OK to finish working on this tab and go back to the General tab, where you can create the 
Agenda Entry.

See Also:

Creating an Agenda Entry — General
Creating an Agenda Entry — Summary 
Creating an Agenda Entry — Repeating
Creating an Agenda Entry — Reminders



Creating an Agenda Entry — Repeating
The New Agenda Entry dialog box can be opened in three ways. You can select New Agenda Entry from 

the File Menu, click  on the toolbar or double-click a time slot on the Daily and Weekly Agenda pages, 
or a day's grid square on the Monthly Agenda page.

You can make your Agenda Entry a recurring Entry using this dialog box. This can be useful for 
scheduling any type of event that will take place on a regular basis.

1. Indicate how frequently you would like the Entry to recur. Start by choosing if you want a daily, weekly, 
monthly or yearly repetition of your recurring Entry. Click the arrow to the right of the edit box and 
select one of the options. If you choose a monthly repetition, you can either have the Entry recur on 
one (or several) specific date(s) of the month, or you can select one (or several) specific day(s) of the 
month for the recurrence.

Depending on your choice in the frequency edit box, you will have different options to choose from to 
the right of it.

· If you select Daily, you can choose whether you want the Entry to recur every day or at some 
other frequency. Select the appropriate button and type in the frequency if you choose the latter 
alternative (such as every 2 or 3 days).

· If you select Weekly, you can choose whether you want the Entry to recur every week or at some 
other frequency. Select the appropriate button and type in the frequency if you choose the latter 
alternative (such as every 2 or 3 weeks). You also have to choose on which week day(s) you 
want the Entry to be repeated. Click the day(s) you want to schedule the Entry for. If you change 
your mind about a day that you've chosen, click its button again to unselect it.

· If you select Monthly on Date(s), you can choose whether you want the Entry to be repeated on 
a specific date every month or at some other frequency.
If you want one date every month, select the upper button and type in the date. 
If you want a different frequency, click the lower button, select the date in the list box and type in 
the frequency (such as every 2 or 3 months). You can also select more than one date in the list 
box by pressing the Ctrl key when clicking them. If you want the Entry to recur several dates 
every month, select the dates and type 1 in the edit box

· If you select Monthly on Day(s), select the day(s) in the list box (for example On the 3rd Monday 
of every month). If you want to select more than one day in the list box, press the Ctrl key when 
clicking them. Then type the frequency of the repetition in the small right-hand edit box (for 
example, every 3 months).

· If you select Yearly, you can choose whether you want the Entry to recur every year or at some 
other frequency. Select the appropriate button and type in the frequency if you choose the latter 
alternative (such as every 2 or 3 years).

2. Enter the Start date using the arrows or by choosing the calendar button. 

3. Set the End date by selecting either the Until or the For button.

· If you choose the Until button, set the date using the arrows or by choosing the calendar button.
· If you choose the For button, set the duration by selecting one of the options from the right-hand 

edit box (days, weeks, months, or years). Then type the interval in the small left-hand edit box.

4. Indicate whether or not you want your Agenda to include Saturdays, Sundays and Holidays when 
scheduling the recurring Agenda Entry.

5. Choose the way your Agenda should handle conflicts when scheduling the recurrence. Click the 
arrow to the left of the Conflicts edit box to see and select one of the following options: 



· Display will show you where a conflict exists. When you choose List Dates, your Agenda will 
display a list of all the dates on which your Entry has been scheduled. If you have selected 

Display, an icon will appear next to each date:  indicates that there is a conflict on that date, 
and 

 indicates that there is no conflict on that date.
If you want more information about the conflict(s), double-click the date in the list box. This calls 
up the Details of Conflict dialog box.

· Suggest times will call up the Suggest Date/Time dialog box for dates where a conflict occurs, 
which will help you find times where you could reschedule the Entry.

· If you choose Ignore, your Agenda will only display a list of dates, without any indication of 
whether a conflict exists.

6. Choose List Dates to create a list of the dates on which your Agenda Entry will be scheduled. The list 
will appear in the list box below. If you change your settings and choose List Dates again, your 
Agenda will replace the first list of dates you created. 

7. If you wish to create additional dates not included in the repetition you have specified, you can do so 
using the Additional date edit box. 

Set the date using the arrows to the right of the edit box or choose the calendar button.

Once the date is set, choose the  to accept it.

8. You can delete dates from the list in two ways:
· Select an individual date and choose Delete to remove selected dates only.
· Choose Clear All to cancel the entire list of dates.

9. Choose OK to finish working on this tab and go back to the General tab, where you can create the 
Agenda Entry.

See Also:

Creating an Agenda Entry — General
Creating an Agenda Entry — Summary 
Creating an Agenda Entry — Details
Creating an Agenda Entry — Reminders
Details of the Conflict 
Suggesting another Date or Time 



Suggesting another Date or Time
When you create an Agenda Entry, you can ask your Agenda to suggest another date or time for your 
Entry. Choosing Suggest date/time will bring up the Suggest Date/Time dialog box.

1. In the date boxes, set the range of dates within which you want to schedule your Agenda Entry. Set 
the dates using the arrows or by choosing the calendar button.

2. In the Duration box, indicate the amount of time for which you want your Agenda to search. Type it in 
or use the arrow keys.

3. Set the time range. This is the block of time it will search in each day. You can either:

· Select "Between" and set the range using the arrows to the right of the boxes or choosing the 
clock button;

· Select "Within normal hours"— your Agenda will use the normal hours you have set in your 
Scheduling Preferences.

· Select "Within extended hours"— your Agenda will use the extended hours you have set in your 
Scheduling Preferences. 

4. In the Maximum number of suggestions box, indicate how many suggestions you want displayed by 
typing in the number.

5. Choose List Suggestions to start your search.

6. Select one of the suggestions from the list. It is then displayed in the Selected time boxes.

7. If you want to adjust the time and date of the selected suggestion, you can do this in the Selected 
time boxes. Use the arrows to the right of the edit boxes or the calendar button and the clock button.

8. Choose OK to make your choice and exit the dialog box.

See Also:

Details of the Conflict 



Layout Options — Daily
In the Print Dialog box (File Menu, Print) you can set up your layout options by choosing Options. This 
calls up the Layout Options dialog box.

The Daily tab of this dialog box allows you to select the layout for your Daily Agenda pages. The boxes 
that appear checked are the default selections.

1. Select the special features you would like printed on your Daily Agenda pages. You can choose one 
or more of the following:

· Start time: Your Agenda will print the times at which Agenda Entries are scheduled to begin.
· End time: Your Agenda will print the times at which Agenda Entries are scheduled to end.
· Description: Your Agenda will print any descriptions included in Agenda Entries.
· Location: Your Agenda will print the scheduled location for Agenda Entries.
· Gray shading: Your Agenda will shade all your Agenda Entries gray, to make your available time 

more visible.
· Overflow pages: Your Agenda will print an overflow page for items that don't fit on the Daily 

Agenda page.

2. Select the column headings. This way you modify the layout of the printed Daily page. You can 
choose where its different parts will be found and what will be included in the print-out. Click the arrow 
to the right of each column title box and select one option for each.

3. Set the time range for which you want your Agenda to print your Daily Agenda pages. 
Use the arrows to the right of the time display boxes, or choose the clock button    to set the time.

4. Choose Save at the bottom of the dialog box to save your customized format under its original name.

Choose Save as… to save your customized format under a new name. Once you have chosen Save 
as… to give your format a name, you can save all subsequent changes by simply choosing Save. 
Your Agenda can save a maximum of 100 customized layouts.

5. To change the name of the layout you are working on, click Rename. A dialog box will appear, asking 
you to enter a new name for the layout.

6. If you choose Reset, your customized settings will be deleted and returned to the default settings for 
the "Portrait" layout.

7. Choosing Delete will permanently erase the layout in which you are currently working. 

8. Choose OK to return to the Print dialog box.



Layout Options — Weekly
In the Print Dialog box (File Menu, Print) you can set up your layout options by choosing Options. This 
calls up the Layout Options dialog box.

The Weekly tab of this dialog box allows you to select the layout for your Weekly Agenda pages. The 
boxes that appear checked are the default selections.

1. Select the special features you would like printed on your Weekly Agenda pages. You can choose one 
or more of the following:

· Start time: Your Agenda will print the times at which Agenda Entries are scheduled to begin.
· End time: Your Agenda will print the times at which Agenda Entries are scheduled to end.
· Description: Your Agenda will print any descriptions included in Agenda Entries.
· Location: Your Agenda will print the scheduled location for Agenda Entries.
· Work days only: Your Agenda will not print out Saturdays and Sundays.
· Gray shading: Your Agenda will shade all your Agenda Entries gray, to make your available time 

more visible.
· Overflow pages: Your Agenda will print an overflow page for items that don't fit on the Weekly 

Agenda page.
· Day Events and Notes: Your Agenda will print your Day Events, Daily Notes, and Holidays at the 

bottom of each day.

2. Set the time range for which you want your Agenda to print your Weekly Agenda pages. 
Use the arrows to the right of the time display boxes, or choose the clock button    to set the time.

3. Choose Save at the bottom of the dialog box to save your customized format under its original name.

Choose Save as… to save your customized format under a new name. Once you have chosen Save 
as… to give your format a name, you can save all subsequent changes by simply choosing Save. 
Your Agenda can save a maximum of 100 customized layouts.

4. To change the name of the layout you are working on, click Rename. A dialog box will appear asking 
you to enter a new name for the layout.

5. If you choose Reset, your customized settings will be deleted and returned to the default settings for 
the "Portrait" layout.

6. Choosing Delete will permanently erase the layout in which you are currently working. 

7. Choose OK to return to the Print dialog box.



Layout Options — Monthly
In the Print Dialog box (File Menu, Print) you can set up your layout options by choosing Options. This 
calls up the Layout Options dialog box.

The Monthly tab of this dialog box allows you to select the layout for your Monthly Agenda pages. The 
boxes that appear checked are the default selections.

1. Select the special features you would like printed on your Monthly Agenda pages. You can choose 
one or more of the following:

· Overflow pages: Your Agenda will print an overflow page for items that don't fit on the Monthly 
Agenda page.

· Work days only: Your Agenda will not print out Saturdays and Sundays.
· Start time: Your Agenda will print the times at which Agenda Entries are scheduled to begin.
· End time: Your Agenda will print the times at which Agenda Entries are scheduled to end.

2. Choose Save at the bottom of the dialog box to save your customized format under its original 
name.

Choose Save as… to save your customized format under a new name. Once you have chosen Save 
as… to give your format a name, you can save all subsequent changes by simply choosing Save. 
Your Agenda can save a maximum of 100 customized layouts.

3. To change the name of the layout you are working on, click Rename. A dialog box will appear asking 
you to enter a new name for the layout.

4. If you choose Reset, your customized settings will be deleted and returned to the default settings for 
the "Portrait" layout.

5. Choosing Delete will permanently erase the layout in which you are currently working. 

6. Choose OK to return to the Print dialog box.



Layout Options — Day Lists
In the Print Dialog box (File Menu, Print) you can set up your layout options by choosing Options. This 
calls up the Layout Options dialog box.

The Day List tab of this dialog box allows you to select the layout for your Day List pages. The boxes that 
appear checked are the default selections.

1. Choose which options you want included on your Day List print-outs.

· Attendees: Your Agenda will print out the names of Agenda Entry attendees. The maximum 
value allows you to limit the number of participants the print-out will list. If there are more 
participants than the set limit, your print-out will only indicate the number of attendees.

· Description, Task Comments: Your Agenda will print out any descriptions of Agenda Entries and 
Task comments. The maximum value allows you to limit the length of descriptions or comments 
that your Agenda will print. If the description or comment contains more characters than the set 
limit, your print-out will only indicate the length of it.

· Importance level: Your Agenda will include the importance level of Agenda Entries and the 
Priority of Tasks in the Day List.

· Owner: Your Agenda will indicate who owns (i.e. who proposed) the Entry.
· Tasks: All Tasks for the selected days will be printed out.
· Day Events, Notes, Holidays and Upcoming Reminders: Your Agenda will include all Entries 

that are displayed in the Notes View of your Daily Agenda page on your Day List.
· Empty Days: Days not containing any Entries will be included on your Day List.

3. Choose Save at the bottom of the dialog box to save your customized format under its original name.

Choose Save as… to save your customized format under a new name. Once you have chosen Save 
as… to give your format a name, you can save all subsequent changes by simply choosing Save. 
Your Agenda can save a maximum of 100 customized layouts.

4. To change the name of the layout you are working on, click Rename. A dialog box will appear asking 
you to enter a new name for the layout.

5. If you choose Reset, your customized settings will be deleted and returned to the default settings for 
the "Portrait" layout.

6. Choosing Delete will permanently erase the layout in which you are currently working. 

7. Choose OK to return to the Print dialog box.



Layout Options — Task List
In the Print Dialog box (File Menu, Print) you can set up your layout options by choosing Options. This 
calls up the Layout Options dialog box.

The Task List tab of this dialog box allows you to select the layout for printing your Tasks. The boxes that 
appear checked are the default selections.

1. Select the special features you would like printed on your Task List pages. You can choose one or 
more of the following:

· Task Comments: Your Agenda will print any comments you have included in your Tasks. The 
maximum value allows you to limit the length of comments that your Agenda will print. If the 
comment contains more characters than the set limit, your print-out will only indicate the length of 
it.

· Start date: Your Agenda will print the dates on which your Tasks are scheduled to start.
· Due date: Your Agenda will print the dates on which your Tasks are due.
· Completion date: Your Agenda will print the dates on which your completed Tasks were 

completed.

2. Choose Save at the bottom of the dialog box to save your customized format under its original name.

Choose Save as… to save your customized format under a new name. Once you have chosen Save 
as… to give your format a name, you can save all subsequent changes by simply choosing Save. 
Your Agenda can save a maximum of 100 customized layouts.

3. To change the name of the layout you are working on, click Rename. A dialog box will appear asking 
you to enter a new name for the layout.

4. If you choose Reset, your customized settings will be deleted and returned to the default settings for 
the "Portrait" layout.

5. Choosing Delete will permanently erase the layout in which you are currently working. 

6. Choose OK to return to the Print dialog box.



Layout Options — Fonts
In the Print Dialog box (File Menu, Print) you can set up your layout options by choosing Options. This 
calls up the Layout Options dialog box.

The Fonts tab of this dialog box allows you to select the font in which your Agenda will be printed. The 
fonts that appear are the default selections.

1. Choose the header font by clicking the arrow on the right-hand side of the box and selecting a font.

When you choose the default font, the computer will select the type face that most closely matches 
either Helvetica or Times.

2. Choose the header font size by clicking the arrow on the right-hand side of the box and selecting a 
size. You can select either normal, small or large. Your Agenda will use the appropriate size of the 
selected font for the layout you are using.

3. Choose the text font by clicking the arrow on the right-hand side of the box and selecting a font.

When you choose the default font, the computer will select the type face that most closely matches 
either Helvetica or Times.

4. Choose the text font size by clicking the arrow on the right-hand side of the box and selecting a size. 
You can select either normal, small or large. Your Agenda will use the appropriate size of the selected 
font for the layout you are using.

5. Choose Save at the bottom of the dialog box to save your customized format under its original name.

Choose Save as… to save your customized format under a new name. Once you have chosen Save 
as… to give your format a name, you can save all subsequent changes by simply choosing Save. 
Your Agenda can save a maximum of 100 customized layouts.

6. To change the name of the layout you are working on, click Rename. A dialog box will appear asking 
you to enter a new name for the layout.

7. If you choose Reset, your customized settings will be deleted and returned to the default settings for 
the "Portrait" layout.

8. Choosing Delete will permanently erase the layout in which you are currently working. 

9. Choose OK to return to the Print dialog box.



Layout Options — Margins
In the Print Dialog box (File Menu, Print) you can set up your layout options by choosing Options. This 
calls up the Layout Options dialog box.

The Margins tab of this dialog box allows you to select the margins for the print-out of your Agenda 
pages. The values that appear are the default settings.

1. Select the measuring unit by clicking the arrow on the right-hand side of the box and selecting either 
inches or centimeters.

2. Set the number of rows and columns you wish to have. Type in the appropriate value in each box.

3. Set the margins and internal margins by typing the appropriate values in each box.

4. Choose Save at the bottom of the dialog box to save your customized format under its original name.

Choose Save as… to save your customized format under a new name. Once you have chosen Save 
as… to give your format a name, you can save all subsequent changes by simply choosing Save. 
Your Agenda can save a maximum of 100 customized layouts. 

5. To change the name of the layout you are working on, click Rename. A dialog box will appear asking 
you to enter a new name for the layout.

6. If you choose Reset, your customized settings will be deleted and returned to the default settings for 
the "Portrait" layout.

7. Choosing Delete will permanently erase the layout in which you are currently working. 

8. Choose OK to return to the Print dialog box.



Date and Time Formats
You can set your preferences for the date and time formats using the Date and Time tab of the General 
Preferences dialog box (Edit Menu, Preferences, General).

1. Set your short date format by selecting the order in which you want the month, date and year to 
appear. In the Separator box, type in the character that should be used to divide the month, date and 
year. You can type in any character you prefer.
If you want the four-digit year, choose Century.
You will see your short date format displayed at the bottom of the Short Date Format box.

2. Set the long date format. Choose in what order you want the month, day and year to appear. Then 
Select the formats for the day, date, month and year by clicking the arrows next to each box and 
selecting your preferred options. 
You will see your long date format displayed at the bottom ofheLong Date Format box.

3. Set the time format by selecting either the AM/PM or 24-Hour display.

Choose OK only when you have finished with all the tabs of the dialog box.



Mail Message
This dialog box is called up when you choose to send an e-mail message concerning an Entry that you 
are creating, editing, deleting, or replying to.

In the Mail Message dialog box, you write your message, decide to whom it will be sent, and send it.

1. Create the list of people to whom you will send your mail message. All the invited people as well as 
the resource designates and the Entry's owner (i.e. the user who proposed it) are included in the list 
by default. If your message concerns a new Entry, the users must have set their notification 
preferences to receive e-mail notifications about new Entries in order to be included on the list.
If you delete one of these users and then change your mind, you can quickly make the list complete 
again with the checkmark buttons at the top of the dialog box. Click the button to include the 
corresponding people in the Distribution list.

To add an additional user to the Distribution list, type the person's name in the Other edit box.
· If you want to add a resource designate, type r:, re:, or res: followed by the resource's name.
· If you want to add a group, type g:, gr:, or grp: followed by the group's name.

Choose  to accept the addition. This will add the person to the users who will receive your 
message.

Choose  to cancel the addition. This will erase the user's name from the edit box. They will not be 
added to the Distribution list.

To add several users or groups at once, use the search feature. 

Choose  to open the Search dialog box. 

2. As you add people to the list, they will appear in the Distribution List box. 
To delete a person from the list, select their name in the list box and choose Delete. 

The Send key will turn gray (inactive) if there's not at least one person on the Distribution list.

3. Compose your message in the Message to Send edit box. Basic information about the Entry that the 
message corresponds to will already appear in the edit box. Scroll down to add to the message.

You can cut and paste text from other applications into your message using the standard Ctrl-C 
(copy), Ctrl-X (cut) and Ctrl-V (paste) commands.

4. Choose Send when you're ready to send your message.

See Also:

Add Names
Replying to an Invitation



The Calendar

The calendar is called up when you click  on the Date Control bar. It lets you go to a specified date in 
the Agenda simply through clicking the date on the calendar. It is also called up when you click the same 
button next to a date box in a dialog box. Here you can set a date in the date box through clicking it on 
the calendar.

The arrows on the calendar allow you to move forwards and backwards months and years at a time:

moves you back one year;

moves you forward one year;

moves you forward one month;

moves you back one month.

 will always take you back to the current date. 

You can also use the scroll-down list boxes at the top to choose the month and the year.



Viewing an Agenda Entry — General
The View Entry dialog box displays information about the Agenda Entry you have selected. You can call 
up this dialog box either by double-clicking the Entry in your In-tray (if you have set your Preferences for 
this option), double-clicking the Entry on your Agenda page, or selecting it on the Agenda page and 
choosing Open Entry from the Edit Menu.

This dialog box will only appear if you didn't propose the Entry you have selected. If you proposed the 
Entry, the Edit Entry dialog box will appear instead. (You cannot edit information about Entries you haven't 
proposed.)

The General tab of this dialog box lists the following information about your Entry:

· Who proposed the Entry;

· Creator;

· Title;

· Date;

· Start time, Duration and End time.

The General tab of the dialog box also shows you a list of the people and resources invited to the Agenda 
Entry you are viewing. In the list, an icon next to each name indicates how the people and resources have 
replied to the Entry:

the person or resource will attend;

the person or resource will not attend;

the person or resource has not yet responded;

the person or resource will attend, but would prefer another time;

the person or resource will not attend, but would attend if the time were changed.

The list cannot be edited in this dialog box. 

(You may change the list of people/resources if you proposed the Entry, that is, if it was created in your 
Agenda by yourself or a designate. If you did propose the Agenda Entry, the Edit Entry dialog box will be 
called up instead of the View Entry dialog box. In the Edit Entry dialog box, choose the General tab to 
make changes in the list of people and resources.)

If the Entry is a recurring one, a list box at the bottom of the dialog box will show the recurrences of the 
Entry, and indicate your reply to them using these icons:

for Entries you have accepted

for Entries you have refused

for Entries you have not responded to yet.

for Entries you have accepted although you would prefer another time;

for Entries you have refused but you would attend if the time were changed.

Choose OK only once you've finished with all the tabs of the dialog box.

See Also:



Editing an Agenda Entry — General
Viewing an Agenda Entry — Details
Viewing an Agenda Entry — Reminders
Viewing an Agenda Entry — Reply 
Viewing an Agenda Entry — Linked Tasks
In-tray Preferences — New Entries



Viewing an Agenda Entry — Details
The View Entry dialog box displays information about the Agenda Entry you have selected. You can call 
up this dialog box either by double-clicking the Entry in your In-tray (if you have set your Preferences for 
this option), double-clicking the Entry on your Agenda page, or selecting it on the Agenda page and 
choosing Open Entry from the Edit Menu.

This dialog box will only appear if you didn't propose the Entry you have selected. If you proposed the 
Entry, the Edit Entry dialog box will appear instead. (You cannot edit information about Entries you haven't 
proposed.)

The Details tab of the dialog box shows you the description of the Agenda Entry and gives you access to 
the Agenda Entry's attachment, if one has been included.

The description cannot be edited in this dialog box.

(You may edit the description of the Entry if you proposed the Entry (that is, if it was created in your 
Agenda by yourself or a designate). If you did propose the Entry, the Edit Entry dialog box will be called 
up instead of the View Entry dialog box. In the Edit Entry dialog box, choose the Details tab.) 

If there is a file attached to the Entry, it will be displayed at the bottom of the tab. To open an attached file, 
double-click the file's icon. If your system contains the software that created the file, the application will be 
launched and the file will open. Otherwise, you will be asked to associate the file with an appropriate 
application. 
If you are working off-line, you cannot access attached files.

If the Entry is a recurring one, the Details will be the same for every recurrence. A list box at the bottom of 
the dialog box will show the recurrences of the Entry, and indicate your reply to them using these icons:

for Entries you have accepted;

for Entries you have refused;

for Entries you have not responded to yet;

for Entries you have accepted although you would prefer another time;

for Entries you have refused but would attend if the time were changed.

Choose OK only once you've finished with all the tabs of the dialog box.

See Also:

Editing an Agenda Entry — Details
Viewing an Agenda Entry — General
Viewing an Agenda Entry — Reminders
Viewing an Agenda Entry — Reply
Viewing an Agenda Entry — Linked Tasks
Associating a File 



Viewing an Agenda Entry — Linked Tasks
The View Entry dialog box displays information about the Agenda Entry you have selected. You can call 
up this dialog box either by double-clicking the Entry in your In-tray (if you have set your Preferences for 
this option), double-clicking the Entry on your Agenda page, or selecting it on the Agenda page and 
choosing Open Entry from the Edit Menu.

This dialog box will only appear if you didn't propose the Entry you have selected. If you proposed the 
Entry, the Edit Entry dialog box will appear instead. (You cannot edit information about Entries you haven't 
proposed.)

The Linked Tasks tab of the dialog box shows you a list of the Tasks linked to the Agenda Entry you are 
viewing. 

You can add linked Tasks by choosing New. This will take you to the Task Create and Link dialog box.

If the Entry is a recurring one, a list box at the bottom of the dialog box will show the recurrences of the 
Entry, and indicate your reply to them using these icons:

for Entries you have accepted

for Entries you have refused

for Entries you have not responded to yet.

for Entries you have accepted although you would prefer another time;

for Entries you have refused but would attend if the time were changed.

Choose OK only once you've finished with all the tabs of the dialog box.

See Also:

Creating & Editing Tasks — General
Viewing an Agenda Entry — General
Viewing an Agenda Entry — Details
Viewing an Agenda Entry — Reply
Viewing an Agenda Entry — Reminders



Viewing an Agenda Entry — Reminders
The View Entry dialog box displays information about the Agenda Entry you have selected. You can call 
up this dialog box either by double-clicking the Entry in your In-tray (if you have set your Preferences for 
this option), double-clicking the Entry on your Agenda page, or selecting it on the Agenda page and 
choosing Open Entry from the Edit Menu.

This dialog box will only appear if you didn't propose the Entry you have selected. If you proposed the 
Entry, the Edit Entry dialog box will appear instead. (You cannot edit information about Entries you haven't 
proposed.)

The Reminders tab of the dialog box shows you the Reminders you have set for the Agenda Entry you 
are viewing.
You can change your Reminders in this dialog box.

1. Select the Reminder ON button to turn on the Reminders function. Select the No Reminder (OFF) 
button to turn it off. 
Once you select the Reminder ON button, you can set the Reminders options.

2. Set how you wish to be reminded. You can either be reminded by a Pop-up window or you can have 
the Entry appear as an Upcoming Note in the Notes View of your Agenda (at the bottom of the Daily 
and Weekly Agenda pages). 
Click the arrow next to the display box and select one of the two options.

3. Set when you want to be reminded. You can choose to be reminded minutes, hours, days, weeks, 
months or years in advance. To view your options and select one, click the arrow to the right of the 
box. Then type the appropriate number in the left-hand box.

4. If the Entry you are viewing is a recurring one, a list box will display all the dates on which the Entry 
has been scheduled. The Reminders you have set will apply only to the selected dates.

· To apply the Reminders to all recurrences of the Entry, choose Apply to All.
· To select several consecutive dates in the list box, hold down the Shift key and click the first and 

the last of the dates. Once all the appropriate dates are selected, set your Reminders.
· To select several non-consecutive dates in the list box, hold down the Ctrl key when you click 

them. Once all the appropriate dates are selected, set your Reminders.

In the list box with all the dates of a recurring Entry, these icons will indicate your reply to them:

for Entries you have accepted;

for Entries you have refused;

for Entries you have not responded to yet;

for Entries you have accepted although you would prefer another time;

for Entries you have refused but would attend if the time were changed.

Choose OK only once you've finished with all the tabs of the dialog box.

See Also:

Viewing an Agenda Entry — General
Viewing an Agenda Entry — Details
Viewing an Agenda Entry — Reply



Viewing an Agenda Entry — Linked Tasks
Entry Defaults — Agenda Entries
Using the Reminders



Viewing an Agenda Entry — Reply
The View Entry dialog box displays information about the Agenda Entry you have selected. You can call 
up this dialog box either by double-clicking the Entry in your In-tray (if you have set your Preferences for 
this option), double-clicking the Entry on your Agenda page, or selecting it on the Agenda page and 
choosing Open Entry from the Edit Menu.

This dialog box will only appear if you didn't propose the Entry you have selected. If you proposed the 
Entry, the Edit Entry dialog box will appear instead. (You cannot edit information about Entries you haven't 
proposed.)

When the View Entry dialog box is called up for an Agenda Entry, the Reply tab will always be displayed, 
in order for you to quickly respond to invitations. A summary of the Entry is displayed on this tab, so you 
don't have to go to the other tabs to get the information you need to reply to the Agenda Entry.

The summary lists the following information about the Agenda Entry:

· Who proposed the Entry;

· Title;

· Location;

· Time;

· Importance level;

· Access level;

· People invited.

The Reply tab shows you the current reply that is set for the Agenda Entry you are viewing. You can 
change the displayed reply here. If you've never replied,"'I will confirm later" is selected.

1. Select the appropriate message from the list:

· I will attend
· I will not attend
· I will confirm later
· The message "I would prefer another time" can accompany any of the options.

To send an e-mail    message with your reply, click .

2. If the Entry you are viewing is a recurring one, a list box will display all the dates on which the Entry 
has been scheduled. If you change your reply, the new reply will apply only to the selected dates.

· To change the reply to all recurrences of the Entry, choose Apply to All.
· To select several consecutive dates in the list box, hold down the Shift key and click the first and 

the last of the dates. Once all the appropriate dates are selected, change your reply.
· To select several non-consecutive dates in the list box, hold down the Ctrl key when you click 

them. Once all the appropriate dates are selected, change your reply.

In the list box with all the dates of a recurring Entry, these icons will indicate your reply to them:

for Entries you have accepted;

for Entries you have refused;

for Entries you have not responded to yet;



for Entries you have accepted although you would prefer another time;

for Entries you have refused but would attend if the time were changed.

Choose OK only once you've finished with all the tabs of the dialog box.

See Also:

Mail Message
Viewing an Agenda Entry — General
Viewing an Agenda Entry — Details
Viewing an Agenda Entry — Reminders
Viewing an Agenda Entry — Linked Tasks



Viewing a Day Event — General
The View Entry dialog box displays information about the Day Event you have selected. You can call up 
this dialog box either by double-clicking the Entry in your In-tray (if you have set your Preferences for this 
option), double-clicking the Entry on your Agenda page, or selecting it on the Agenda page and choosing 
Open Entry from the Edit Menu.

This dialog box will only appear if you didn't propose the Entry you have selected. If you proposed the 
Entry, the Edit Entry dialog box will appear instead. (You cannot edit information about Entries you haven't 
proposed.)

The General tab of the dialog box lists the following information about the Day Event you have selected:

· Who proposed the Entry;

· Creator;

· Title;

· Date.

· Access level

This tab also shows you a list of the people and resources invited to the Day Event. Next to each person 
or resource in the list, one of these icons will be displayed:

people or resources (the resource designates) who have decided to keep the Day Event in their 
Agenda;

people or resources who have decided to remove the Day Event from their Agenda;

people or resources who haven't responded to the Day Event yet.

The list cannot be edited in this dialog box.

(To edit the list of people and resources for a Day Event that you did propose, go to the General tab of the 
Edit Entry dialog box for that Day Event.)

If the Entry is a recurring one, a list box at the bottom of the dialog box will show the recurrences of the 
Entry, and indicate your reply to them using these icons:

for Entries you have accepted;

for Entries you have refused;

for Entries you have not responded to yet.

Choose OK only once you've finished with all the tabs of the dialog box.

See Also:

Viewing a Day Event — Reminders 
Viewing a Day Event — Agenda Status 
Entry Defaults — Day Events



Viewing a Day Event — Reminders
The View Entry dialog box displays information about the Day Event you have selected. You can call up 
this dialog box either by double-clicking the Entry in your In-tray (if you have set your Preferences for this 
option), double-clicking the Entry on your Agenda page, or selecting it on the Agenda page and choosing 
Open Entry from the Edit Menu.

This dialog box will only appear if you didn't propose the Entry you have selected. If you proposed the 
Entry, the Edit Entry dialog box will appear instead. (You cannot edit information about Entries you haven't 
proposed.)

The Reminder tab of the dialog box shows you the Reminders you have set for the Day Event.

You can change your Reminders in this dialog box:

1. Select the Reminder ON button to turn on the Reminders function. Select the No Reminder (OFF) 
button to turn it off. 
Once you select the Reminder ON button, you can set the Reminders options.

2. Set how you wish to be reminded. You can either be reminded by a Pop-up window or you can have 
the Entry appear as an Upcoming Note in the Notes View of your Agenda (at the bottom of the Daily 
and Weekly Agenda pages). 
Click the arrow next to the display box and select one of the two options.

3. Set when you want to be reminded. You can choose to be reminded minutes, hours, days, weeks, 
months or years in advance. To view your options and select one, click the arrow to the right of the 
box. Then type the appropriate number in the left-hand box.

4. If the Entry you are viewing is a recurring one, a list box will display all the dates on which the Entry 
has been scheduled. The Reminders you have set will apply only to the selected dates.

· To apply the Reminders to all recurrences of the Entry, choose Apply to All.
· To select several consecutive dates in the list box, hold down the Shift key and click the first and 

the last of the dates. Once all the appropriate dates are selected, set your Reminders.
· To select several non-consecutive dates in the list box, hold down the Ctrl key when you click 

them. Once all the appropriate dates are selected, set your Reminders.

In the list box with all the dates of a recurring Entry, these icons will indicate your reply to them:

for Entries you have accepted;

for Entries you have refused;

for Entries you have not responded to yet.

Choose OK only once you've finished with all the tabs of the dialog box.

See Also:

Using the Reminders
Viewing a Day Event — General
Entry Defaults — Day Events
Viewing a Day Event — Agenda Status



Editing a Day Event — General
The Edit Entry dialog box lets you make changes to a Day Event you have scheduled. You can call up 
this dialog box either by double-clicking the Entry in your In-tray or on your Agenda page, or by selecting 
it on the Agenda page and choosing Open Entry from the Edit Menu.

This dialog box will only appear if you proposed the Entry you have selected. If you didn't propose the 
Entry, the View Entry dialog box will appear instead. (You cannot edit information about Entries you 
haven't proposed.) 

When you edit a Day Event to which you have invited others, the changes you make will automatically 
appear in their Agendas as well. If you change the date of the Event, it will appear as a new Day Event in 
their In-tray.

Use the General tab of the dialog box to make any of the changes below.

1. Make changes to the Title of the Day Event in the Title box.

2. Change the date by either:
· using the arrows to the right of the date box to scroll the date up or down; or,
· choosing the calendar button to the right of the date box.

3. Use the People/Resources part of the tab to change the list of people and resources who have been 
invited to your Day Event.

· To invite a user to the list, type the name in the Add edit box.
If you want to invite a resource, type r:, re:, or res: followed by the resource's name.
If you want to add a group, type g:, gr:, or grp: followed by the group's name.

· Once the correct name is in the edit box, press Enter on your keyboard to add the name in the list 
of invited people and resources below.

· Choose  to search for people, groups or resources.

· Choose  to select a group for your list.
· To delete a name, select it from the list box and choose Delete.

Next to each person or resource in the list box, one of these icons will be displayed:

people or resources (the resource designates) who have decided to keep the Day Event in their 
Agenda;

people or resources who have decided to remove the Day Event from their Agenda;

people or resources who haven't responded to the Day Event yet.

Choose OK only once you've finished with all the tabs of the dialog box.

NOTE: Each time you create or modify an Entry to which other users have been invited, your Agenda 
may display a message box asking you if you want to send the other users an e-mail message. (This 
depends on your Preferences, which you can set using Edit Menu, Preferences, Agenda, Notification.)

· If you want to send an e-mail message, choose Yes. Your Agenda will then display the Mail Message 
dialog box for you.

· If you do not want to send an e-mail message, choose No. Your Entry will still appear in the In-trays 
and Agendas of the other users.



See Also:

Editing a Day Event — Summary
Editing a Day Event — Reminders 
Editing a Day Event — Agenda Status 
Entry Defaults — Day Events
Adding Names
Selecting a Group



Editing a Day Event — Summary
The Edit Entry dialog box lets you make changes to a Day Event you have scheduled. You can call up 
this dialog box either by double-clicking the Entry in your In-tray or on your Agenda page, or by selecting 
it on the Agenda page and choosing Open Entry from the Edit Menu.

This dialog box will only appear if you proposed the Entry you have selected. If you didn't propose the 
Entry, the View Entry dialog box will appear instead. (You cannot edit information about Entries you 
haven't proposed.)

When you edit a Day Event to which you have invited others, the changes you make will automatically 
appear in their Agendas as well. If you change the date of the Event, it will appear as a new Day Event in 
their In-tray.

The Summary tab of the dialog box provides a summary of your Day Event. It lists certain information 
about the Entry and lets you change other information.

1. The following information is listed on this tab, but cannot be changed here:

· Title;
· Who proposed the Entry;
· People invited;
· Creator.

2. You can adjust the access level by clicking the arrow to the right of the Access box and selecting one 
of the options.

Choose OK only once you've finished with all the tabs of the dialog box.

NOTE: Each time you create or modify an Entry to which other users have been invited, your Agenda 
may display a message box asking you if you want to send the other users an e-mail message. (This 
depends on your Preferences, which you can set using Edit Menu, Preferences, Agenda, Notification.)

· If you want to send an e-mail message, choose Yes. Your Agenda will then display the Mail Message 
dialog box for you.

· If you do not want to send an e-mail message, choose No. Your Entry will still appear in the In-trays 
and Agendas of the other users.

See Also:

Editing a Day Event — General
Editing a Day Event — Reminders
Editing a Day Event — Agenda Status



Editing a Day Event — Reminders 
The Edit Entry dialog box lets you make changes to a Day Event you have scheduled. You can call up 
this dialog box either by double-clicking the Entry in your In-tray or on your Agenda page, or by selecting 
it on the Agenda page and choosing Open Entry from the Edit Menu.

This dialog box will only appear if you proposed the Entry you have selected. If you didn't propose the 
Entry, the View Entry dialog box will appear instead. (You cannot edit information about Entries you 
haven't proposed.)

When you edit a Day Event to which you have invited others, the changes you make will automatically 
appear in their Agendas as well. If you change the date of the Event, it will appear as a new Day Event in 
their In-tray.

This tab of the dialog box lets you change the Reminders you have set for your Day Event.

1. Select the Reminder ON button to turn on the Reminders function. Select the No Reminder (OFF) 
button to turn it off. 
Once you select the Reminder ON button, you can set the Reminders options.

2. Set how you wish to be reminded. You can either be reminded by a Pop-up window or you can have 
the Entry appear as an Upcoming Note in the Notes View of your Agenda (at the bottom of the Daily 
and Weekly Agenda pages). 
Click the arrow next to the display box and select one of the two options.

3. Set when you want to be reminded. You can choose to be reminded minutes, hours, days, weeks, 
months or years in advance. To view your options and select one, click the arrow to the right of the 
box. Then type the appropriate number in the left-hand box.

Choose OK only once you've finished with all the tabs of the dialog box.

NOTE: Each time you create or modify an Entry to which other users have been invited, your Agenda 
may display a message box asking you if you want to send the other users an e-mail message. (This 
depends on your Preferences, which you can set using Edit Menu, Preferences, Agenda, Notification.)

· If you want to send an e-mail message, choose Yes. Your Agenda will then display the Mail Message 
dialog box for you.

· If you do not want to send an e-mail message, choose No. Your Entry will still appear in the In-trays 
and Agendas of the other users.

See Also:

Using the Reminders
Entry Defaults — Day Event
Editing a Day Event — General
Editing a Day Event — Summary
Editing a Day Event — Agenda Status



The Date Control Bar — Daily Agenda Page
The date control bar appears along the upper edge of your Agenda pages. It lets you turn the pages of 
your Agenda using five buttons.

When you use the Date Control bar on the Daily Agenda page, the buttons work like this:

moves you back one week;

moves you forward one week;

moves you forward one day;

moves you back one day;

opens the calendar, which allows you to select a specific date that you want to got to in the 
Agenda;

makes the rows of your Agenda's Day View shorter;

makes the rows of your Agenda's Day View taller.

When you select the calendar button, a calendar will appear on screen.

See The Calendar for details on how to use it.

At the far left of the Date Control bar, you may also see  or 
. These indicate that there are more Agenda Entries earlier or later in your Agenda, which are not 

visible on-screen at the moment. Scroll up or down to see these Agenda Entries.



The Date Control Bar — Monthly Agenda Page
The date control bar appears along the upper edge of your Agenda pages. It lets you turn the pages of 
your Agenda using five buttons.

When you use the Date Control bar on the Monthly Agenda page, the buttons work like this:

moves you back six months;

moves you forward six months;

moves you forward one month;

moves you back one month.

opens the calendar, which allows you to select a specific date that you want to got to in the 
Agenda;

The  on the left-hand side of the control bar returns the calendar grid to the default setting.

When you select the calendar button, a calendar will appear on screen.

See The Calendarfor details on how to use it.



The Date Control Bar — Weekly Agenda Page
The date control bar appears along the upper edge of your Agenda pages. It lets you turn the pages of 
your Agenda using five buttons.

When you use the Date Control bar on the Weekly Agenda page, the buttons work like this:

moves you back one month;

moves you forward one month;

moves you forward one week;

moves you back one week;

opens the calendar, which allows you to select a specific date that you want to got to in the 
Agenda;

makes the rows of your Agenda's Week View shorter;

makes the rows of your Agenda's Week View taller.

When you select the calendar button, a calendar will appear on screen.

See The Calendar for details on how to use it.

At the far left of the Date Control bar, you may also see  or 
. These indicate that there are more Agenda Entries earlier or later in your Agenda, which are not 

visible on-screen at the moment. Scroll up or down to see these Agenda Entries.



The Daily Agenda Page
The Daily Agenda page is divided into four parts:

· The Day View

· The Task View

· The Notes View

· The Date Control bar.

You can resize the three views to suit your needs. You will notice the cursor change when you point at the 
splitters between the panes. It will look like this:

Move the splitters by clicking them and dragging them to their new location. 

Choose from the list below to see specific information about:

The Day View

The Task View

The Notes View

The Date Control bar

Agenda Preferences — Display



The Monthly Agenda Page
The Monthly Agenda page is divided into two parts:

· The Month View

· The Date Control bar.

Your month will be displayed here. You can resize individual columns (i.e. weekdays) or rows (i.e. 

individual weeks) in the Month View by clicking the splitters you want to move with the  cursor and 
dragging them to resize the column or row. To return to the default grid setting, click 

 furthest to the left on the Date Control bar.

Choose from the list below to see specific information about:

The Month View

The Date Control bar



All about the In-tray
The In-tray is where you will receive and manage Entries that you receive from other users (i.e. Agenda 
Entries, Daily Notes, Day Events or Holidays proposed by others). It also contains a listing of the Entries 
you have sent to others.

You can open your In-tray in one of two ways: either select Open In-tray from the File Menu or click  
on the toolbar.

When you open your In-tray, you will see a folder labeled with your name. If you have opened other 
Agendas as a designate, folders will also appear labeled with their names.

You open the folder by clicking it. It will then expand and show you four folders labeled:

· New Entries

· Entries you've accepted

· Entries you've sent out

· Entries you've refused.

You can open any of these folders by clicking them. (To close the folder, just click it again.) A listing of the 
folder's content will appear below the folder. Each Entry in the list will be preceded by an icon, identifying 
the Entry as a Daily Note, a Holiday, an Agenda Entry, a Day Event or a repeating Entry. They will look 
like this:

Daily Note
Holiday
Agenda Entry
Day Event
Recurring Entry.

By double-clicking any of these icons, you can see further information about the Entry.

You can also move Entries directly from one folder to another by clicking the Entry and dragging it into 
another folder. Your Agenda will make the necessary changes for you (for example, changing your 
response to the Entry).

See Also:

New Entries
Entries you've Accepted
Entries you've Sent Out
Entries you've Refused



New Entries
In the In-Tray's New Entries folder you will find Entries to which you have not responded. Click the folder 
icon to open a list of the Entries.

1. Double-click any Entry title to open a dialog box. The contents of the dialog box depend on the 
preferences you have set (Edit Menu, Preferences, In-tray, New), and the type of Entry you have 
selected. 

· The View Entry dialog box displays information about the Entry you have selected. Use the tabs 
to find out specific details about the Entry.

· The Reply dialog box lets you reply to an Agenda Entry. For Holidays, Day Events, and Notes you 
can choose whether to keep the Entry in your Agenda or not. Simply click your selection in the 
dialog box and choose OK. You may have the option of sending a mail message about your 

response. If so, click  to do this.

If you double-click a recurring Entry, or click its icon, a list of all its dates will be displayed along with 
icons indicating which kind of Entry it is (Agenda Entry, Daily Note, or Day Event). In this list you can 
double-click individual dates to call up the same dialog boxes as for regular Entries.

2. Click an Entry's icon to view a list of all the people and resources who have been invited to the Entry. 
Next to each name there's an icon indicating if and how the person or resource has replied to the 
Entry: 

indicates that the person/resource has accepted the Entry;
indicates that the person/resource has refused the Entry;
indicates that the person/resource has not yet responded to the Entry;

indicates that the person/resource has accepted the Entry, but would prefer another time;

indicates that the person/resource has refused the Entry, but would be interested if it were 
rescheduled.

Your name appears in bold font in the list. If you double-click it, the fast reply dialog box is called up 
(see above).

3. Once you have dealt with an Entry, your Agenda will put it in the appropriate In-tray folder, either as 
an Entry you have accepted or refused.

See Also:

In-tray Preferences — New Entries
Mail Message
Replying to an Invitation 
Viewing an Agenda Entry — General
Viewing a Day Event — General
Viewing a Daily Note — General 



Entries you've Accepted
In the In-Tray's Entries you've Accepted folder you will find Entries which you are planning to attend or 
keep in your Agenda. Click the folder icon to open a list of the Entries. The time range of the Entries 
shown depends on the preferences you have set (Edit Menu, Preferences, In-tray, Accepted).

1. Double-click any Entry title to open a dialog box. The contents of the dialog box depend on the 
preferences you have set (Edit Menu, Preferences, In-tray, Accepted), and the type of Entry you have 
selected.

· The View Entry dialog box displays information about the Entry you have selected. Use the tabs 
to find out specific details about the Entry.

· The Reply dialog box lets you change your reply to an Agenda Entry. For Holidays, Day Events, 
and Notes you can choose whether to keep the Entry in your Agenda or not. Simply click your 
selection in the dialog box and choose OK. You may have the option of sending a mail message 

about your response. If so, click  to do this.

If you double-click a recurring Entry, or click its icon, a list of all its dates will be displayed along with 
icons indicating which kind of Entry it is (Agenda Entry, Daily Note, or Day Event). In this list you can 
double-click individual dates to call up the same dialog boxes as for regular Entries.

2. Click an Entry's icon to view a list of all the people and resources who have been invited to the Entry. 
Next to each name there's an icon indicating if and how the person or resource has replied to the 
Entry: 

indicates that the person/resource has accepted the Entry;
indicates that the person/resource has refused the Entry;
indicates that the person/resource has not yet responded to the Entry;

indicates that the person/resource has accepted the Entry, but would prefer another time;

indicates that the person/resource has refused the Entry, but would be interested if it were 
rescheduled.

Your name appears in bold font in the list. If you double-click it, the fast reply dialog box is called up 
(see above).

3. If you change your reply to an Entry, your Agenda will put it in the appropriate In-tray folder.

See Also:

In-Tray Preferences — Accepted Entries
Viewing an Agenda Entry — General
Viewing a Day Event—General
Viewing a Daily Note — General 
Replying to an Invitation



Entries you've Sent Out
In the In-Tray's Entries you've Sent Out folder you will find Entries which you have created and sent out 
to other users. Click the folder icon to open a list of the Entries. The time range of the Entries shown 
depends on the preferences you have set (Edit Menu, Preferences, In-tray, Sent).

1. If you double-click the title text of an Entry you have sent out, an Edit Entry dialog box will appear. 
You can see and modify the information about that particular Agenda Entry by going through the tabs 
of this dialog box.

If you double-click a recurring Entry, or click its icon, a list of all its dates will be displayed along with 
icons indicating which kind of Entry it is (Agenda Entry, Daily Note, or Day Event). In this list you can 
double-click individual dates. You will then be asked whether you want to edit only this recurrence or 
edit several recurrences of the Entry.
Choosing Edit this recurrence only will call up the regular Edit Entry dialog box. But if you choose to 
edit several recurrences you will come to the Edit Recurring Entry dialog box, where you can modify 
more than one recurrence at a time.

2. In this folder, you can delete an Entry you've sent out (i.e. cancel it and remove it from all the invited 
users' In-trays and Agendas). Select the Entry you want to delete and choose Delete Entry from the 
Edit Menu.

3. Click an Entry's icon to view a list of all the people and resources that you have invited to the Entry. 
Next to each name there's an icon indicating if and how the person or resource has replied to the 
Entry: 

indicates that the person/resource has accepted the Entry;
indicates that the person/resource has refused the Entry;
indicates that the person/resource has not yet responded to the Entry;

indicates that the person/resource has accepted the Entry, but would prefer another time;

indicates that the person/resource has refused the Entry, but would be interested if it were 
rescheduled.

Your name appears in bold font in the list if you have invited yourself. If you double-click it, the fast 
reply dialog box is called up. You can set your reply by clicking your selection in the dialog box and 
choosing OK. No matter how you reply to the Entry, it will always remain an Entry you have sent out, 
and therefore it will always stay in this folder.

See Also:

In-Tray Preferences — Entries Sent
Editing a Day Event — General 
Editing a Daily Note — General 
Editing an Agenda Entry — General 



Entries you've Refused
In the In-Tray's Entries you've Refused folder you will find Entries which you have refused to attend or to 
keep in your Agenda. Click the folder icon to open a list of the Entries. The time range of the Entries 
shown depends on the preferences you have set (Edit Menu, Preferences, In-tray, Refused).

1. Double-click any Entry title to open a dialog box. The contents of the dialog box depend on the 
preferences you have set (Edit Menu, Preferences, In-tray, Refused), and the type of Entry you have 
selected.

· The View Entry dialog box displays information about the Entry you have selected. Use the tabs 
to find out specific details about the Entry.

· The Reply dialog box lets you change your reply to an Agenda Entry. For Holidays, Day Events, 
and Notes you can choose whether to keep the Entry in your Agenda or not. Simply click your 
selection in the dialog box and choose OK. You may have the option of sending a mail message 

about your response. If so, click  to do this.

If you double-click a recurring Entry, or click its icon, a list of all its dates will be displayed along with 
icons indicating which kind of Entry it is (Agenda Entry, Daily Note, or Day Event). In this list you can 
double-click individual dates to call up the same dialog boxes as for regular Entries.

2. Click an Entry's icon to view a list of all the people and resources who have been invited to the Entry. 
Next to each name there's an icon indicating if and how the person or resource has replied to the 
Entry:

indicates that the person/resource has accepted the Entry;
indicates that the person/resource has refused the Entry;
indicates that the person/resource has not yet responded to the Entry;

indicates that the person/resource has accepted the Entry, but would prefer another time;

indicates that the person/resource has refused the Entry, but would be interested if it were 
rescheduled.

Your name appears in bold font in the list. If you double-click it, the fast reply dialog box is called up 
(see above).

3. If you change your reply to an Entry, your Agenda will put it in the appropriate In-tray folder.

See Also:

In-Tray Preferences — Refused Entries
Viewing an Agenda Entry — General
Viewing a Day Event—General
Viewing a Daily Note — General 
Replying to an Invitation



Selecting a Designator
The Designator Selection dialog box will appear when you select Open Agenda—A Group Agenda as 
Designate, or Open Tasks—Modify Other's as Designate, from the File Menu. Respectively, the dialog 
box lets you select from whose Agenda you want to open a Group Agenda as a designate, or whose Task 
Display you want to open as a designate.

1. Select the person from whose Agenda you wish to open a Group Agenda as a designate, or whose 
Task Display you wish to open as a designate.

2. Choose OK.



User Selection
This dialog box will appear when you select Open Tasks — View Other's Tasks from the File Menu. It lets 
you select whose Task Display you want to view.

1. Type the name of the person whose Task Display you want to open in the edit box.

· Choose  to accept the selection. This is the user whose Task Display will be opened.

· Choose  to cancel the selection. The user name you have entered will be erased and that 
person's Task Display will not be opened.

2. If you are uncertain of the name, use the search feature. Choose  to call up the Search dialog 
box.

3. Choose OK.



Details of the Conflict
This dialog box will appear when you indicate that you want more information about a scheduling conflict 
(for example, through double-clicking an Agenda Entry that causes conflicts in the New Agenda Entry 
dialog box, or choosing View in the Conflicts Found dialog box). 

Here, you will find more detailed information about conflicts caused by the Agenda Entry that you are 
creating, editing, or rescheduling.

· The left-hand list box shows which people and resources from your list of invited for whom the 
Agenda Entry causes one or more scheduling conflicts.

· The right-hand list box shows the title of the Agenda Entries that are conflicting with your Agenda 
Entry in the Agenda of the person or resource that you have selected in the left-hand list box.

Choose OK when you have finished reading the information.

See Also:

Suggesting Another Date 
Creating an Agenda Entry — General
Editing an Agenda Entry — General



Conflict Found
Whenever you reschedule an Agenda Entry and create a conflict in the process, your Agenda will alert 
you to the conflict. It will then ask you whether you still want to move the Agenda Entry.

· Choose Yes if you want to move the Entry despite the conflict;
· Choose No if you want to cancel the move;
· Choose View if you want to view the conflict before making your decision. This will call up the Details 

of Conflict dialog box.

See Also:

Details of the Conflict 



The Day View
Your day will be displayed here, divided into time slots , the size of which you can increase or decrease 
using two buttons on the toolbar, or with the commands Decrease and Increase Time Slot from the Edit 
Menu.

Select  (or Increase Time Slot from the Edit Menu) to increase the size of your time slots. This can 
allow you an overview of your entire day by putting up to one hour of time into one time slot.

Select  (or Decrease Time Slot from the Edit Menu) to decrease the size of your time slots. You can 
see your time in fine detail this way, down to five minute intervals, if you wish.

Agenda Entries scheduled for that day will appear in the corresponding time slots, color-coded according 
to their Importance level, Attendance Status or Ownership. Conflicting Agenda Entries will be shown side 
by side. The scheduled time of the event and its title will be displayed at the top of the Entry. Several 
icons could also appear there. These include:

indicates you have accepted to attend the Agenda Entry;

indicates you have refused to attend the Agenda Entry;

indicates you have not yet responded to the Agenda Entry;
indicates there is a description attached to the Agenda Entry;

indicates there is a file attached to the Agenda Entry;
indicates the Agenda Entry has more than one attendee;

indicates you have set a Reminder for the Entry.
These icons allow you a quick overview of the Entry in the Day View.

You can add Agenda Entries to your day by clicking the time slot where you wish to begin your Agenda 
Entry and dragging the pointer to the End time. You will see the block of time you have selected is 
highlighted. You can now type the Agenda Entry title directly into the block. You can also double-click any 
time slot to call up the New Agenda Entry dialog box. This dialog box is moreover displayed if you click 

 on the toolbar or choose New Agenda Entry from the File Menu.

You can change the duration of an Agenda Entry directly on your Agenda page. Click the Agenda Entry to 
select it. The field of the Agenda Entry you selected will turn white and its frame will be highlighted, like 
this:

(Note that the actual color depends on your PC's color preferences.)

Two handles will appear on the upper and lower edges. Click the handle you want to use and drag it to 
lengthen or shorten the Agenda Entry. Notice that the cursor looks like this when you point at the handles:



Your Agenda will resize the Agenda Entry and adjust the display of any Agenda Entries that occupy the 
same time slots.

You can move the Agenda Entry in a similar way. You will notice that when you point at any part of the 
frame other than the two handles, the cursor looks like this:

 
To move the Agenda Entry, click the frame of the Agenda Entry with this cursor and drag the Agenda 
Entry to its new location. Your Agenda will resize the Agenda Entry and adjust the display in case to 
accommodate any conflicts. 

To delete an Agenda Entry that you have proposed, select it and then choose Delete Entry from the Edit 
Menu. Doing this will erase the Entry. If you delete an Entry to which other users have been invited, it will 
be deleted from all the attendees' Agendas. If you didn't propose the Agenda Entry you wish to remove 
from your Agenda, you have to double-click the Entry to view it, and then set your reply to "Will not 
attend". You will also need to set your Agenda Preferences to Do not Display Declined Entries (Edit Menu
—Preferences, Agenda, Display).

There are several ways to edit the Agenda Entries you have proposed (you cannot edit Entries proposed 
by others). You can select the Agenda Entry and then choose Open Entry from the Edit Menu. You can 
also click the Entry to edit its title directly in your Agenda, or double-click the Entry to open the Edit Entry 
dialog box.

When an Agenda Entry is selected, the tab key will always select the next Agenda Entry in chronological 
order for you. Shift + tab will take you to the previous Agenda Entry.

See Also:

The Task View
The Notes View
The Date Control Bar — Daily Agenda Page 



The Task View
Your Tasks will be displayed in this view. Four different kinds of Tasks may be displayed here: Active 
Tasks, Tasks without a Start date but with a Due date in the future, overdue, and completed Tasks. 

The Tasks are sorted according to Due date. Tasks without Due dates are listed first.

If you are viewing the Daily page of the current date, these Tasks are listed in the Task View:

· Active Tasks (that is, Tasks whose Start date has passed);

· Tasks without a Start date but with a Due date in the future;

· Overdue Tasks;

· Completed Tasks only if you completed them today, or if the current date was their Due date.

On a Daily page of a date in the past, these Tasks are listed:

· Active Tasks whose Start dates had passed on that date;

· Completed Tasks if that date was their date of completion or their Due date;

· Overdue Tasks whose Start dates had passed on that date (note that they will be displayed as Active 
Tasks if their Due date had not passed).

On a Daily page for a future date, these Tasks are listed:

· Tasks for which that date is Start or Due date;

· Tasks without Start date but whose Due date comes after that date.

A small box will appear next to each Task, indicating its status:

The Task is due in the future.
The Task is overdue.
The Task has been completed.

You can mark a Task as completed by clicking its box. You can remove the Completed check mark by 
clicking the box again. The Agenda will make all the appropriate changes to your Task.

Some Tasks may also have the following symbols:

Indicates that a Reminder has been set for the Task.

Indicates that the Task has an attachment.

Indicates that the Task has comments.

By double-clicking a Task, you can call up the Edit Task dialog box. Double-click the blank area under the 
existing Tasks, or choose New Task from the File Menu, to open the New Task dialog box. Thus, you can 
modify and create Tasks directly on your Daily Agenda page.

You can also select a Task in the Task View and use the commands Print Selected Entry from the File 
Menu, and Open, Duplicate, and Delete Entry from the Edit menu.

See Also:

The Task Display 
The Day View
The Notes View



The Date Control Bar — Daily Agenda Page



The Notes View
Daily Notes, Holidays, Upcoming Reminders and Day Events will be displayed in the Notes View.

Next to each Entry in the Notes View, there is an icon indicating what kind of Entry it is. The Entries will 
appear as follows:

Daily Note

Holiday

Day Event
Upcoming Day Event
Upcoming Agenda Entry
Upcoming Note
Upcoming Task.
Upcoming Holiday

You can open the Entries through double-clicking them.

· If you double-click a Holiday or an Entry you that you didn't propose, the View Entry dialog box is 
called up. This dialog box gives you more information about the Entry and let's you respond to it. It's 
easy to see if an Entry was proposed by someone else, since that user's name will be displayed after 
the Entry title in the Notes View. (Holidays, however, are not proposed, but rather put into the system 
by users with special rights to manage them.)

· If you double-click an Entry that you've proposed (i.e. a Daily Note, Day Event or an Upcoming Entry 
that you have created or that has been created in your name), the Edit Entry dialog box is called up.

You can create a Daily Note either by choosing New Daily Note from the File Menu, by clicking  on 
the toolbar, or by double-clicking in the Notes View below any existing Entries. You can also send copies 
of your Daily Notes to other users.

For more information on Upcoming Reminders, see: Using the Reminders.

See Also:

The Day View
The Task View
The Date Control Bar — Daily Agenda Page
Entry Defaults — Daily Notes



The Month View
In the Month View an entire month is displayed. At the beginning and the end of the month, any grid 
squares not used for the current month display will show the days of the previous or following month in 
gray. The current date is displayed in red.

The month view will display Agenda Entries, Day Events, Daily Notes and Holidays. The names of 
Holidays will appear in red next to the date along the upper edge of the grid square. Agenda Entries are 
listed first, followed by Notes, Day Events and, last, Holidays.

You can do many different things within the Month View by simply pointing and double-clicking.

· Double-clicking the upper edge of a grid square will take you to the Daily Page for that date. 

· Double-clicking an Entry that you've proposed will allow you to edit it in the Edit Entry dialog box.

· If you double-click an Entry you didn't propose, the View Entry dialog box will be called up. This dialog 
box gives you more information about the Entry and let's you respond to it.

· Double-clicking in the blank space beneath any existing Entries in a grid square will call up the New 
Agenda Entry dialog box.

The month view also lets you move Entries you've proposed from one day to another by clicking the Entry 
and dragging it to another grid square. Notice that when you click an Entry you've proposed and don't 
release the mouse button, your cursor will change to a dragging cursor: 

You select an Entry by clicking it. Once an Entry is selected, you can scroll through all the Entries in a grid 
square using the up and down arrows on your keyboard. (Those grid squares containing more Entries 
than displayed in the grid square will show a , indicating that there is more to see below.)

See Also:

The Date Control Bar — Monthly Agenda Page 



Using the Reminders
If you don't want to use the default Reminders, you can set separate Reminders for your Entries when 
you create, edit, or view them. Go to the Reminders tab of the dialog box to do so. 

To set your Reminder default preferences, choose Preferences from the Edit Menu and select Entry 
Defaults. You can set default Reminders for Agenda Entries, Tasks, Day Events and Daily Notes. There 
are no default Reminders for Holidays, but you can set Reminders for individual Holidays when you view 
them.

There are two kinds of Reminders:

· Pop-up window

· Upcoming note.

If you choose a pop-up window, a window will appear on your screen reminding you of your Entry. You 
can set how much notice you would like by setting the Reminders minutes, hours, days, weeks, months 
or even years in advance. Furthermore, you can turn the Pop-up Reminder feature on and off with a 
command on the View Menu. When your Pop-up Reminders are turned on, it is indicated by this icon in 

the status bar: .

If you choose an Upcoming note, a note reminding you of the Entry will appear in the Note View of your 
Agenda page, marked with this icon: . It can be set to appear in your Agenda days, weeks, months or 
years in advance. 

See Also:

Entry Defaults — Tasks
Entry Defaults — Day Events
Entry Defaults — Daily Notes
Entry Defaults — Agenda Entries
The Pop-Up Reminders 
The Snooze box



All about the Mail
Your Agenda works with your e-mail program to send messages to others when you reply to their 
invitations or when you create, modify, or delete Entries to which you have invited others. Furthermore, 
you can choose whether or not to let other users notify you by e-mail of new Entries that you have been 
invited to. 

Each time you create or modify an Entry to which other users have been invited, your Agenda may 
display a message box asking you if you want to send the other users an e-mail message. (This depends 
on your Preferences, which you can set using Edit Menu, Preferences, Agenda, Notification.)

· If you want to send an e-mail message, choose Yes. Your Agenda will then display the Mail Message 
dialog box for you.

· If you do not want to send an e-mail message, choose No. Your Entry will still appear in the In-trays 
and Agendas of the other users.

Mail Message

In the Mail Message dialog box, you write your message, decide to whom it will be sent, and send it.

1. Create the list of people and resources to whom you will send your mail message. All the invited 
people as well as the resource designates are included in the list by default. If your message 
concerns a new Entry, the users must have set their notification preferences to receive e-mail 
notifications about new Entries in order to be included on the list.
If you delete one of these users and then change your mind, you can quickly make the list complete 
again with the checkmark buttons at the top of the dialog box. Click the button to include the 
corresponding people in the Distribution list.

To add an additional user to the Distribution list, type the person's name in the Other edit box.
· If you want to add a resource designate, type r:, re:, or res: followed by the resource's name.
· If you want to add a group, type g:, gr:, or grp: followed by the group's name.

Choose  to accept the addition. This will add the person to the users who will receive your 
message.

Choose  to cancel the addition. This will erase the user's name from the edit box. They will not be 
added to the Distribution list.

To add several users or groups at once, use the search feature. 

Choose  to open the Search dialog box. 

2. As you add people to the list, they will appear in the Distribution List box. 
To delete a person from the list, select their name in the list box and choose Delete.

The Send key will turn gray (inactive) if there's not at least one person on the Distribution list.

3. Compose your message in the Message to Send edit box. Basic information about the Entry that the 
message corresponds to will already appear in the edit box. Scroll down to add to the message.

You can cut and paste text from other applications into your message using the standard Ctrl-C 
(copy), Ctrl-X (cut) and Ctrl-V (paste) commands.

4. Choose Send when your message is ready.



See Also:

Adding Names



Color Coding
Your Agenda can color code your Agenda Entries in one of three ways: by Importance level, by 
Attendance Status, or by Ownership. This gives you a clearer picture of the events in your Agenda at a 
glance.

If you choose to color code your Agenda Entries by Importance level, the colors will be as follows (the 
Importance level of an Entry is set when the it is created):

Extreme Importance

High Importance

Normal Importance

Low Importance

No Importance

If you color code your Agenda Entries by Attendance Status (your response to the Entry), they will appear 
as follows:

Accepted Agenda Entries

Unconfirmed Agenda Entries

Refused Agenda Entries

Accepted tentative Agenda Entries

Unconfirmed tentative Agenda Entries

Refused tentative Agenda Entries

An Agenda Entry is owned by the person or resource who proposed it. If your Agenda Entries are color 
coded by Ownership, they will appear as follows:

Agenda Entries owned (i.e. proposed) by you

Agenda Entries that you have been invited to

Tentative Agenda Entries owned (i.e. proposed) by you

Tentative Agenda Entries that you have been invited to

Please note that when you choose to color code Agenda Entries by ownership, and you open another 
user's Agenda, the Agenda Entries you (and not the Agenda's owner) have proposed will appear in blue. 
This makes it easier for you to spot Agenda Entries you can edit in other users' Agendas. (Even if you are 



in another user's Agenda, you can still edit an Entry you have proposed.) However, if you are working in 
someone else's Agenda as a designate, it will be the Agenda Entries proposed by the Agenda's owner 
that will appear in blue, since you are working in that person's Agenda as though you were the owner.

See Also:

The Color Scheme 



Getting Started
For information on getting started on your Agenda, click one of the following topic headings:

Signing in 
Signing in from your Off-line Agenda 
Searching for your User Name
Several Names Match
Selecting a Node Alias or ID 
Logging in as a Resource 
Change Password 
Verifying the Change in Password 
Off-line Preferences



The Agenda Pages
For detailed information about the Agenda pages, click one of the following topic headings:

All about the Agenda Pages
The Daily Agenda Page
The Weekly Agenda Page
The Monthly Agenda Page
Open an Agenda 

Working as a Designate
Working as a Designate 
Logging in as a Resource 
Opening the Group Agenda as a Designate
Selecting a Designator

Opening others' Agendas
The Group Agenda
Selection for the Group Agenda

Access Rights
Designate Rights 
Viewing 
Viewing Tasks 
Scheduling 



The In-tray
For detailed information about the In-tray, click one of the following topic headings:

All about the In-tray
New Entries
Entries you've Accepted
Entries you've Refused
Entries you've Sent Out
Replying to an Invitation



The Weekly Agenda Page
The Weekly Agenda page is divided into three parts:

· The Week View—subdivided into five, six, or seven Day Views (according to your Agenda 
preferences)

· The Notes View—subdivided into five, six, or seven Views (according to your Agenda preferences)

· The Date Control bar

You can resize the two views to suit your needs. The cursor will change when you point at the splitters 
between the views. It will look like this:

To move the splitters, click them and drag them to their new location. 

Each of the Day Views contained in the Week View behave in the same way as the Day View on your 
Daily Agenda page. By double-clicking the heading of any of the day columns, you can bring up the Daily 
Agenda page for that day. And when you reschedule an Agenda Entry on screen, you can move it not 
only within the Day on which it was scheduled, but also from one Day View to another within that week. In 
the same way, you can move Day Events and Notes between the different days of the Note View.

Choose from the list below to see specific information about:

The Day View 

The Notes View 

The Date Control Bar 



Tasks
You can create Tasks in your Agenda. Tasks are things you have to do, but that cannot be scheduled into 
your Agenda like a meeting or an appointment. These Tasks will appear in the Task View of your Daily 
Agenda pages and in your Task Display.

For more detailed information about Tasks, click one of the following topic headings:

The Task Display 
The Task View

Creating & Editing Tasks
General
Details
Reminders

Preferences
Entry Defaults — Tasks

Working as a Designate
Selecting a Designator
Working as a Designate 

Opening others' Tasks
User Selection



Reminders
Your Agenda can remind you of the Entries you have in it. The Reminders can be set up in a number of 
different ways, to suit the demands of your Entries and your schedule.

For more details on setting your Reminders, click one of the following topic headings:

Using the Reminders
Entry Defaults — Agenda Entries
Entry Defaults — Day Events 
Entry Defaults — Tasks 
Entry Defaults — Daily Notes 
The Pop-Up Reminders 
The Snooze Box 



Printing
You can print out your Agenda pages. The layouts for the different types of pages can be tailored to 
include only the information you want on your print-outs. The fonts and margins can also be adjusted to 
suit your needs.

For more details about printing, click one of the following topic headings:

The Print Dialog Box
Print Preview 

Layout Options
Daily Agenda Pages
Weekly Agenda Pages
Monthly Agenda Pages
Day Lists
Task List 
Fonts
Margins
Saving your Print Layouts 



Setting up your Preferences
You can personalize your Agenda to suit your needs and habits. Setting the preferences allows you to 
establish default settings that make your Agenda work for you.

For more details on setting your preferences, click one of the following topic headings:

Agenda Preferences
Display
Notification 

In-Tray Preferences
New Entries
Entries Accepted 
Entries Refused
Entries Sent Out

Scheduling Preferences
Scheduling Preferences

Entry Defaults
Agenda Entries
Tasks
Day Events
Daily Notes

General Preferences
Name Formats 
Date and Time Formats
Time Zone Preferences 

Off-line Preferences
Location 
Download 
People/Resources 
Groups 
Reconciliation 

Other
Color Coding



Agenda Entries
Any event you schedule in your Agenda's Day or Week View is considered an Agenda Entry. You can 
create Agenda Entries, view your Agenda Entries and (sometimes) those of others—this depends on the 
access level the Entry's creator has assigned the Entry—and edit the Entries you have proposed. 

For more details on Agenda Entries, click one of the following topic headings:

Creating Agenda Entries
General
Summary 
Repeating
Details
Reminders

Viewing Agenda Entries
General
Details
Linked Tasks
Reminders
Reply

Editing Agenda Entries
General
Summary
Details
Linked Tasks
Reminders
Reply 
Recurring Entries 
Moving an Entry 
Rescheduling Notification 

Preferences
Entry Defaults — Agenda Entries 

Other Topics
Details of the Conflict 
Suggesting Another Date or Time



Mail
Your Agenda works with your e-mail program to send messages to others when you reply to their 
invitations or when you create, modify, or delete Entries to which you have invited others. Furthermore, 
you can choose whether or not to let other users notify you by e-mail of new Entries that you have been 
invited to.

For more details on using your mail program with your Agenda, click one of the following topic headings:

All about the Mail
Mail Messages
Replying to an Invitation
Agenda Preferences — Notification 



Searching
You can search for people, groups and resources using the Search dialog box. You call this dialog box up 

by clicking . By filling in one or more search parameters, you can make your search as broad or as 
narrow as you need. 

For more details on searches, click one of the following topic headings:

Selecting Several Users
Searching — People
Searching — Groups
Searching — Resources
The User Information Box 
The Resource Information Box
Where is… 



Groups
Your Agenda allows you to create groups of users and resources. These groups lets you save time when 
you need to invite the same set of people and/or resources on a regular basis. You can create groups of 
different types, which determine to whom the group will be available. 

For more information on groups, click one of the following topic headings:

Group Management
Selecting a Group
Searching — Groups



Glossary
Access level 
Agenda Entry 
Associate 
Attachment 
Attendance Status 
Calendar 
Creator 
Daily Note 
Day Event 
Default 
Designate 
Domain 
E-mail 
Entry 
Foreign user 
Group Types 
Importance level 
Local user 
Node 
Off-line 
On-line 
Organization unit 
Ownership 
Propose 
Reconciliation 
Remote user 
Resource 
Search Parameter 
Server 
Status bar 
Task 
Tentative 
Time Control 
Time slot 
Toolbar 



All about the Agenda Pages
The Agenda pages are displayed in three basic formats: Daily, Weekly and Monthly. They can show either 
your personal Agenda or a Group Agenda, showing the Entries of a group of people on one Agenda page. 
And if you have been granted the rights by another user, you may open any of these Agenda pages as a 
Designate for that user. You can also have the right to view another user's Agenda, without being able to 
work in that user's name

The Agenda pages not only allow you to see the Entries, but also to edit existing Entries and add new 
Entries directly on the page.

You can open an Agenda in one of two ways: either select Open Agenda from the File Menu or select 

 from the toolbar.

See Also:

The Daily Agenda Page
The Weekly Agenda Page 
The Monthly Agenda Page
Open an Agenda 
The Group Agenda 
Opening the Group Agenda as a Designate 



Access Rights — Designate
The Access Rights dialog box (Edit Menu, Access Rights) lets you give designate rights to others. Here 
you decide which of your Entries other users can view in your Agenda, and how much information about 
them they will see (for example, when they are working with a Group Agenda). Furthermore, you choose 
default settings for access rights in your Agenda in this dialog box.

You can also block other users from the possibility of inviting you to Entries here.

Choose what rights each designate will have in your Agenda using the Designate tab of the dialog box. 
These rights can also be changed here.

1. To grant designate rights to another user, select the person's name from the list of users with special 
access rights shown in the list box. If the name isn't already in the list, add it using the edit box. Once 
you click the checkmark button, the name will be added to the list box.

2. Use the check boxes on the Designate tab to choose what rights you want to give the individual 
designate to work with your Entries for each access level. For Agenda Entries, Day Events, and Daily 
Notes, you can choose between three options for every access level:

· View times only: The designate will only have the right to view the times on which you have 
Agenda Entries scheduled (if you choose this option, the designate will not see Notes or Day 
Events with this access level in your Agenda).

· View/Reply: The designate will have the right to view your Entries completely, as well as the right 
to reply to invitations in your name.

· Modify: The designate will have the right to modify your Entries.

You can assign different rights to different types of Entries, according to the access level you have 
assigned your Entries.

· Normal Entries: The designate will be able to view or edit Agenda Entries, Day Events, and 
Notes that you have given "normal" access.

· Confidential Entries: The designate will be able to view or edit Agenda Entries, Day Events, and 
Notes that you have given "confidential" access.

· Personal Entries: The designate will be able to view or edit Agenda Entries, Day Events, and 
Notes that you have given "personal" access.

· Public Entries: The designate will be able to edit Agenda Entries, Day Events, and Notes that 
you have given "public" access. (You cannot block a designate from viewing Public Entries.)

Note that you must grant a user the right to modify Agenda Entries, Day Events, and Daily Notes for 
at least one access level in order to grant them the right to open your Agenda as a designate. That is, 
users must have the right to edit some kind of Agenda Entries, Day Events, and Daily Notes in order 
to work as designates on your Agenda pages.

3. The check boxes to the right on the tab concern designate rights to your Tasks. When you give 
designate rights to your Tasks, your designate will either have full designate rights (i.e. right to view 
and modify) or no designate rights.

· Normal Tasks: The designate will be able to view and edit Tasks you have given "normal" 
access.

· Confidential Tasks: The designate will be able to view and edit Tasks you have given 
"confidential" access.

· Personal Tasks: The designate will be able to view and edit Tasks you have given "personal" 
access.

· Public Tasks: The designate will be able to view and edit Tasks you have given "public" access.



4. Instead of setting the rights for each type of Entry individually, you can also choose to grant the user:

· Full Designate Rights: The user will have rights to view and modify all Entries.
· No Designate Rights: The user will have no designate rights in your Agenda.
· Same as Default: The user's rights will be set to be the same as the default. Select this option if 

you don't want to give the person any special access rights on this tab of the dialog box, but still 
want to keep the name on the list in order to set his or her rights on another tab.

5. To delete a name from the list of users with special access rights, select the name from the list box 
and choose Delete. They will then revert to having the same rights as the default. Note, however, that 
this applies to all their rights that are set on all the different tabs of the dialog box.

6. If you want to choose default settings, select Default: Any unlisted person in the list box and 
choose settings in the same way you would for an individual user (see above).

NOTE: It is not recommended for users to give designate rights to every user on the system. 
Furthermore, the names of those users who do give such rights to all users will not appear on everyone's 
list of possible designates in the Open Agenda dialog box.

Choose OK when you have finished using all the tabs of the dialog box.

See Also:

Access Rights — Viewing 
Access Rights — Viewing Tasks 
Access Rights — Scheduling 
Adding Names
Open an Agenda 
Selecting a Designator 



Access Rights — Viewing
The Access Rights dialog box (Edit Menu, Access Rights) lets you give designate rights to others. Here 
you decide which of your Entries other users can view in your Agenda, and how much information about 
them they will see (for example, when they are working with a Group Agenda). Furthermore, you choose 
default settings for access rights in your Agenda in this dialog box.

You can also block other users from the possibility of inviting you to Entries here.

The Viewing tab of the dialog box lets you control what Agenda Entries, Day Events, and Daily Notes in 
your Agenda will be visible to other Users.

1. To grant viewing rights to another user, select the person's name from the list of users with special 
access rights shown in the list box. If the name isn't already in the list, add it using the edit box. Once 
you click the checkmark button, the name will be added to the list box.

2. Use the check boxes on the Viewing tab to choose what viewing rights you want to give the user for 
Agenda Entries, Day Events, and Daily Notes. You set the rights separately for Normal, Confidential 
and Personal access levels (you cannot block another user from viewing Public Entries). 
You have two options on each access level: users can either see only the blocks of busy time (View 
times only) or the full information about the Entries (View Entries).

Note: If you only give the right to view busy times, the user won't be able to view Day Events or Notes 
with that access level in your Agenda.

3. Instead of setting the rights for each type of Entry individually, you can also choose to grant the user:

· Full Viewing Rights: The user will have rights to view all Agenda Entries, Day Events, and 
Notes.

· No Viewing Rights: The user will only have the right to view Public Agenda Entries, Day Events, 
and Notes in your Agenda. (Public Entries can always be viewed by all users.)

· Same as Default: The user's rights will be set to be the same as the default. Select this option if 
you don't want to give the person any special access rights on this tab of the dialog box, but still 
want to keep the name on the list in order to set his or her rights on another tab.

4. To delete a name from the list of users with special access rights, select the name from the list box 
and choose Delete. They will then revert to having the same rights as the default. Note, however, that 
this applies to all their rights that are set on all the different tabs of the dialog box.

5. If you want to choose default settings, select Default: Any unlisted person in the list box and 
choose settings in the same way you would for an individual user (see above).

Choose OK when you have finished using all the tabs of the dialog box. 

See Also:

Access Rights — Viewing Tasks 
Access Rights — Scheduling 
Access Rights — Designate 
Adding Names



Access Rights — Viewing Tasks
The Access Rights dialog box (Edit Menu, Access Rights) lets you give designate rights to others. Here 
you decide which of your Entries other users can view in your Agenda, and how much information about 
them they will see (for example, when they are working with a Group Agenda). Furthermore, you choose 
default settings for access rights in your Agenda in this dialog box.

You can also block other users from the possibility of inviting you to Entries here.

The Viewing Tasks tab of the dialog box lets you control what Tasks in your Agenda will be visible to other 
users.

1. To grant Task viewing rights to another user, select the person's name from the list of users with 
special access rights shown in the list box. If the name isn't already in the list, add it using the edit 
box. Once you click the checkmark button, the name will be added to the list box.

2. Use the check boxes on the Viewing Tasks tab to choose what Task viewing rights you want to give 
the user. You set the rights separately for Normal, Confidential and Personal access levels (you 
cannot block another user from viewing Public Tasks). If you grant users the right to view Tasks of an 
access level, they will be able to see all the information about those Tasks.

3. Instead of setting the rights for each type of Task individually, you can also choose:

· Full Viewing Rights: The user will have rights to view all Tasks.
· No Viewing Rights: The user will only have the right to view Public Tasks in your Agenda. (Public 

Tasks can always be viewed by all users.)
· Same as Default: The user's rights will be set to be the same as the default. Select this option if 

you don't want to give the person any special access rights on this tab of the dialog box, but still 
want to keep the name on the list in order to set his or her rights on another tab.

4. To delete a name from the list of users with special access rights, select the name from the list box 
and choose Delete. They will then revert to having the same rights as the default. Note, however, that 
this applies to all their rights that are set on all the different tabs of the dialog box.

5. If you want to choose default settings, select Default: Any unlisted person in the list box and 
choose settings in the same way you would for an individual user (see above).

Choose OK when you have finished using all the tabs of the dialog box.

See Also:

Access Rights — Scheduling 
Access Rights — Designate 
Access Rights — Viewing 
Adding Names



Access Rights — Scheduling
The Access Rights dialog box (Edit Menu, Access Rights) lets you give designate rights to others. Here 
you decide which of your Entries other users can view in your Agenda, and how much information about 
them they will see (for example, when they are working with a Group Agenda). Furthermore, you choose 
default settings for access rights in your Agenda in this dialog box.

You can also block other users from the possibility of inviting you to Entries here.

The Scheduling tab of this dialog box lets you control which users can invite you to Entries.

1. To set a user's scheduling rights, select the person's name from the list of users with special access 
rights shown in the list box. If the name isn't already in the list, add it using the edit box. Once you 
click the checkmark button, the name will be added to the list box.

2. Select "Can invite me to events" to give the person the right to schedule Entries where you are listed 
as a participant. 
Clear "Can invite me to events" to block the person from scheduling Entries where you are listed as a 
participant.

3. You can also choose Same as Default. The user's rights will then be set to be the same as the 
default. Select this option if you still want to keep the user's name on the list in order to set his or her 
rights on another tab.

4. To delete a name from the list of users with special access rights, select the name from the list box 
and choose Delete. They will then revert to having the same rights as the default. Note, however, that 
this applies to all their rights that are set on all the different tabs of the dialog box.

5. If you want to choose default settings, select Default: Any unlisted person in the list box and 
choose settings in the same way you would for an individual user (see above).

Choose OK when you have finished using all the tabs of the dialog box.

See Also:

Access Rights — Designate 
Access Rights — Viewing 
Access Rights — Viewing Tasks 
Adding Names 



The Group Agenda
The Group Agenda allows you to open the Day Views of several people and resources side by side, so 
you can view the Agenda Entries of others and schedule an event with them at a time when everyone is 
available. 

You choose which people and resources will be included in your Group Agenda using the Selection for 
Group Agenda dialog box. It appears when you select Group Agenda from the File Menu (File Menu, 

Open Agenda, A Group Agenda) or choose  on the toolbar.

The Group Agenda is made up of a number of columns. Along the top of the columns appear the names 
of the people and resources you have chosen to include in your Group Agenda. The first column is a 
Combined view—it shows at what times all the people and resources you have selected for your Group 
Agenda are available. All the subsequent columns show the individual Day Views that make up the Group 
Agenda.

The Group Agenda's Date Control bar has one extra button: . Clicking this button will return you to the 
Selection for the Group Agenda dialog box. You can then add or remove people and resources in your 
current Group Agenda.

You can schedule Agenda Entries using the first column of the Group Agenda. In fact, that column is like 
your own Agenda's Day View, with the filled time slots of the other Day Views superimposed. So you can 
schedule the Entry directly in that first column just as you would on your regular Daily Agenda page.

In the New Agenda Entry dialog box that will appear, you will see that on the General tab, the names of 
those people and resources whose Agendas you have opened will already appear on the list of invited 
people and resources. You can still add to and delete from the list as you would when creating any other 
Entry. And you can still edit the People/Resources list later using the Edit Entry dialog box.

In the Group Agenda, you may also schedule an Agenda Entry in a single user's Agenda, in the same way 
as if you had opened only that person's or resource's Agenda. The Combined view will automatically 
adjust to accommodate any such Entries that you create.

The Group Agenda gives you a more convenient way of scheduling an event with several other people, 
instead of viewing each of the other Agendas individually.

See Also:

Selection for Group Agenda
The Daily Agenda Page
Creating an Agenda Entry — General
Editing an Agenda Entry — General



Selection for the Group Agenda
The Selection for the Group Agenda dialog box will appear when you select Open Group Agenda from the 

File Menu (File Menu, Open Agenda, Open Group Agenda) or choose  from the toolbar. It allows you 
to select the people and resources whose Agendas' Day Views will be included in the Group Agenda you 
are about to open.

To add names:

1. Type the person's, resource's, or group's name in the edit box.

· If you want to add a resource, type r:, re:, or res: followed by the resource's name.
· If you want to add a group, type g:, gr:, or grp: followed by the group's name.

2. Once the name is in the edit box:

· Choose  to accept the addition. This will add the person to the list of people/resources you 
are creating.

· Choose  to cancel the addition. This will erase the person's name from the edit box. They will 
not be added to the list of people/resources you are creating.

· Choose  to search for people, groups or resources.

· Choose  to select a group for your list.

3. To delete a name from the list box, select the name and choose Delete.

4. When your list is complete, choose OK.

See Also:

Adding Names
The Group Agenda



Opening the Group Agenda as a Designate
Opening a Group Agenda as a designate lets you create Agenda Entries using the Group Agenda while 
working as a designate for someone else.

The Group Agenda gives you a more convenient way of scheduling an event with several other people, 
instead of viewing each of the other Agendas individually.

When you choose Opening the Group Agenda as a Designate from the File Menu (File Menu, Open 
Agenda, A Group Agenda As Designate), the Designate Selection dialog box will appear. Select the 
person or resource for whom you wish to work as a designate.

After you have chosen for whom you are working as a designate, the Selection for Group Agenda dialog 
box will appear. Select the people and resources who will be included in the Group Agenda. When you 
have made your selections, your Agenda will create a Group Agenda for you.

The Group Agenda is made up of a number of columns. Along the top of the columns appear the names 
of the people and resources you have chosen to include in your Group Agenda. The first column is a 
Combined view—it shows at what times all the people and resources you have selected for your Group 
Agenda are available. All the subsequent columns show the individual Day Views that make up the Group 
Agenda.

The Group Agenda's Date Control bar has one extra button: . Clicking this button will return you to the 
Selection for the Group Agenda dialog box. You can then add or remove people and resources in your 
current Group Agenda.

You can schedule Agenda Entries using the first column of the Group Agenda. In fact, that column is like 
the Day View of the Agenda you are working in as a designate, with the filled time slots of the other Day 
Views superimposed. So you can schedule the Entry directly on that first column just as you would on a 
regular Daily Agenda page.

In the New Agenda Entry dialog box that will appear, you will see that on the General tab, the names of 
those people and resources whose Agendas you have opened will already appear on the list of invited 
people and resources. You can still add to and delete from the list as you would when creating any other 
Entry. You can still edit the People/Resources list later using the Edit Entry dialog box. The Agenda 
Entries you create as a designate will be displayed in the designator's Agenda and In-tray, just as if he or 
she had created them.

In the Group Agenda, you may also schedule an Agenda Entry in a single user's Agenda, in the same way 
as if you had opened only that person's or resource's Agenda. The Combined view will automatically 
adjust to accommodate any such Entries that you create.

See Also:

Selection for Group Agenda
The Daily Agenda Page
The Group Agenda
Creating an Agenda Entry — General
Editing an Agenda Entry — General
Selecting a Designator 
Access Rights — Designate 



The Pop-Up Reminders
When you set your Reminders, you can choose either an Upcoming note or a Pop-up Window.

The Pop-up Window contains all the Reminders active at one time. You can scroll through them by 

clicking .

As you scroll through your Reminders, the icon will indicate to what kind of Entry your Reminder refers. 
They will appear as follows:

Agenda Entry

Day Event

Holiday

Task

Daily Note

The title, date, Start time and End time will be displayed, as applicable.

You can handle your Reminders in several ways.

· Choose Open… to go to the View Entry dialog box and see the Entry in detail.

· Choose Reminder… to go to the Reminder tab of the View Entry dialog box. You can make changes 
to the Reminders here.

· Choose Snooze… to turn the Reminder off temporarily. A dialog box will appear asking you for how 
long you want your Reminders to snooze.

· Choose Clear… to turn off the Reminder you are viewing.

· Choose Clear All… to turn off all of active Reminders.

See Also:

Using the Reminders
The Snooze box 



The Snooze Box
The Snooze dialog box will appear when you choose Snooze… in the Reminders dialog box.

The Snooze function lets you turn off the Reminders dialog box for a period of time.

1. To use the Snooze function, set the time interval using the arrows to the right of the edit box and 
selecting an interval. You can choose to let your Pop-up Reminders snooze for minutes or hours.

2. Type in the appropriate number in the edit box to the left.

3. Choose OK.



Entry Defaults — Agenda Entries
The Entry Defaults dialog box (Edit Menu, Preferences, Entry Defaults) allows you to set the Entry 
defaults for all the new Entries in your Agenda.

This tab lets you set the default settings for Agenda Entries.

1. Choose the default setting for the importance level and access level. Click the button on the right-
hand side of the edit boxes to see the options. Choose one for each.

2. Set the Default Reminders.
Select the On or Off button. Once you select the On button, you can set the Reminders options.

3. Choose whether you want your default Reminder to be a Pop-up window or an Upcoming note by 
clicking the arrow next to the Reminder box, and selecting the appropriate alternative.

4. Set when you wish to be reminded. Click the arrow next to the right-hand box to see the options. You 
can choose to be reminded minutes, hours, days, weeks, months, or even years in advance. Type the 
appropriate number in the box on the left.

Note: This Reminder setting will also be the default for any Entries that you receive from other users. 
That is, not only for Agenda Entries, but also for Day Events, Daily Notes, and Holidays that you 
receive from other users.

5. Choose OK only when you've finished with all the tabs of the dialog box.

See Also

Using the Reminders



Entry Defaults — Tasks
The Entry Defaults dialog box (Edit Menu, Preferences, Entry Defaults) allows you to set the Entry 
defaults for all the new Entries in your Agenda.

This tab lets you set the default settings for Tasks you create.

1. Choose the default setting for the Priority and access level. Click the button on the right-hand side of 
the edit boxes to see the options. Choose one for each.

2. Choose the default settings for the Task Start and Task Due Reminders.

For each Reminder, choose the On or Off button. Once you select the On button, you can set the 
Reminders options.

3. For each Reminder, choose whether you want your default Reminder to be a Pop-up window or an 
Upcoming note by clicking the arrow next to the Reminder box, and selecting the appropriate 
alternative.

4. Set when you wish to be reminded. Click the arrow next to the right-hand box to see the options. You 
can choose to be reminded minutes, hours, days, weeks, months, or even years in advance. Type the 
appropriate number in the left-hand boxes.

5. Choose OK only when you've finished with all the tabs of the dialog box.

See Also

Using the Reminders



Entry Defaults — Day Events
The Entry Defaults dialog box (Edit Menu, Preferences, Entry Defaults) allows you to set the Entry 
defaults for all the new Entries in your Agenda.

This tab lets you set the default settings for the Day Events you create.

1. Choose the default setting for the access level. Click the button on the right-hand side of the edit box 
to see the options. Choose one.

2. Set the Default Reminders.
Select the On or Off button. Once you select the On button, you can set the Reminders options.

3. Choose whether you want your default Reminder to be a Pop-up window or an Upcoming note by 
clicking the arrow next to the Reminder box, and selecting the appropriate alternative.

4. Set when you wish to be reminded. Click the arrow next to the right-hand box to see the options. You 
can choose to be reminded minutes, hours, days, weeks, months, or even years in advance. Type the 
appropriate number in the box on the left.

Note: This Reminder setting will not be the default for Day Events that you receive from other users. 
For those Entries, the default Reminders are the same as for Agenda Entries.

5. Choose OK only when you've finished with all the tabs of the dialog box.

See Also

Using the Reminders



Entry Defaults — Daily Notes
The Entry Defaults dialog box (Edit Menu, Preferences, Entry Defaults) allows you to set the Entry 
defaults for all the new Entries in your Agenda.

This tab lets you set the default settings for the Daily Notes you create.

1. Choose the default setting for the access level. Click the button on the right-hand side of the edit box 
to see the options. Choose one.

2. Set the Default Reminders.
Select the On or Off button. Once you select the On button, you can set the Reminders options.

3. Choose whether you want your default Reminder to be a Pop-up window or an Upcoming note by 
clicking the arrow next to the Reminder box, and selecting the appropriate alternative.

4. Set when you wish to be reminded. Click the arrow next to the right-hand box to see the options. You 
can choose to be reminded minutes, hours, days, weeks, months, or even years in advance. Type the 
appropriate number in the box on the left.

Note: This Reminder setting will not be the default for Daily Notes that you receive from other users. 
For those Entries, the default Reminders are the same as for Agenda Entries.

5. Choose OK only when you've finished with all the tabs of the dialog box.

See Also

Using the Reminders



Moving an Entry
The Move Entry dialog box (Edit Menu, Reschedule Entry) lets you move the Entry you have selected in 
your Agenda to another date and/or time.

1. Change the date of the Entry by setting the new date in the Date edit box. Use the arrows to the right 
of the box to adjust the time or choose the calendar button.

2. If you are moving an Entry with a Start time and an End time, the dialog box will also have edit boxes 
where you can change those times.
Change the Start and End times by either using the arrows to the right of the edit boxes or by 
choosing the clock button.
Notice that the Duration will adjust itself accordingly. (You can also adjust the duration instead of the 
End time, if you prefer—your Agenda will then adjust the End time for you.)

3. If you are moving an Agenda Entry, the dialog box will contain a Suggest Another Date button. 
Choose it to call up the Suggest Date/Time dialog box, where your Agenda will help you find another 
time or date for the Entry.

4. Choose OK.

NOTE: Each time you create or modify an Entry to which other users have been invited, your Agenda 
may display a message box asking you if you want to send the other users an e-mail message. (This 
depends on your Preferences, which you can set using Edit Menu, Preferences, Agenda, Notification.)

· If you want to send an e-mail message, choose Yes. Your Agenda will then display the Mail Message 
dialog box for you.

· If you do not want to send an e-mail message, choose No. Your Entry will still appear in the In-trays 
and Agendas of the other users.

See Also:
 
Editing an Agenda Entry — General 
Suggesting another Date 



Selecting a Node Alias or ID
When you open your Agenda, you will see a dialog box asking you to sign in. It asks you to fill in your 
name, password and server name.

The server may have several nodes where your information is stored. You need to specify to which node 
you want to connect.

Select the correct node and choose OK.

See Also:

Signing In 



Editing a Recurring Entry — Agenda Entries
When you double-click a recurring Entry that you've proposed (or in some other way indicate that you 
want to edit it), you will be asked whether you want to edit only that specific recurrence or if you want to 
edit several recurrences of the Entry. If you choose to edit several recurrences, you will come to the Edit 
Recurring Entry dialog box, where you can edit as many recurrences you like.

1. Select which recurrences of the Agenda Entry you want to edit from the list box.

· If you want to edit all recurrences of the Entry, choose All.
· To select all dates prior to the one you have highlighted, choose All Previous.
· To select all dates following the one you have highlighted, choose All Next.
· To select several consecutive dates, hold down the Shift key and click the first and the last of the 

dates that you want to edit.
· To select several non-consecutive dates, hold down the Ctrl key when you click them.
· To unselect all recurrences, choose Clear.

2. From the box on the right, you can choose between a number of actions.

· To change the title of the Agenda Entry for the selected dates, choose Title. This will call up the 
New Title dialog box.

· To change the location of the Agenda Entry for the selected dates, choose Location. This will call 
up the New Location dialog box.

· To add people and resources to the Agenda Entry's list of attendees for the selected dates, 
choose Add Attendees. This will call up the Add People/Resources dialog box.

· To remove people and resources from the Agenda Entry's list of attendees for the selected dates, 
choose Delete Attendees. This will call up the Delete People/Resources dialog box.

· To change the Agenda Entry's Reminder settings for the selected dates, choose Reminders. This 
will call up the Reminder dialog box.

· To change your reply to the Agenda Entry for the selected dates, choose Reply. This will call up 
the Reply dialog box.

· To delete the selected dates, choose Delete Recurrences. The recurrences will be removed from 
your Agenda (and the Agendas of any attendees) when you choose OK.

· To view a specific recurrence, select that date from the list and choose View original. This will 
call up the View Entry dialog box.

· To change the date and/or time of a specific recurrence, select it from the list and choose 
Date/Time. This will call up the Move Entry dialog box. You can only change the date of one 
recurrence at a time. However, you can change the time of more than one recurrence at a time. 

3. Choose OK only when you've done all the changes you want to do.

NOTE: Each time you create or modify an Entry to which other users have been invited, your Agenda 
may display a message box asking you if you want to send the other users an e-mail message. (This 
depends on your Preferences, which you can set using Edit Menu, Preferences, Agenda, Notification.)

· If you want to send an e-mail message, choose Yes. Your Agenda will then display the Mail Message 
dialog box for you.

· If you do not want to send an e-mail message, choose No. Your Entry will still appear in the In-trays 
and Agendas of the other users.

See Also:

New     Title   



New Location 
Adding People/Resources to Recurring Entries 
Deleting People/Resources from Recurring Entries 
Viewing an Agenda Entry — General 
Moving an Entry 
Editing your Reply for a Recurring Agenda Entry
Editing Reminders for a Recurring Entry



Editing a Recurring Agenda Entry
When you choose to edit a recurring Agenda Entry, your Agenda will ask you whether you want to edit 
only the selected recurrence of the Agenda Entry, or several recurrences.

· If you choose "Edit this recurrence only", your Agenda will call up the Edit Entry dialog box for the 
selected recurrence.

· If you choose "Edit several recurrences", your Agenda will call up the Edit Recurring Entry dialog box.

Select one of the options and choose OK.



New Location
When you choose to edit the Location of an Agenda Entry in the Edit Recurring Entry dialog box, your 
Agenda will call up this dialog box.

1. Type in the new location for the Agenda Entry you are editing.

2. Choose OK. This will return you to the Edit Recurring Entry dialog box.



New Title
When you choose to edit the Title of an Entry in the Edit Recurring Entry dialog box, your Agenda will call 
up this dialog box.

1. Type in the new title for the Entry you are editing.

2. Choose OK. This will return you to the Edit Recurring Entry dialog box.



Editing a Day Event — Agenda Status
The Edit Entry dialog box lets you make changes to a Day Event you have scheduled. You can call up 
this dialog box either by double-clicking the Entry in your In-tray or on your Agenda page, or by selecting 
it on the Agenda page and choosing Open Entry from the Edit Menu.

This dialog box will only appear if you proposed the Entry you have selected. If you didn't propose the 
Entry, the View Entry dialog box will appear instead. (You cannot edit information about Entries you 
haven't proposed.) 

When you edit a Day Event to which you have invited others, the changes you make will automatically 
appear in their Agendas as well. If you change the date of the Event, it will appear as a new Day Event in 
their In-tray.

The Agenda tab lets you choose whether or not to keep the Day Event in your Agenda. A summary of the 
Entry is displayed on this tab, so you don't have to go to the other tabs to get the information.

The summary lists the following information about the Day Event:

· Who proposed the Entry;

· Title;

· Date;

· Access level;

· People invited.

To change the status of the Day Event, select one of the three options offered:

· Keep in Agenda.

· Remove from Agenda.

· Decide later.

Choose OK only once you've finished with all the tabs of the dialog box.

NOTE: Each time you create or modify an Entry to which other users have been invited, your Agenda 
may display a message box asking you if you want to send the other users an e-mail message. (This 
depends on your Preferences, which you can set using Edit Menu, Preferences, Agenda, Notification.)

· If you want to send an e-mail message, choose Yes. Your Agenda will then display the Mail Message 
dialog box for you.

· If you do not want to send an e-mail message, choose No. Your Entry will still appear in the In-trays 
and Agendas of the other users.

See Also:

Editing a Day Event — General 
Editing a Day Event — Summary
Editing a Day Event — Reminders
Entry Defaults — Day Event



Viewing a Day Event — Agenda Status
The View Entry dialog box displays information about the Day Event you have selected. You can call up 
this dialog box either by double-clicking the Entry in your In-tray (if you have set your Preferences for this 
option), double-clicking the Entry on your Agenda page, or selecting it on the Agenda page and choosing 
Open Entry from the Edit Menu.

This dialog box will only appear if you didn't propose the Entry you have selected. If you did propose the 
Entry, the Edit Entry dialog box will appear instead. (You cannot edit information about Entries you haven't 
proposed.)

When the View Entry dialog box is called up for a Day Event, the Agenda tab will always be displayed, in 
order for you to quickly choose whether or not to keep it in your Agenda. A summary of the Entry is 
displayed on this tab, so you don't have to go to the other tabs to get the information you need to respond 
to the Day Event.

The summary lists the following information about the Day Event:

· Who proposed the Entry;

· Title;

· Date;

· Access level;

· People invited.

To respond to the Day Event:

1. Select one of the three options:

· Keep in Agenda
· Remove from Agenda
· Decide later

2. If the Entry you are viewing is a recurring one, a list box will display all the dates on which the Entry 
has been scheduled. If you change your reply, the new reply will apply only to the selected dates.

· To change the reply to all recurrences of the Entry, choose Apply to All.
· To select several consecutive dates in the list box, hold down the Shift key and click the first and 

the last of the dates. Once all the appropriate dates are selected, change your reply.
· To select several non-consecutive dates in the list box, hold down the Ctrl key when you click 

them. Once all the appropriate dates are selected, change your reply.

In the list box with all the dates of a recurring Entry, these icons will indicate your reply to them:

for Entries you have accepted;

for Entries you have refused;

for Entries you have not responded to yet.

Choose OK only once you've finished with all the tabs of the dialog box.

See Also:

Viewing a Day Event — General 



Viewing a Day Event — Reminders
Entry Defaults — Day Events



Unable to Invite...
When you try to invite a person or resource whom you do not have the right to invite, this dialog box will 
appear.

All users can control their scheduling access (see Edit Menu, Access Rights, Scheduling). They may 
choose to block certain other users from inviting them to Entries.

Choose OK to close the dialog box. Your Agenda will automatically adjust the list of invited people and 
resources according to your Scheduling Rights.

See Also:

Access Rights — Scheduling 



Access Rights
The Access Rights dialog box (Edit Menu, Access Rights) lets you give designate rights to others. It also 
lets you decide how much information about your Entries other users will have access to when they open 
your Agenda (for example, when they are working in a Group Agenda). 

Furthermore, you set the defaults for other users' access rights in your Agenda here.

You can also block users from inviting you to Entries.

For more details on access rights, click one of the following topic headings:

Access Rights — Designate 
Access Rights — Scheduling 
Access Rights — Viewing Tasks 
Access Rights — Viewing 
Unable to Invite… 



The Task Display
The Task Display contains all of your Tasks: active, uncompleted, completed and overdue. 

To open your Task Display, either select Open Tasks from the File Menu or choose  from the toolbar. 

When you select Open Tasks from the File Menu, you will have three options to choose from:

· Your Tasks

· Modify Other's as Designate

· View Other's Tasks

If you choose Your Tasks:
Choosing Your Tasks opens your own Task Display, where you can work with your own Tasks: you can 
view, edit and add Tasks.

If you choose Modify Other's as Designate:
Choosing Modify Other's as Designate lets you open someone else's Task Display and work on that 
user's Tasks as a designate (the person must have given you the right to do so). When you work on 
someone else's Tasks as a designate, you can view, edit and add that user's Tasks, according to the 
Designate Rights the user has granted you (Edit Menu, Access Rights, Designate).

If you choose View Other's Tasks:
Choosing View Other's Tasks lets you open someone else's Task Display to view their Tasks. But you will 
only be able to see the information for which you have been given Viewing Rights by that user (Edit 
Menu, Access Rights, Tasks). Depending on these rights, you will be able to view some or all Tasks, but 
you will not be able to make any changes to them.

Working in the Task Display
In the Task Display, you will find a list of Tasks. Next to each Task, a small box indicating its status will 
appear: 

The Task is due in the future.

The Task is overdue.

The Task has been completed.

Some Tasks may also have the following symbols:

Indicates that a Reminder has been set for the Task.

Indicates that the Task has an attachment.

Indicates that the Task has comments.

You can choose to display all or only some Tasks in the Task Display, by selecting one of the following 
commands from the View Menu's Show Tasks submenu:



· All Tasks

· Incomplete Tasks

· Completed Tasks

· Active Tasks.

You can also choose how you wish to sort your Tasks, by selecting one of the following from the View 
Menu's Sort Tasks submenu:

· by Description

· by Due Date

· by Start Date

· by Priority

Another way to sort your Tasks is by clicking the heading above the column by which you want your Tasks 
sorted. This option gives you an additional way of sorting the Tasks: Select %Completed to sort the Tasks 
by the completion percentage.

You can manage the Tasks using commands from the Edit and File Menus. If you are working in your own 
Task Display or working as a designate, you also have the option of using the buttons shown along the 
bottom of the display and the New edit box at its top.

· Complete: Choosing this button will mark the Task you have selected from the list as being 
completed. The Task will be marked as 100% Completed and the completion date will be filled in 
automatically.

· New: This button calls up the New Task dialog box. Selecting New Task from the File Menu will do the 
same thing.

· You can also type the Task's description directly in the New edit box at the top left of the Task Display, 
and choose the Checkmark button (choosing the 'X'-button will erase what you have typed in). When 
you create a Task in this way, the Task is added in the list right away and the New Task dialog box is 
never called up.

· Edit: Choosing this button will open up an Edit Task dialog box containing the Task you have selected 
from the list. You can also double-click a Task, or choose Open Selected Task from the Edit Menu, to 
call up the Edit Task dialog box.

· Delete: This button lets you delete the Task you have selected from the list. Selecting Delete 
Selected Task from the Edit Menu will do the same thing.

There are two functions available from the Menus that cannot be accessed using the buttons at the 
bottom of the display. These are:

· Duplicate Selected Task from the Edit Menu — makes a copy of the Task you have selected;

· Print Selected Task from the File Menu— prints the Task you have selected.

When viewing someone else's Tasks, you cannot make any changes in the Task Display. Therefore, the 
buttons and the New edit box mentioned above are not available. If you double-click a Task in the list 
here, the View Task dialog box is called up.

To print a complete listing of your Tasks, choose  from the toolbar.

See Also:

Tasks 



The     Task     View   
Creating & Editing Tasks — General 
View Task 



The Export Utility
The Export Utility allows you to export information from Agendas into text files or supported palmtops.

1. Choose whether you want to export to a file or to a palmtop by selecting the appropriate button (File 
or Palmtop). 

2. Select to what type of file or palmtop you will be exporting your data. Click the arrow to the right of the 
edit box and select one of the options.

Text file formats:
· ASCII comma delimited file
· ASCII tab delimited file
· ASCII activity by Date file
· ASCII activity by item file
· ASCII full activity file
· HP 100LX/200LX Appointment Book file (creates a 100LX/200LX-compatible data file)
· vCalendar file (text file used to transfer calendar data to any application that can paste plain text 

or the vCalendar registered format to the clipboard).

Palmtop formats:
· Hewlett-Packard HP 100LX palmtop
· Hewlett-Packard HP 200LX palmtop

3. Choose the period for which you wish to export data. You have three options:

· Set the range of dates that you want to export your Entries for. Select Range and enter the Start 
and End dates using the arrows to the right of the edit boxes below or by choosing the calendar 
button.

· Export all the Entries contained in your Agenda by selecting All.
· Customize the time period that you want to export your Entries for. Select Custom and set the 

time period with the edit boxes below. Select from the alternatives that are displayed when you 
click on the arrows next to the two right-hand edit boxes. Then type in the appropriate numbers in 
the small left-hand edit boxes. Your customized time period will be saved until the next time you 
export data.

4. Select the people and resources from whose Agendas you wish to export data. Type their names one 
by one in the People/Resources edit box and add them to the list in the list box below. Your Agenda 
will export the Entries of all the people and resources listed.

· If you want to add a resource, type r:, re:, or res: followed by the resource's name.
· If you want to add a group, type g:, gr:, or grp: followed by the group's name.

· Choose  to accept the name. Your Agenda will export data from this user.

· Choose  to reject the name. This will erase the user's name from the edit box. Your Agenda 
will not export data from this user.

· To select a group, click .

· To search for people, resources or groups, click 

You can remove people or resources from the list by selecting their names in the list box and 
choosing Delete.



5. File names will automatically be assigned to the files being created when you export. If you select the 
name of a person or a resource in the list box, the corresponding file name is displayed in the edit box 
below. You can change the names of these files if you wish to. If you are not exporting to a palmtop, 
you can look for the file on your system by clicking Browse.

6. If you are exporting your data to a palmtop, select the serial port you are using. Click Link Settings 
next to the File Name edit box and select one of the options offered in the Serial Settings dialog box 
that is called up.

7. If you are exporting data to your palmtop and this is the first time you export/import with your palmtop, 
you need to install a link between your Agenda and the palmtop. Open the DataComm application on 
your palmtop, choose File Receive from the File Menu and enter the file name ul.exe. Then choose 
Link Settings in the Export Utility dialog box in your Agenda, and choose Link Install in the Serial 
Settings dialog box that is called up. You will not need to do this again, unless the batteries on your 
palmtop run down, erasing all the data and applications it contains.

8. Choose Export.
· If you are exporting data to a palmtop, and there are inconsistencies between the palmtop and 

your Agenda, you may have to go through a Palmtop Reconciliation process before the 
conclusion of your data export. If so, the Palmtop Reconciliation dialog box will be called up.

See Also:

All about your Agenda's Palmtop Support 
Serial Settings 
The Import Utility 
Initial Set-up Procedure for Exporting to the Palmtop 
Installing the UniLink Server on your HP Palmtop 
Working with vCalendar Objects 
Palmtop Reconciliation 
Palmtop Reconciliation — Confirm Entry Deletion 
Palmtop Reconciliation — Confirm Entry Modification 



Change Password
When you select Change Password from the Edit Menu, this dialog box will appear.

To change your password, enter your old password in the upper edit box. Then enter your new password 
in the lower edit box.

As you type in your password, an asterisk will appear for each character you enter (rather than displaying 
the text.)

Choose OK when you have finished.



Deleting People/Resources from Recurring Entries
If you choose to delete attendees when editing a Recurring Entry, the Delete People/Resources dialog 
box will appear.

Select the people and resources you wish to delete from the Entry, and choose Delete. The users or 
resources will be deleted from all the recurrences that you have selected to edit.

Choose OK. This will return you to the Edit Recurring Entry dialog box.



Adding People/Resources to Recurring Entries
If you choose to add attendees when editing a Recurring Entry, the Add People/Resources dialog box will 
appear.

Using the edit box, enter the names of the people and resources you wish to add to the Entry. They will 
be added to all the recurrences that you have selected to edit.

Choose OK. This will return you to the Edit Recurring Entry dialog box.

See Also:

Adding Names 



Rescheduled Entry
Depending on the Preferences you have set (Edit Menu, Preferences, Agenda, Notification), this dialog 
box will appear when you move an Entry to which you have invited others. It gives you the possibility of 
alerting others to the changes of time and/or date by e-mail.

If you choose Yes, the Mail Message dialog box will appear for you to enter and send your message to 
the invited people and resources (= resource designates).



Where is…
The Where is…? feature (Edit Menu, Locate Person) allows you to find out what people, resources or 
groups have scheduled in their Agendas at a specific time.

1. Type the name of the user you wish to locate in the Add edit box.
· If you want to find a resource, type r:, re:, or res: followed by the resource's name.
· If you want to find a group, type g:, gr:, or grp: followed by the group's name.

2. Choose  to accept the name. Your Agenda will search for this user.

Choose  to reject the name. This will erase the user's name from the edit box. Your Agenda will 
not search for the user.

3. In the Date box, enter the date for which you want to find the user. Use the arrows to the right of the 
box or choose the calendar button.

4. In the Time box, set the time at which you want to find the user. Use the arrows to the right of the box 
or choose the clock button.

5. Your Agenda will search for the user using these search parameters, and display the information it 
finds in the list box.

The answer you will get from your search depends on what Viewing Rights the user has granted you 
to see the Agenda Entry that is scheduled at the time for your search. Users set Viewing Rights for 
Entries of each access level.

If you have the right to see all information about an Agenda Entry, you will get both its title and its 
location. If you only have the right to see the busy times of an Agenda Entry, your search will just 
indicate that the user is busy at that time. Finally, when you don't have any viewing rights for an 
Agenda Entry, you will not even be made aware of its existence. 

If your Agenda does not find any information fitting your search parameters, it will indicate this in the 
list box.



Creating a Day Event — General
A Day Event is an event that lasts for, or is valid for, an entire day, without taking up time in your Day 
View. Day Events will appear in the Notes View at the bottom of your Agenda pages. This icon indicates a 
Day Event: .

You can create a Day Event either by choosing New Day Event from the File Menu (File Menu, New, Day 

Event) or by clicking the  on the toolbar.

Day Events scheduled by others will appear in the New Entries folder of your In-tray, where you can 
decide whether to keep them in your Agenda.

Use the General tab of the dialog box to enter the basic information about your Day Event, and to create 
it. You also use this tab of the dialog box to invite people and resources to your Day Event.

1. Type the Title of the Day Event in the Title edit box.

2. Set the date of the Day Event by either:
· using the arrows to the right of the date box to scroll the date up or down; or,
· choosing the calendar button to the right of the date box.

3. Create the list of people and/or resources you want to invite to the Day Event using the edit box.

· To invite a user, type the name in the Add edit box.
If you want to invite a resource, type r:, re:, or res: followed by the resource's name.
If you want to add a group, type g:, gr:, or grp: followed by the group's name.

· Once the correct name is in the edit box, press Enter on your keyboard to include the name on 
the list of invited people and resources that you are creating. The name will then be added in the 
list box below.

· Choose  to search for people, groups or resources.

· Choose  to select a group for your list.
· To delete a name, select it from the list box and choose Delete.

4. If you have made this a recurring Day Event (using the Repeating tab of this dialog box) the list of 
dates on which this Day Event has been scheduled will appear in the list box. Should you make any 
changes to the information you have entered on the General tab after generating these dates, you 
can choose to make your changes apply either only to one selected date or to all dates.

· To make the changes apply to all dates, enter the changes you wish to make and choose Apply 
to All.

· To make changes only to selected dates, select the date and enter the changes you wish to 
make.

5. Do not choose Create until you are completely finished with creating your Day Event (which could 
demand that you use the other tabs of the dialog box).

NOTE: Each time you create or modify an Entry to which other users have been invited, your Agenda 
may display a message box asking you if you want to send the other users an e-mail message. (This 
depends on your Preferences, which you can set using Edit Menu, Preferences, Agenda, Notification.)

· If you want to send an e-mail message, choose Yes. Your Agenda will then display the Mail Message 
dialog box for you.

· If you do not want to send an e-mail message, choose No. Your Entry will still appear in the In-trays 



and Agendas of the other users.

See Also:

Creating a Day Event — Summary 
Creating a Day Event — Reminders 
Creating a Day Event — Repeating 
Adding Names 
Selecting a Group 



Creating a Day Event — Summary
A Day Event is an event that lasts for, or is valid for, an entire day, without taking up time in your Day 
View. Day Events will appear in the Notes View at the bottom of your Agenda pages. This icon indicates a 
Day Event: .

You can create a Day Event either by choosing New Day Event from the File Menu or by clicking the  
on the toolbar.

Day Events scheduled by others will appear in the New Entries folder of your In-tray, where you can 
decide whether to keep them in your Agenda.

The Summary tab of the dialog box provides a summary of your Day Event. It lists certain information 
about the Entry and lets you enter other information.

1. The following information is listed here:

· Title;
· Who proposed the Entry;
· People invited;
· Creator.

2. Enter the access level for the Day Event. Click the arrow to the right of the edit box to see the 
available options. Select one.

3. Choose OK to finish working on this tab and go back to the General tab, where you can create the 
Day Event.

See Also:

Creating a Day Event — General 
Creating a Day Event — Reminders
Creating a Day Event — Repeating 



Creating a Day Event — Repeating
A Day Event is an event that lasts for, or is valid for, an entire day, without taking up time in your Day 
View. Day Events will appear in the Notes View at the bottom of your Agenda pages. This icon indicates a 
Day Event: .

You can create a Day Event either by choosing New Day Event from the File Menu or by clicking the  
on the toolbar.

Day Events scheduled by others will appear in the New Entries folder of your In-tray, where you can 
decide whether to keep them in your Agenda.

Use this tab of the dialog box to make your Day Event a recurring Entry. This can be useful for scheduling 
any type of event that will take place on a regular basis.

1. Indicate how frequently you would like the Day Event to recur. Start by choosing if you want a daily, 
weekly, monthly or yearly repetition of your recurring Entry. Click the arrow to the right of the edit box 
and select one of the options. If you choose a monthly repetition, you can either have the Day Event 
recur on one (or several) specific date(s) of the month, or you can select one (or several) specific 
day(s) of the month for the recurrence.

Depending on your choice in the frequency edit box, you will have different options to choose from to 
the right of it.

· If you select Daily, you can choose whether you want the Entry to recur every day or at some 
other frequency. Select the appropriate button and type in the frequency if you choose the latter 
alternative (such as every 2 or 3 days).

· If you select Weekly, you can choose whether you want the Entry to recur every week or at some 
other frequency. Select the appropriate button and type in the frequency if you choose the latter 
alternative (such as every 2 or 3 weeks). You also have to choose on which week day(s) you 
want the Entry to be repeated. Click the day(s) you want to schedule the Entry for. If you change 
your mind about a day that you've chosen, click its button again to unselect it.

· If you select Monthly on Date(s), you can choose whether you want the Entry to be repeated on 
a specific date every month or at some other frequency.
If you want one date every month, select the upper button and type in the date. 
If you want a different frequency, click the lower button, select the date in the list box and type in 
the frequency (such as every 2 or 3 months). You can also select more than one date in the list 
box by pressing the Ctrl key when clicking them. If you want the Entry to recur several dates 
every month, select the dates and type 1 in the edit box

· If you select Monthly on Day(s), select the day(s) in the list box (for example On the 3rd Monday 
of every month). If you want to select more than one day in the list box, press the Ctrl key when 
clicking them. Then type the frequency of the repetition in the small right-hand edit box (for 
example, every 3 months).

· If you select Yearly, you can choose whether you want the Entry to recur every year or at some 
other frequency. Select the appropriate button and type in the frequency if you choose the latter 
alternative (such as every 2 or 3 years).

2. Enter the Start date using the arrows or by choosing the calendar button. 

3. Set the End date by selecting either the Until or the For button.

· If you choose the Until button, set the date using the arrows or by choosing the calendar button.
· If you choose the For button, set the duration by selecting one of the options from the right-hand 

edit box (days, weeks, months, years). Then type the interval in the small left-hand edit box.

4. Indicate whether or not you want your Agenda to include Saturdays, Sundays and Holidays when 



scheduling the recurring Day Event.

5. Choose List Dates to create a list of the dates on which your Day Event will be scheduled. The list 
will appear in the list box below. If you change your settings and choose List Dates again, your 
Agenda will replace the first list of dates you created.

6. If you wish to create additional dates not included in the repetition you have specified, you can do so 
using the Additional date edit box. 

Set the date using the arrows to the right of the edit box or choose the calendar button.

Once the date is set, choose the  to accept it.

7. You can delete dates from the list in two ways:
· Select an individual date and choose Delete to remove certain dates only.
· Choose Clear All to cancel the entire list of dates.

8. Choose OK to finish working on this tab and go back to the General tab, where you can create the 
Day Event.

See Also:

Creating a Day Event — General 
Creating a Day Event — Summary 
Creating a Day Event — Reminders



Creating a Day Event — Reminders
A Day Event is an event that lasts for, or is valid for, an entire day, without taking up time in your Day 
View. Day Events will appear in the Notes View at the bottom of your Agenda pages. This icon indicates a 

Day Event: .

You can create a Day Event either by choosing New Day Event from the File Menu or by clicking the  
on the toolbar.

Day Events scheduled by others will appear in the New Entries folder of your In-tray, where you can 
decide whether to keep them in your Agenda.

Use the Reminders tab of the dialog box to set Reminders for your Day Event.

1. Select the Set Reminder button to turn on the Reminders function. Select the No Reminder button to 
turn it off. 
Once you select the Set Reminder button, you can set the Reminders options.

2. Set how you wish to be reminded. You can either be reminded by a Pop-up window or you can have 
the Entry appear as an Upcoming Note in the Notes View of your Agenda (at the bottom of the Daily 
and Weekly Agenda pages). 
Click the arrow next to the display box and select one of the two options.

3. Set when you want to be reminded. You can choose to be reminded minutes, hours, days, weeks, 
months or years in advance. To view your options and select one, click the arrow to the right of the 
box. Then type the appropriate number in the left-hand box.

4. If you are creating a recurring Day Event, a list box will display all the dates on which your Entry has 
been scheduled. The Reminders you have set will apply only to the selected dates.

· To apply the Reminders to all recurrences of the Entry, choose Apply to All.
· To select several consecutive dates in the list box, hold down the Shift key and click the first and 

the last of the dates. Once all the appropriate dates are selected, set your Reminders.
· To select several non-consecutive dates in the list box, hold down the Ctrl key when you click 

them. Once all the appropriate dates are selected, set your Reminders.

5. Choose OK to finish working on this tab and go back to the General tab, where you can create the 
Day Event.

See Also:

Creating a Day Event — General 
Creating a Day Event — Summary 
Creating a Day Event — Repeating 



Creating a Daily Note — General
A Daily Note is a note that will appear in the Notes View at the bottom of your Agenda pages. This icon 
indicates a Daily Note: .

You can create a Daily Note by choosing New Daily Note from the File Menu, by double-clicking in the 

Notes View below any other Entries already displayed there, or by choosing  on the toolbar. You can 
also send copies of your Daily Notes to other users.

Daily Notes sent to you by others will appear in the New Entries folder of your In-tray, where you can 
decide whether to keep them in your Agenda.

Use the General tab of the dialog box to write and create your Daily Note. You also use this tab of the 
dialog box to send a copy of your Note to other people and resources.

1. Type the Title of the Daily Note in the Title edit box. This will be the text of your Note as it will appear 
in your Agenda. It can be up to 64 characters long.

2. Set the date of the Daily Note by either:
· using the arrows to the right of the date box to scroll the date up or down; or,
· choosing the calendar button to the right of the date box.

3. Create the list of people and/or resources to whom you want to send the Daily Note using the edit 
box.

· To add a user to the list, type the name in the Add edit box.
If you want to add a resource, type r:, re:, or res: followed by the resource's name.
If you want to add a group, type g:, gr:, or grp: followed by the group's name.

· Once the correct name is in the edit box, press Enter on your keyboard to include the name on 
the list of receiving people and resources that you are creating. The name will then be added in 
the list box below.

· Choose  to search for people, groups or resources.

· Choose  to select a group for your list.
· To delete a name, select it from the list box and choose Delete.

4. If you have made this a recurring Daily Note (using the Repeating tab of this dialog box) the list of 
dates on which this Daily Note has been scheduled will appear in the list box. Should you make any 
changes to the information you have entered on the General tab after generating these dates, you 
can choose to make your changes apply either only to one selected date or all dates.

· To make the changes apply to all dates, choose Apply to All.
· To make changes only to selected dates, select the date and enter the changes you wish to 

make.

5. Do not choose Create until you are completely finished with creating your Daily Note (which could 
demand that you use the other tabs of the dialog box).

NOTE: Each time you create or modify an Entry to which other users have been invited, your Agenda 
may display a message box asking you if you want to send the other users an e-mail message. (This 
depends on your Preferences, which you can set using Edit Menu, Preferences, Agenda, Notification.)

· If you want to send an e-mail message, choose Yes. Your Agenda will then display the Mail Message 
dialog box for you.



· If you do not want to send an e-mail message, choose No. Your Entry will still appear in the In-trays 
and Agendas of the other users.

See Also:

Creating a Daily Note — Summary 
Creating a Daily Note — Reminders 
Creating a Daily Note — Repeating 
Adding Names 
Selecting a Group 



Creating a Daily Note — Summary
A Daily Note is a note that will appear in the Notes View at the bottom of your Agenda pages. This icon 
indicates a Daily Note: .

You can create a Daily Note by choosing New Daily Note from the File Menu, by double-clicking in the 

Notes View below any other Entries already displayed there, or by choosing  on the toolbar. You can 
also send copies of your Daily Notes to other users.

Daily Notes sent to you by others will appear in the New Entries folder of your In-tray, where you can 
decide whether to keep them in your Agenda.

The Summary tab of the dialog box provides a summary of your Daily Note. It lists certain information 
about the Entry and lets you enter other information.

1. The following information is listed here:

· Title;
· Who proposed the Entry;
· People invited;
· Creator.

2. Enter the access level for the Daily Note. Click the arrow to the right of the edit box to see the 
available options. Select one.

3. Choose OK to finish working on this tab and go back to the General tab, where you can create the 
Daily Note.

See Also:

Creating a Daily Note — General 
Creating a Daily Note — Reminders 
Creating a Daily Note — Repeating 



Creating a Daily Note — Repeating
A Daily Note is a note that will appear in the Notes View at the bottom of your Agenda pages. This icon 
indicates a Daily Note: .

You can create a Daily Note by choosing New Daily Note from the File Menu, by double-clicking in the 

Notes View below any other Entries already displayed there, or by choosing  on the toolbar. You can 
also send copies of your Daily Notes to other users.

Daily Notes sent to you by others will appear in the New Entries folder of your In-tray, where you can 
decide whether to keep them in your Agenda.

Use this tab of the dialog box to make your Daily Note a recurring Entry.

1. Indicate how frequently you would like the Daily Note to recur. Start by choosing if you want a daily, 
weekly, monthly or yearly repetition of your recurring Entry. Click the arrow to the right of the edit box 
and select one of the options. If you choose a monthly repetition, you can either have the Daily Note 
recur on one (or several) specific date(s) of the month, or you can select one (or several) specific 
day(s) of the month for the recurrence.

Depending on your choice in the frequency edit box, you will have different options to choose from to 
the right of it.

· If you select Daily, you can choose whether you want the Entry to recur every day or at some 
other frequency. Select the appropriate button and type in the frequency if you choose the latter 
alternative (such as every 2 or 3 days).

· If you select Weekly, you can choose whether you want the Entry to recur every week or at some 
other frequency. Select the appropriate button and type in the frequency if you choose the latter 
alternative (such as every 2 or 3 weeks). You also have to choose on which week day(s) you 
want the Entry to be repeated. Click the day(s) you want to schedule the Entry for. If you change 
your mind about a day that you've chosen, click its button again to unselect it.

· If you select Monthly on Date(s), you can choose whether you want the Entry to be repeated on 
a specific date every month or at some other frequency.
If you want one date every month, select the upper button and type in the date. 
If you want a different frequency, click the lower button, select the date in the list box and type in 
the frequency (such as every 2 or 3 months). You can also select more than one date in the list 
box by pressing the Ctrl key when clicking them. If you want the Entry to recur several dates 
every month, select the dates and type 1 in the edit box

· If you select Monthly on Day(s), select the day(s) in the list box (for example On the 3rd Monday 
of every month). If you want to select more than one day in the list box, press the Ctrl key when 
clicking them. Then type the frequency of the repetition in the small right-hand edit box (for 
example, every 3 months).

· If you select Yearly, you can choose whether you want the Entry to recur every year or at some 
other frequency. Select the appropriate button and type in the frequency if you choose the latter 
alternative (such as every 2 or 3 years).

2. Enter the Start date using the arrows or by choosing the calendar button. 

3. Set the End date by selecting either the Until or the For button.

· If you choose the Until button, set the date using the arrows or by choosing the calendar button.
· If you choose the For button, set the duration by selecting one of the options from the right-hand 

edit box (days, weeks, months, years). Then type the interval in the small left-hand edit box.

4. Indicate whether or not you want your Agenda to include Saturdays, Sundays and Holidays when 



scheduling the recurring Daily Note.

5. Choose List Dates to create a list of the dates on which your Daily Note will appear. The list will be 
displayed in the list box below. If you change your settings and choose List Dates again, your 
Agenda will replace the first list of dates you created.

6. If you wish to create additional dates not included in the repetition you have specified, you can do so 
using the Additional date edit box. 

Set the date using the arrows to the right of the edit box or choose the calendar button.

Once the date is set, choose the  to accept it.

7. You can delete dates from the list in two ways:
· Select an individual date and choose Delete to remove certain dates only.
· Choose Clear All to cancel the entire list of dates.

8. Choose OK to finish working on this tab and go back to the General tab, where you can create the 
Daily Note

See Also:

Creating a Daily Note — General 
Creating a Daily Note — Summary 
Creating a Daily Note — Reminders 



Creating a Daily Note — Reminders
A Daily Note is a note that will appear in the Notes View at the bottom of your Agenda pages. This icon 
indicates a Daily Note: .

You can create a Daily Note by choosing New Daily Note from the File Menu, by double-clicking in the 

Notes View below any other Entries already displayed there, or by choosing  on the toolbar. You can 
also send copies of your Daily Notes to other users.

Daily Notes sent to you by others will appear in the New Entries folder of your In-tray, where you can 
decide whether to keep them in your Agenda.

Use the Reminders tab of the dialog box to set Reminders for your Daily Note.

1. Select the Set Reminder button to turn on the Reminders function. Select the No Reminder button to 
turn it off. 
Once you select the Set Reminder button, you can set the Reminders options.

2. Set how you wish to be reminded. You can either be reminded by a Pop-up window or you can have 
the Daily Note appear as an Upcoming Note in the Notes View of your Agenda (at the bottom of the 
Daily and Weekly Agenda pages). 
Click the arrow next to the display box and select one of the two options.

3. Set when you want to be reminded. You can choose to be reminded minutes, hours, days, weeks, 
months or years in advance. To view your options and select one, click the arrow to the right of the 
box. Then type the appropriate number in the left-hand box.

4. If you are creating a recurring Daily Note, a list box will display all the dates on which your Entry has 
been scheduled. The Reminders you have set will apply only to the selected dates. 

· To apply the Reminders to all recurrences of the Entry, choose Apply to All.
· To select several consecutive dates in the list box, hold down the Shift key and click the first and 

the last of the dates. Once all the appropriate dates are selected, set your Reminders.
· To select several non-consecutive dates in the list box, hold down the Ctrl key when you click 

them. Once all the appropriate dates are selected, set your Reminders.

5. Choose OK to finish working on this tab and go back to the General tab, where you can create the 
Daily Note.

See Also:

Creating a Daily Note — General 
Creating a Daily Note — Summary 
Creating a Daily Note — Repeating 



Editing a Recurring Entry — Day Events
When you double-click a recurring Entry that you've proposed (or in some other way indicate that you 
want to edit it), you will be asked whether you want to edit only that specific recurrence or if you want to 
edit several recurrences of the Entry. If you choose to edit several recurrences, you will come to the Edit 
Recurring Entry dialog box, where you can edit as many recurrences you like.

1. Select which recurrences of the Day Event you want to edit from the list box.

· If you want to edit all recurrences of the Entry, choose All.
· To select all dates prior to the one you have highlighted, choose All Previous.
· To select all dates following the one you have highlighted, choose All Next.
· To select several consecutive dates, hold down the Shift key and click the first and the last of the 

dates that you want to edit.
· To select several non-consecutive dates, hold down the Ctrl key when you click them.
· To unselect all recurrences, choose Clear.

2. From the box on the right, you can choose between a number of actions.

· To change the title of the Day Event for the selected dates, choose Title. This will call up the New 
Title dialog box.

· To add people and resources to the Day Event's list of attendees for the selected dates, choose 
Add Attendees. This will call up the Add People/Resources dialog box.

· To remove people and resources from the Day Event's list of attendees for the selected dates, 
choose Delete Attendees. This will call up the Delete People/Resources dialog box.

· To change the Day Event's Reminder settings for the selected dates, choose Reminders. This 
will call up the Reminder dialog box.

· To delete the selected dates, choose Delete Recurrences. The recurrences will be removed from 
your Agenda (and the Agendas of any attendees) when you choose OK.

· To view a specific recurrence, select that date from the list and choose View original. This will 
call up the View Entry dialog box.

· To change the date of a specific recurrence, select it from the list and choose Date/Time. This will 
call up the Move Entry dialog box. You can only change the date of one recurrence at a time.

3. Choose OK only when you've done all the changes you want to do.

NOTE: Each time you create or modify an Entry to which other users have been invited, your Agenda 
may display a message box asking you if you want to send the other users an e-mail message. (This 
depends on your Preferences, which you can set using Edit Menu, Preferences, Agenda, Notification.)

· If you want to send an e-mail message, choose Yes. Your Agenda will then display the Mail Message 
dialog box for you.

· If you do not want to send an e-mail message, choose No. Your Entry will still appear in the In-trays 
and Agendas of the other users.

See Also:

New     Title   
Adding People/Resources to Recurring Entries 
Deleting People/Resources from Recurring Entries 
Editing Reminders for a Recurring Entry 



Editing a Recurring Entry — Daily Notes
When you double-click a recurring Entry that you've proposed (or in some other way indicate that you 
want to edit it), you will be asked whether you want to edit only that specific recurrence or if you want to 
edit several recurrences of the Entry. If you choose to edit several recurrences, you will come to the Edit 
Recurring Entry dialog box, where you can edit as many recurrences you like.

1. Select which recurrences of the Daily Note you want to edit from the list box.

· If you want to edit all recurrences of the Entry, choose All.
· To select all dates prior to the one you have highlighted, choose All Previous.
· To select all dates following the one you have highlighted, choose All Next.
· To select several consecutive dates, hold down the Shift key and click the first and the last of the 

dates that you want to edit.
· To select several non-consecutive dates, hold down the Ctrl key when you click them.
· To unselect all recurrences, choose Clear.

2. From the box on the right, you can choose between a number of actions.

· To change the title of the Note for the selected dates, choose Title. This will call up the New Title 
dialog box.

· To add people and resources from the Note's list of attendees for the selected dates, choose Add 
Attendees. This will call up the Add People/Resources dialog box.

· To remove people and resources from the Note's list of attendees for the selected dates, choose 
Delete Attendees. This will call up the Delete People/Resources dialog box.

· To change the Note's Reminder settings for the selected dates, choose Reminders. This will call 
up the Reminder dialog box.

· To delete the selected dates, choose Delete Recurrences. The recurrences will be removed from 
your Agenda (and the Agendas of any attendees) when you choose OK.

· To view a specific recurrence, select that date from the list and choose View original. This will 
call up the View Entry dialog box.

· To change the date of a specific recurrence, select it from the list and choose Date/Time. This will 
call up the Move Entry dialog box. You can only change the date of one recurrence at a time.

3. Choose OK only when you've done all the changes you want to do.

NOTE: Each time you create or modify an Entry to which other users have been invited, your Agenda 
may display a message box asking you if you want to send the other users an e-mail message. (This 
depends on your Preferences, which you can set using Edit Menu, Preferences, Agenda, Notification.)

· If you want to send an e-mail message, choose Yes. Your Agenda will then display the Mail Message 
dialog box for you.

· If you do not want to send an e-mail message, choose No. Your Entry will still appear in the In-trays 
and Agendas of the other users.

See Also:

New     Title   
Adding People/Resources to Recurring Entries 
Deleting People/Resources from Recurring Entries 
Editing Reminders for a Recurring Entry 



Editing a Daily Note — General
The Edit Entry dialog box lets you make changes to a Daily Note you have written. You can call up this 
dialog box either by double-clicking the Note in your In-tray or on your Agenda page, or by selecting it on 
the Agenda page and choosing Open Entry from the Edit Menu.

This dialog box will only appear if you proposed the Entry you have selected. If you didn't propose the 
Daily Note, the View Entry dialog box will appear instead. (You cannot edit information about Entries you 
haven't proposed.)

When you edit a Daily Note that you have sent to others, the changes you make will automatically appear 
in their Agendas as well. If you change the date of the Daily Note, it will appear as a new Daily Note in 
their In-tray.

The General tab of the dialog box lets you change the basic content of your Note.

1. Make changes to the Title of the Daily Note in the Title box.

2. Change the date by either:
· using the arrows to the right of the date box to scroll the date up or down; or,
· choosing the calendar button to the right of the date box.

3. Use the People/Resources part of the tab to change the list of people and resources who will receive 
your Note.

· To add a user to the list, type the name in the Add edit box.
If you want to add a resource, type r:, re:, or res: followed by the resource's name.
If you want to add a group, type g:, gr:, or grp: followed by the group's name.

· Once the correct name is in the edit box, press Enter on your keyboard to add the name in the list 
of receiving people and resources below.

· Choose  to search for people, groups or resources.

· Choose  to select a group for your list.
· To delete a name, select it from the list box and choose Delete.

Next to each person or resource, one of these icons will be displayed:

people or resources (the resource designates) who have decided to keep the Day Event in their 
Agenda;

people or resources who have decided to remove the Day Event from their Agenda;

people or resources who haven't responded to the Daily Note yet.

Choose OK only once you've finished with all the tabs of the dialog box.

NOTE: Each time you create or modify an Entry to which other users have been invited, your Agenda 
may display a message box asking you if you want to send the other users an e-mail message. (This 
depends on your Preferences, which you can set using Edit Menu, Preferences, Agenda, Notification.)

· If you want to send an e-mail message, choose Yes. Your Agenda will then display the Mail Message 
dialog box for you.

· If you do not want to send an e-mail message, choose No. Your Entry will still appear in the In-trays 
and Agendas of the other users.



See Also:

Editing a Daily Note — Agenda Status 
Editing a Daily Note — Summary 
Editing a Daily Note — Reminders 
Adding Names 
Selecting a Group 



Editing a Daily Note — Summary
The Edit Entry dialog box lets you make changes to a Daily Note you have written. You can call up this 
dialog box either by double-clicking the Note in your In-tray or on your Agenda page, or by selecting it on 
the Agenda page and choosing Open Entry from the Edit Menu.

This dialog box will only appear if you proposed the Entry you have selected. If you didn't propose the 
Daily Note, the View Entry dialog box will appear instead. (You cannot edit information about Entries you 
haven't proposed.)

When you edit a Daily Note that you have sent to others, the changes you make will automatically appear 
in their Agendas as well. If you change the date of the Daily Note, it will appear as a new Daily Note in 
their In-tray.

The Summary tab of the dialog box provides a summary of your Daily Note. It lists certain information 
about the Entry and lets you change other information.

1. The following information is listed on this tab, but cannot be changed here:

· Title;
· Who proposed the Entry;
· People invited;
· Creator.

2. You can adjust the access level by clicking the arrow to the right of the Access box and selecting one 
of the options.

Choose OK only once you've finished with all the tabs of the dialog box.

NOTE: Each time you create or modify an Entry to which other users have been invited, your Agenda 
may display a message box asking you if you want to send the other users an e-mail message. (This 
depends on your Preferences, which you can set using Edit Menu, Preferences, Agenda, Notification.)

· If you want to send an e-mail message, choose Yes. Your Agenda will then display the Mail Message 
dialog box for you.

· If you do not want to send an e-mail message, choose No. Your Entry will still appear in the In-trays 
and Agendas of the other users.

See Also:

Editing a Daily Note — Agenda Status 
Editing a Daily Note — General 
Editing a Daily Note — Reminders 



Editing a Daily Note — Reminders
The Edit Entry dialog box lets you make changes to a Daily Note you have written. You can call up this 
dialog box either by double-clicking the Note in your In-tray or on your Agenda page, or by selecting it on 
the Agenda page and choosing Open Entry from the Edit Menu.

This dialog box will only appear if you proposed the Entry you have selected. If you didn't propose the 
Daily Note, the View Entry dialog box will appear instead. (You cannot edit information about Entries you 
haven't proposed.)

When you edit a Daily Note that you have sent to others, the changes you make will automatically appear 
in their Agendas as well. If you change the date of the Daily Note, it will appear as a new Daily Note in 
their In-tray.

This tab of the dialog box lets you change the Reminders you have set for your Daily Note.

1. Select the Reminder ON button to turn on the Reminders function. Select the No Reminder (OFF) 
button to turn it off. 
Once you select the Reminder ON button, you can set the Reminders options.

2. Set how you wish to be reminded. You can either be reminded by a Pop-up window or you can have 
the Note appear as an Upcoming Note in the Notes View of your Agenda (at the bottom of the Daily 
and Weekly Agenda pages). 
Click the arrow next to the display box and select one of the two options.

3. Set when you want to be reminded. You can choose to be reminded minutes, hours, days, weeks, 
months or years in advance. To view your options and select one, click the arrow to the right of the 
box. Then type the appropriate number in the left-hand box.

Choose OK only once you've finished with all the tabs of the dialog box.

NOTE: Each time you create or modify an Entry to which other users have been invited, your Agenda 
may display a message box asking you if you want to send the other users an e-mail message. (This 
depends on your Preferences, which you can set using Edit Menu, Preferences, Agenda, Notification.)

· If you want to send an e-mail message, choose Yes. Your Agenda will then display the Mail Message 
dialog box for you.

· If you do not want to send an e-mail message, choose No. Your Entry will still appear in the In-trays 
and Agendas of the other users.

See Also:

Using the Reminders 
Editing a Daily Note — Agenda Status 
Editing a Daily Note — General 
Editing a Daily Note — Summary 



Editing a Daily Note — Agenda Status
The Edit Entry dialog box lets you make changes to a Daily Note you have written. You can call up this 
dialog box either by double-clicking the Note in your In-tray or on your Agenda page, or by selecting it on 
the Agenda page and choosing Open Entry from the Edit Menu.

This dialog box will only appear if you proposed the Entry you have selected. If you didn't propose the 
Daily Note, the View Entry dialog box will appear instead. (You cannot edit information about Entries you 
haven't proposed.)

When you edit a Daily Note that you have sent to others, the changes you make will automatically appear 
in their Agendas as well. If you change the date of the Daily Note, it will appear as a new Daily Note in 
their In-tray.

The Agenda tab lets you choose whether or not to keep the Daily Note in your Agenda. A summary of the 
Entry is displayed on this tab, so you don't have to go to the other tabs to get the information.

The summary lists the following information about the Daily Note:

· Who proposed the Entry;

· Title;

· Date;

· Access level;

· People invited.

To change the status of the Note, select one of the three options offered:

· Keep in Agenda.

· Remove from Agenda.

· Decide later.

Choose OK only once you've finished with all the tabs of the dialog box.

NOTE: Each time you create or modify an Entry to which other users have been invited, your Agenda 
may display a message box asking you if you want to send the other users an e-mail message. (This 
depends on your Preferences, which you can set using Edit Menu, Preferences, Agenda, Notification.)

· If you want to send an e-mail message, choose Yes. Your Agenda will then display the Mail Message 
dialog box for you.

· If you do not want to send an e-mail message, choose No. Your Entry will still appear in the In-trays 
and Agendas of the other users.

See Also:

Editing a Daily Note — General 
Editing a Daily Note — Summary 
Editing a Daily Note — Reminders 



Daily Notes
You can create Daily Notes in your Agenda. Notes are things you want to enter into your Agenda, but that 
don't fall under Tasks, Day Events, or Agenda Entries. These Daily Notes will appear in the Notes View of 
your Daily and Weekly Agenda pages. This icon indocates a Daily Note: .

For more details about Tasks, click one of the following topic headings:

The Notes View 

Creating Notes
General 
Summary
Repeating 
Reminders 

Viewing Notes
General 
Reminders 
Agenda Status 

Editing Notes
General 
Summary 
Reminders 
Agenda Status
Recurring Entries 
Moving an Entry 
Rescheduled Entry 

Preferences
Entry Defaults — Daily Notes 



Viewing a Daily Note — General
The View Entry dialog box displays information about the Daily Note you have selected. You can call up 
this dialog box either by double-clicking the Entry in your In-tray (if you have set your Preferences for this 
option) , double-clicking the Entry on your Agenda page, or selecting it on the Agenda page and choosing 
Open Entry from the Edit Menu.

This dialog box will only appear if you didn't propose the Entry you have selected. If you did propose the 
Entry, the Edit Entry dialog box will appear instead. (You cannot edit information about Entries you haven't 
proposed.)

The General tab of the dialog box lists the following information about the Daily Note you have selected:

· Who proposed the Entry;

· Creator;

· Title;

· Date.

· Access level

This tab of the dialog box also shows you a list of the people and resources who have received a copy of 
the Daily Note you are viewing. Next to each person or resource in the list, one of these icons will be 
displayed:

people or resources (the resource designates) who have decided to keep the Daily Note in their 
Agenda;

people or resources who have decided to remove the Daily Note from their Agenda;

people or resources who haven't responded to the Daily Note yet.

The list cannot be edited in this dialog box.

(To edit the list of people and resources for a Daily Note you proposed, go to the General tab of the Edit 
Entry dialog box for that Note.)

If the Entry is a recurring one, a list box at the bottom of the dialog box will show the recurrences of the 
Entry, and indicate your reply to them using these icons:

for Entries you have accepted;

for Entries you have refused;

for Entries you have not responded to yet.

Choose OK only once you've finished with all the tabs of the dialog box.

See Also:

Viewing a Daily Note — Agenda Status 
Viewing a Daily Note — Reminders 
Entry Defaults — Daily Notes 



Viewing a Daily Note — Agenda Status
The View Entry dialog box displays information about the Daily Note you have selected. You can call up 
this dialog box either by double-clicking the Entry in your In-tray (if you have set your Preferences for this 
option) , double-clicking the Entry on your Agenda page, or selecting it on the Agenda page and choosing 
Open Entry from the Edit Menu.

This dialog box will only appear if you didn't propose the Entry you have selected. If you did propose the 
Entry, the Edit Entry dialog box will appear instead. (You cannot edit information about Entries you haven't 
proposed.)

When the View Entry dialog box is called up for a Daily Note, the Agenda tab will always be displayed, in 
order for you to quickly choose whether or not to keep it in your Agenda. A summary of the Entry is 
displayed on this tab, so you don't have to go to the other tabs to get the information you need to respond 
to the Note.

The summary lists the following information about the Daily Note:

· Who proposed the Entry;

· Title;

· Date;

· Access level;

· People invited.

To respond to the Note:

1. Select one of the three options:

· Keep in Agenda.
· Remove from Agenda.
· Decide later.

2. If the Entry you are viewing is a recurring one, a list box will display all the dates on which the Entry 
has been scheduled. If you change your reply, the new reply will apply only to the selected dates.

· To change the reply to all recurrences of the Entry, choose Apply to All.
· To select several consecutive dates in the list box, hold down the Shift key and click the first and 

the last of the dates. Once all the appropriate dates are selected, change your reply.
· To select several non-consecutive dates in the list box, hold down the Ctrl key when you click 

them. Once all the appropriate dates are selected, change your reply.

In the list box with all the dates of a recurring Entry, these icons will indicate your reply to them:

for Entries you have accepted;

for Entries you have refused;

for Entries you have not responded to yet.

Choose OK only once you've finished with all the tabs of the dialog box.

See Also:

Viewing a Daily Note — General 



Viewing a Daily Note — Reminders 



Viewing a Daily Note — Reminders
The View Entry dialog box displays information about the Daily Note you have selected. You can call up 
this dialog box either by double-clicking the Entry in your In-tray (if you have set your Preferences for this 
option) , double-clicking the Entry on your Agenda page, or selecting it on the Agenda page and choosing 
Open Entry from the Edit Menu.

This dialog box will only appear if you didn't propose the Entry you have selected. If you did propose the 
Entry, the Edit Entry dialog box will appear instead. (You cannot edit information about Entries you haven't 
proposed.)

The Reminder tab of the dialog box shows you the Reminders you have set for the Daily Note.

You can change your Reminders in this dialog box.

1. Select the Reminder ON button to turn on the Reminders function. Select the No Reminder (OFF) 
button to turn it off. 
Once you select the Reminder ON button, you can set the Reminders options.

2. Set how you wish to be reminded. You can either be reminded by a Pop-up window or you can have 
the Note appear as an Upcoming Note in the Notes View of your Agenda (at the bottom of the Daily 
and Weekly Agenda pages). 
Click the arrow next to the display box and select one of the two options.

3. Set when you want to be reminded. You can choose to be reminded minutes, hours, days, weeks, 
months or years in advance. To view your options and select one, click the arrow to the right of the 
box. Then type the appropriate number in the left-hand box.

4. If the Entry you are viewing is a recurring one, a list box will display all the dates on which the Entry 
has been scheduled. The Reminders you have set will apply only to the selected dates.

· To apply the Reminders to all recurrences of the Entry, choose Apply to All.
· To select several consecutive dates in the list box, hold down the Shift key and click the first and 

the last of the dates. Once all the appropriate dates are selected, set your Reminders.
· To select several non-consecutive dates in the list box, hold down the Ctrl key when you click 

them. Once all the appropriate dates are selected, set your Reminders.

In the list box with all the dates of a recurring Entry, these icons will indicate your reply to them:

for Entries you have accepted;

for Entries you have refused;

for Entries you have not responded to yet.

Choose OK only once you've finished with all the tabs of the dialog box.

See Also:

Viewing a Daily Note — Agenda Status 
Viewing a Daily Note — General 



Editing a Recurring Daily Note
When you choose to edit a recurring Daily Note, your Agenda will ask you whether you want to edit only 
the selected recurrence of the Note, or several recurrences.

· If you choose "Edit this recurrence only", your Agenda will call up the Edit Entry dialog box for the 
selected recurrence.

· If you choose "Edit several recurrences", your Agenda will call up the Edit Recurring Entry dialog box.

Select one of the options, then choose OK.



Editing a Recurring Day Event
When you choose to edit a recurring Day Event, your Agenda will ask you whether you want to edit only 
the selected recurrence of the Day Event, or several recurrences.

· If you choose "Edit this recurrence only", your Agenda will call up the Edit Entry dialog box for the 
selected recurrence.

· If you choose "Edit several recurrences", your Agenda will call up the Edit Recurring Entry dialog box.

Select one of the options, then choose OK.



The Import Utility
The Import Utility allows you to import data into your Agenda from certain files and supported palmtops. 

1. Choose whether you want to import from a file or from a palmtop by selecting the appropriate button 
(File or Palmtop). 

2. Select from what type of file or palmtop you will be importing your data. Click the arrow to the right of 
the edit box and select one of the options. 

File formats:
· HP-100LX/200LX Appointment Book Files
· Schedule+ files
· vCalendar files.

Palmtop formats:
· Hewlett-Packard HP-100LX 
· Hewlett-Packard HP-200LX

3. Enter the name of the file from which you will be importing data in the File Name edit box. Clicking on 
the arrow to the right of the edit box will show you (and let you select from) a list of the last files you 
have imported from. If you are not importing from a palmtop, you can look for the file on your system 
by clicking Browse.

4. If you are importing data from a palmtop, select the serial port you are using. Click Link Settings next 
to the File Name edit box and select one of the options offered in the Serial Settings dialog box that is 
called up.

5. Choose the period for which you wish to import data. You have three options:

· Set the range of dates that you want to import Entries for. Select Range and enter the Start and 
End dates using the arrows to the right of the edit boxes below or by choosing the calendar 
button.

· Import all the data contained in the file you're importing from by selecting All.
· Customize the time period that you want to import Entries for. Select Custom and set the time 

period with the edit boxes below. Select from the alternatives that are displayed when you click on 
the arrows next to the two right-hand edit boxes. Then type in the appropriate numbers in the 
small left-hand edit boxes. Your customized time period will be saved until the next time you 
import data.

6. If you are importing data from your palmtop and this is the first time you export/import with your 
palmtop, you need to install a link between your Agenda and the palmtop. Open the DataComm 
application on your palmtop, choose File Receive from the File Menu and enter the file name ul.exe. 
Then choose Link Settings in the Import Utility dialog box in your Agenda, and choose Link Install in 
the Serial Settings dialog box that is called up. You will not need to do this again, unless the batteries 
on your palmtop run down, erasing all the data and applications it contains.

7. Choose Import.
· If you are importing a vCalendar file, a dialog box will appear, letting you handle the Entries being 

imported either individually or collectively.
· When importing from a palmtop, the Palmtop Reconciliation dialog box will open to let you deal 

with inconsistencies between the palmtop and your Agenda.

See Also:



The Export Utility 
Serial Settings 
vCalendar Entries Found... 
Palmtop Reconciliation 
Palmtop Reconciliation — Confirm Entry Deletion 
Palmtop Reconciliation — Confirm Entry Modification 



Editing an Agenda Entry — Reply
Use the Edit Entry dialog box to make changes to an Agenda Entry you've proposed. This dialog box is 
called up when you select the Agenda Entry on the Agenda page and choose Open Entry from the Edit 
Menu (or double-click the Entry).

If other users have been invited to the Agenda Entry, the changes you make will automatically appear in 
their Agendas as well. If you change the time or date of the Agenda Entry, it will appear as a new Entry in 
their In-tray.

This tab of the dialog box lets you change your reply to the Entry. A summary of the Agenda Entry is 
displayed here. It lists the following information about the Entry:

· Who proposed the Entry;

· Creator;

· Title;

· Location;

· Time;

· Importance level;

· Access level;

· People invited.

To change your reply to the Entry, select the appropriate message from the list:

· I will attend

· I will not attend

· I will confirm later

· The message "I would prefer another time" can accompany any of the options.

To send an e-mail message about your reply, click . This will call up the Mail Message dialog box.

Choose OK only when you have made all your changes (on all the tabs of the dialog box).

NOTE: Each time you create or modify an Entry to which other users have been invited, your Agenda 
may display a message box asking you if you want to send the other users an e-mail message. (This 
depends on your Preferences, which you can set using Edit Menu, Preferences, Agenda, Notification.)

· If you want to send an e-mail message, choose Yes. Your Agenda will then display the Mail Message 
dialog box for you.

· If you do not want to send an e-mail message, choose No. Your Entry will still appear in the In-trays 
and Agendas of the other users.

See Also:

Mail Message
Editing an Agenda Entry — General 
Editing an Agenda Entry — Summary 
Editing an Agenda Entry — Details 
Editing an Agenda Entry — Reminders 
Editing an Agenda Entry — Linked Tasks 



Verifying the Change in Password
When you change your password, your Agenda will ask you to verify the change, to make sure your new 
password is properly entered.

1. Re-enter your password. 

2. Choose OK.



Importing & Exporting
You can transfer data between your Agenda and a Hewlett Packard palmtop computer or a data file, 
including various ASCII file formats, Schedule+ files and vCalendar objects. 

For more details about these features, see the following topics:

General
All about your Agenda's Palmtop Support 
The Import Utility 
The Export Utility 
Serial Settings 
Initial Set-up Procedure for Exporting to the Palmtop 
Installing the UniLink Server on your HP Palmtop 

vCalendar objects
Working with vCalendar Objects 
vCalendar Entries Found... 
vCalendar Object Details 

Palmtop Reconciliation
Palmtop Reconciliation 
Preferences 
Confirm Entry Deletion 
Confirm Entry Modification 
Conflicts Detected 



All about your Agenda's Palmtop Support
When you export from your Agenda to your HP palmtop, a calendar file is written on the palmtop. 
Changes made to the palmtop calendar can then be added to your Agenda by importing the data from the 
palmtop to the Agenda.

When you export to the palmtop, your Agenda will generate a name for the calendar file being created, 
but you can change the name of the file to suit your needs. Every time you export to the palmtop 
specifying this calendar name, any inconsistencies between the file and the Agenda will be dealt with in a 
reconciliation process. In your Palmtop Reconciliation preferences, you can choose to let the Agenda deal 
automatically with the details of this process, or you can decide the line of action for each inconsistent 
Entry on a case-by-case basis. Either way, the Palmtop Reconciliation ensures that your Agenda and the 
calendar on your palmtop will always be identical after the exportation, with consideration to changes 
made in either one of them (according to your own settings).

You can also import Entries from a calendar file on your palmtop into your Agenda. Your Agenda will take 
you through a reconciliation process in the same way as described above. In this way, your Agenda and 
the calendar on your palmtop will also be identical after the importation, with consideration to changes 
made in either one of them (according to your own settings).

You can import Entries that were previously exported from someone else's Agenda, simply by choosing 
the appropriate palmtop file to import from. However, these Entries will be considered as created and 
proposed by you.

You should remember that although you can export several Agendas at once, only one palmtop calendar 
can be imported at one time.

Your Agenda has greater scheduling capabilities than the supported palmtops. As a result, there are some 
limits on the information that can be transferred. The import and export utilities are intended to help 
mobile users, but the palmtop cannot serve as a replacement for the Agenda. All types of Entries can be 
exported, but Agenda Entries will exist on your palmtop as Appointments; Day Events, Daily Notes and 
Holidays will exist as Events; and Tasks will exist as To-do's.

Entries that have more than one attendee can be exported to the palmtop. While working on the palmtop, 
you can edit any aspect of these Entries except the list of people/resources. When importing such Entries 
into your Agenda, all changes will automatically be updated for every person/resource included in the 
Entry.

When you export Entries to the palmtop, their Reminders will be set by default (they will be set to five 
minutes before the Entry begins).

To exchange data between your Agenda and your palmtop, you will need to perform an initial set-up. This 
process only needs to be done once. However, if you let both the main and auxiliary power supplies of 
your palmtop run down, you will need to redo this initial set-up.



Initial Set-up Procedure for Exporting to the Palmtop
This set-up procedure will prepare your palmtop to exchange data with your Agenda. Once you have 
done this procedure once, you do not need to repeat it unless you let both the main and auxiliary power 
supplies of your palmtop run down.

For your Agenda to be able to exchange data with your palmtop, you will need to install the UniLink 
Server on your palmtop. 

You must link the PC and the palmtop with the appropriate PC link cable supplied with your palmtop. 
Make sure that the PC's communications port is correctly configured. Refer to your computer's user 
manual for information on the available ports and identifying them. Select the appropriate port from the list 
of options available in the Port edit box.

Then set up the following (the following are the default values and may not need to be changed):

· Set the baud rate to 9600 (rates higher or lower than this don't work well with most palmtops); 

· Set the data bits to 8;

· Set the parity to none;

· Set the stop bits to 1;

· Set the flow control to Xon/Xoff.

These settings will give you the best communication results between your Agenda and your palmtop. 

Once you have set your communications parameters, choose OK to save these settings in your 
UNISON.INI file. If you have correctly configured the port, you can install the UniLink Server on your 
palmtop by choosing Link Install. If you have correctly transferred the UniLink Server file (ul.exe), the 
application should start. Choose Done to close the dialog box.

See Also:

The Export Utility 
Installing the UniLink Server on your HP Palmtop 



Installing the UniLink Server on your HP Palmtop
For your Agenda to be able to exchange data with your palmtop, you will need to install the UniLink 
Server on your palmtop. You only need to do this the first time you export data to or import data from your 
palmtop. (However, if you let the main and auxiliary power supplies for your palmtop run down, you will 
need to re-install the UniLink Server.)

The following instructions will help you complete the set-up procedure for the HP-100LX and HP-200LX 
palmtops. (Only these palmtops are currently supported.)

 1. Connect your palmtop to one of the COM ports on your PC using the PC Link cable supplied with 
your palmtop.

 2. Turn on the palmtop and select & to start the Application Manager.

 3. Press C to start the DataComm Application.

 4. Press MENU C S to open up the settings dialog.

 5. Set the Baud rate to 9600. (Press Alt B and use the arrow keys.)

 6. Set the Interface to Com 1. (Press Alt I and use the arrow keys.)

 7. Set the Parity to None. (Press Alt P and scroll through the box.)

 8. Set the Data bits to 8. (Press Alt T and use the arrow keys.)

 9. Set the Stop Bits to 1. (Press Alt S and use the arrow keys.)

10. Press F10 to accept these settings.

11. Press MENU F P to open up the File Transfer Protocol dialog.

12. Select XMODEM.

13. Press F10 to accept these settings.

14. Press MENU FR to open the Receive File dialog.

15. Enter D:\UL.EXE in the File name edit box.

16. Press F10 to accept these settings.

17. In the Export Utility dialog box, choose Link Install.

18. After the file transfer is complete, exit the DataComm Application by pressing MENU FX.

19. On the palmtop, go to the DOS Prompt. (Press &…D.)

20. Start the UniLink Server by typing UL.

See Also:



The Export Utility 

Initial Set-up Procedure for Exporting to the Palmtop 



Icon Glossary
Your Agenda uses icons to convey as much information as possible without cluttering up the screen. They 
appear along the toolbar, in dialog boxes, in the status bar and in the displays.

Click any of the icons shown below to see a brief definition of the icon.

Netscape Calendar Icons

  

The Dialog Boxes

 

 

Adding Names

 

Reconciliation

 



The Daily Agenda View

 

The Monthly Agenda View

 

The In-tray

 

 

 

The Notes View



 

  

The Task View and Task Display

 

Special Cursors

The Toolbars

 



The Pop-up Reminders

 

The Date Control Bar

 

 

The Status Bar

  

  



Day Events
A Day Event is an event that lasts for, or is valid for, an entire day, without taking up time in your Day 
View. Day Events will appear in the Notes View at the bottom of your Agenda pages. This icon indicates a 

Day Event: .

Creating a Day Event
General 
Summary 
Repeating 
Reminders 

Viewing Day Events
General
Reminders 
Agenda Status

Editing Day Events
General
Summary
Reminders 
Agenda Status
Recurring Entries
Moving an Entry 
Rescheduled Entry 

Preferences
Entry Defaults — Day Events 



Entry Notification
Depending on your settings (Edit Menu, Preferences, Agenda, Notification), other users can receive Entry 
Notifications by electronic mail. 

If you have set the e-mail  notifications on, each time you create or modify an Entry to which other users 
have been invited, your Agenda will display a message box asking you if you want to send the other users 
an e-mail message.

· If you want to send an e-mail message, choose Yes. Your Agenda will then display the Mail Message 
dialog box for you.

· If you do not want to send an e-mail message, choose No. Your Entry will still appear in the In-trays 
and Agendas of the other users.

See Also:
Mail Message 
All about the Mail 
Agenda Preferences — Notification



View Task
This dialog box will appear when you open a Task from within the Reminder Pop-up dialog box. It displays 
information on the Task of which you are being reminded. Furthermore, it is called up when you double-
click a Task while viewing the Task Display of another user.

At the top of the dialog box, the Description of the Task is displayed, as well as the date on which it was 
created.

The View Task dialog box has three tabs: General, Reminders and Details. If you are viewing someone 
else's Tasks, however, there is no Reminders tab.

The General Tab
The General tab displays the following information:

· Due date

· Due time

· Start date

· Start time

· % Completed

· Completion date

· Access level.

· Priority

The Reminders Tab
On the Reminders tab you can change your Reminder settings for the Task. You can set Reminders for 
both your Task's Start Date and/or its Due Date, both are set in the same way.

1. Select the Reminder ON button to turn on the Reminders function. Select the No Reminder (OFF) 
button to turn it off. 
Once you select the Reminder ON button, you can set the Reminders options.

2. Set how you wish to be reminded. You can either be reminded by a Pop-up window or you can have 
the Entry appear as an Upcoming Note in the Notes View of your Agenda (at the bottom of the Daily 
and Weekly Agenda pages). 
Click the arrow next to the display box and select one of the two options.

3. You can choose to be reminded minutes, hours, days, weeks, months or years in advance. To view 
your options and select one, click the arrow to the right of the box. Then type the appropriate number 
in the left-hand box.

The Details Tab
Choose the Details tab to view the Task's Comments and Attachments, if it has any. In this dialog box you 
cannot make any changes on the Details tab.

See Also:

The Pop-Up Reminders 



The Color Scheme 

Choosing Event Colors from the View Menu, or clicking the  button on the toolbar will call up the 
Agenda Entry Colors dialog box. It allows you to quickly change the color scheme of your Agenda Entries 
without having to go and change your Agenda Preferences.

To change the color scheme of your Agenda Entries, select one of the three options available. To view the 
options click the arrow on the right-hand side of the edit box.

You can color your Agenda Entries according to:

· Entry Ownership (i.e. according to whether you or someone else proposed the Entry)

· Importance level

· Attendance Status.

Please note that when you choose to color code Agenda Entries by ownership, and you open another 
user's Agenda, the Agenda Entries you (and not the Agenda's owner) have proposed will appear in blue. 
This makes it easier for you to spot Agenda Entries you can edit in other users' Agendas. (Even if you are 
in another user's Agenda, you can still edit an Entry you have proposed.) However, if you are working in 
someone else's Agenda as a designate, it will be the Agenda Entries proposed by the Agenda's owner 
that will appear in blue, since you are working in that person's Agenda as though you were the owner.

The display below the edit box will show you what colors will be used to code your Entries with each of 
these color schemes.

Click OK when you have made your choice.



Logging in as a Resource
You can sign in to the system as a resource, provided that you know the appropriate password. However, 
you should not work as the resource while logged in as it.

When you sign in to the system as a resource you will only have the following capabilities:

· changing the assigned access rights (setting modification and scheduling rights for other users on the 
system);

· changing the password for signing in as the resource.

Whenever you need to work as a resource, you should do so as a designate.
To work as a designate for a resource, you must sign in as the resource, grant yourself the necessary 
designate rights, and then access the Resource's Agenda as a designate from within your own Agenda.

See Also:

Access Rights — Designate 
Access Rights — Scheduling 



Open an Agenda

The Open an Agenda dialog box is displayed when you choose the  button on the toolbar, or select 
Open Agenda - An Agenda from the File Menu. Here you choose whose Agenda you want to open and 
how you want to open it.

You can choose to do one of the following:

· open your own Agenda;
· open the Agenda of another user to view it; or
· open the Agenda of another user as a Designate.

To open your own Agenda:

1. Select "Modify your own Agenda".

2. Click OK.

To view the Agenda of another user:

1. Select "View the Agenda of:".

2. Type the user's name in the edit box.

· If you want to open a resource's Agenda, type r:, re:, or res: followed by the resource's name.

3. Choose  to accept the name. This will open that user's Agenda.

Choose  to cancel. This will erase the user's name from the edit box. The user's Agenda will not 
be opened.

To open the Agenda of another user as a Designate:

1. Select "Modify, as a designate, the Agenda of:".

2. In the list box below, those users who have granted you designate rights will be displayed. Select the 
user or resource for whom you wish to work as a Designate from the list.

3. Choose OK and the selected user's or resource's Agenda will be opened.

NOTE: If you have not been granted designate rights by any other user, this portion of the dialog box will 
not be displayed.

See Also:

Adding Names 
All about the Agenda Pages 
Working as a Designate 





Editing your Reply for a Recurring Agenda Entry
When you choose to edit the Reply in the Edit Recurring Entry dialog box, Your Agenda will call up this 
dialog box.

Change your reply for the recurrences you are editing.

Select the appropriate message from the list:

· Will attend

· Will not attend

· Confirm later

· The message "Prefer another time" can accompany any of the options.

Choose OK. This will return you to the Edit Recurring Entry dialog box.



Editing Reminders for a Recurring Entry
When you choose to edit the Reminder in the Edit Recurring Entry dialog box, Your Agenda will call up 
this dialog box.

Set the Reminder for the recurrences you are editing. 

1. Select the Reminder ON button to turn on the Reminders function. Select the No Reminder (OFF) 
button to turn it off. 
Once you select the Reminder ON button, you can set the Reminders options.

2. Set how you wish to be reminded. You can either be reminded by a Pop-up window or you can have 
the Entry appear as an Upcoming Note in the Notes View of your Agenda (at the bottom of the Daily 
and Weekly Agenda pages). 
Click the arrow next to the display box and select one of the two options.

3. Set when you want to be reminded. You can choose to be reminded minutes, hours, days, weeks, 
months or years in advance. To view your options and select one, click the arrow to the right of the 
box. Then type the appropriate number in the left-hand box.

4. Choose OK. This will return you to the Edit Recurring Entry dialog box.



Print Preview
You can preview the print-outs of your Agenda pages by choosing Preview in the Print dialog box. 

To scroll through a multiple-page print-out, use the Next Page and Previous Page buttons.

If you prefer to view two pages at a time, click the Two Pages button. Click the One Page button to return 
to the one-page-per-screen view.

You can zoom in on documents in two ways:

· Click the area you wish to magnify with the magnifying cursor. The view will expand to let you see the 
print-out in more detail. You can zoom in twice. If you have reached maximum magnification, the 
cursor will revert to the normal pointer. 

· You can also zoom in by clicking the Zoom In button on the toolbar.

To zoom out, use the Zoom Out button on the toolbar.

When you have finished previewing your print-outs, click Close to return to the Print dialog box.



Saving your Print Layouts
When you have set your options for a particular layout format (such as the Franklin Day Planner Classic, 
the Day-Timer Junior Pocket, or any of the many other formats your Agenda allows you to print), you may 
want to save your set-up. This way you can use exactly the same options the next time you print out your 
Agenda pages, without having to re-enter all of the settings again.

To do so, choose Save as… at the bottom of the Layout Options dialog box.

Enter a name for the layout you have created. This name will then appear in the list of layouts offered in 
the Print dialog box.

When you have finished, choose OK. This will return you to the Layout Options dialog box.



The User Information Box
An Information box will appear on screen when you select a user from a search and either double-click 
the selected name or choose Information. An Information box about the current user (i.e. the user that 
you have signed in as) is called up when you choose User Information from the Edit Menu.

When you choose Information in the Search dialog
The box contains the information available about the person you have selected. The information 
displayed here is entered by the System Operator when they add a person into the system.

The information displayed about other users can only be edited by the System Operator.

When you have finished, choose OK to return to the Search dialog box.

When you choose User Information from the Edit Menu
The box contains the system's information about you (or the user that you have signed in as). Depending 
on your system, you may have the right to modify this information. If you do have this right, you can 
change any incorrect information here. If not, you will have to ask your System Operator to make the 
changes for you.

When you have finished, choose OK.

See Also:

Searching — People 
Searching — Groups 



Viewing a Holiday — General
The View Entry dialog box displays information about the Holiday you have selected. You can call up this 
dialog box either by double-clicking the Entry in your In-tray (if you have set your preferences for this 
option), by double-clicking the Holiday on your Agenda pages, or by selecting the Holiday on the Agenda 
page and choosing Open Entry from the Edit Menu.

You cannot edit Holidays unless your System Operator has given you the authority to do so.

The General tab of the dialog box gives you following information about the Holiday you have selected:

· Creator;

· Title;

· Access level;

· Date.

Choose OK only when you've finished viewing the Holiday.

See Also:

Viewing a Holiday — Reminders 
Viewing a Holiday — Agenda Status 



Viewing a Holiday — Reminders
The View Entry dialog box displays information about the Holiday you have selected. You can call up this 
dialog box either by double-clicking the Entry in your In-tray (if you have set your preferences for this 
option), by double-clicking the Holiday on your Agenda pages, or by selecting the Holiday on the Agenda 
page and choosing Open Entry from the Edit Menu.

You cannot edit Holidays unless your System Operator has given you the authority to do so.

You can change your Reminders for the Holiday using this tab of the dialog box.

1. Select the Reminder ON button to turn on the Reminders function. Select the No Reminder (OFF) 
button to turn it off. 
Once you select the Reminder ON button, you can set the Reminders options.

2. Set how you wish to be reminded. You can either be reminded by a Pop-up window or you can have 
the Entry appear as an Upcoming Note in the Notes View of your Agenda (at the bottom of the Daily 
and Weekly Agenda pages). 
Click the arrow next to the display box and select one of the two options.

3. Set when you want to be reminded. You can choose to be reminded minutes, hours, days, weeks, 
months or years in advance. To view your options and select one, click the arrow to the right of the 
box. Then type the appropriate number in the left-hand box.

Choose OK only when you've finished viewing the Holiday.

See Also:

Viewing a Holiday — General 
Viewing a Holiday — Agenda Status 



Viewing a Holiday — Agenda Status
The View Entry dialog box displays information about the Holiday you have selected. You can call up this 
dialog box either by double-clicking the Entry in your In-tray (if you have set your preferences for this 
option), by double-clicking the Holiday on your Agenda pages, or by selecting the Holiday on the Agenda 
page and choosing Open Entry from the Edit Menu.

You cannot edit Holidays unless your System Operator has given you the authority to do so.

When the View Entry dialog box is called up for a Holiday, the Agenda tab will always be displayed, in 
order for you to quickly choose whether or not to keep it in your Agenda. A summary of the Holiday is 
displayed on this tab, so you don't have to go to the other tabs to get the information you need to respond 
to it.

The summary lists the following information about the Holiday:

· Title;

· Date;

· Access level.

To change the status of the Holiday within your Agenda, select one of the three options:

· Keep in Agenda.
· Remove from Agenda.
· Decide later.

Choose OK only when you've finished viewing the Holiday.

See Also:

Viewing a Holiday — General 
Viewing a Holiday — Reminders



Time Zone Preferences
You choose which time zone to work in using the Time Zone tab of the General Preferences dialog box 
(Edit Menu, Preferences, General). 

Change the time zone when working off-line and traveling or when scheduling Entries with users in 
another time zone.

You can choose in which time zone to work in two different ways, depending on whether you know the 
name of the time zone or not.

1. If you know the name of the time zone you wish to work in, you can enter it in the top edit box. Click 
the arrow to the right of the box to see the choices available. Scroll down and select one.

2. You can also select your time zone by selecting the name of the region or country whose time zone 
you wish to use. Click Load Regions. The Agenda will display a list of countries and regions in the list 
box. Select one of them. The name of the corresponding time zone will then be displayed in the top 
edit box.

3. To return to the normal time zone of your system (i.e. the local time zone in which your system has 
been installed) without logging out, choose Revert to host's time zone.

If the System Operator has given the system's users that right, you can also choose to save the changed 
time zone for future sessions This could be useful for someone who frequently travels between two time 
zones.

· If you don't have this option, the text "Save time zone change for future sessions" will be gray 
(inactive) and you cannot select this button.

· If you do not wish to save the changed time zone, select "Make time zone change for this session 
only".

· If you want to change time zone permanently, select "Save time zone change for future sessions". In 
the future, you will always log in to the changed time zone. If you wish to use the host's time zone 
again, you'll have to open this dialog box and choose Revert to host's time zone. To return to your 
saved time zone without logging out, you can then choose Restore saved time zone.

Note: If you choose to save your time zone change, the alternative time zone will be your default time 
zone in the future. The only way of making the system's time zone your default time zone again, is to 
enter it in the top edit box (in one of the ways described above) and select "Save time zone change 
for future sessions".

Choose OK only after you have set all your General Preferences.



Working as a Designate
A designate is someone who has the right to work in the Agenda of another user, in that user's name. 
However, designates can only carry out those operations that the owner of the Agenda has granted them 
the right to perform.

In a person's Agenda:

To open an Agenda as a designate, choose Open Agenda from the File Menu, and choose An Agenda 
from the Submenu. Click "Modify, as a Designate, the Agenda of:" and select the user's name from the list 
box. Choose OK. The Agenda of that user will then be opened. If you switch to the In-tray and you 
already have your Agenda open as well, you will see both your own folders, and those of the person for 
whom you are working as a designate displayed on the same screen.

Opening an Agenda as a designate will let you work on someone else's Agenda in that person's name (if 
you have been granted the right to do so). As a designate, you can view, edit and add Entries according 
to the rights that you have been granted. Your rights as a designate will have been defined by the owner 
of that Agenda. For example, you may or may not also have access to that user's Tasks.

If you create an Entry while working as a designate in an Agenda, it will be considered to be proposed by 
the Agenda's owner, and you will only be able to edit it when working as that user's designate. The Entries 
you create as a designate will be displayed in the owner's Agenda and (if others have been invited) in his 
or her In-tray, exactly as if that user had created them.

The Access Rights dialog box (Edit Menu, Access Rights) lets you give designate rights to other users. 
You can choose what rights each of your designates will have in your Agenda using the Designate tab of 
the Access Rights dialog box. 

In the Task Display:

To open the Task Display of a another user as a designate, select Open Tasks from the File Menu, and 
choose Modify Other's as designate from the Submenu. If you have been given designate rights by more 
than one user, you will be asked to select which user's Task Display you wish to open. You will then be 
able to view and modify those Tasks to which you have been given rights. 

Any Tasks you create while working as a designate in a Task Display will be the Tasks of the user in 
whose name you're working. You will only be able to edit them when working as that person's designate.

As a Resource:

Note that whenever you need to work in the Agenda of a resource, you should do so as a designate. To 
be able to do this, you must log on to the system as a resource. You will have only the following 
capabilities:

· changing the assigned access rights (setting modification and scheduling rights for other users on the 
system); and,

· changing the password for signing on as the resource.

Grant yourself the necessary designate rights. Then you can access the resource's Agenda as a 
designate from within your own Agenda, in the same way as you would a person's Agenda (see above).



Glossaries
There are two glossaries available: one explains the terms used in your Agenda; the other one explains 
the icons used.

Glossary 
Icon Glossary



Creating a Day Event — General
A Day Event is an event that lasts for, or is valid for, an entire day, without taking up time in your Day 
View. Day Events will appear in the Notes View at the bottom of your Agenda pages. This icon indicates a 

Day Event: .

You can create a Day Event either by choosing New Day Event from the File Menu (File Menu, New, Day 

Event) or by clicking the  on the toolbar.

Day Events scheduled by others will appear in the New Entries folder of your In-tray, where you can 
decide whether to keep them in your Agenda.

Use the General tab of the dialog box to enter the basic information about your Day Event, and to create 
it. You also use this tab of the dialog box to invite people and resources to your Day Event.

1. Type the Title of the Day Event in the Title edit box.

2. Set the date of the Day Event by either:
· using the arrows to the right of the date box to scroll the date up or down; or,
· choosing the calendar button to the right of the date box.

3. Create the list of people and/or resources you want to invite to the Day Event using the edit box.

· To invite a user, type the name in the Add edit box.
If you want to invite a resource, type r:, re:, or res: followed by the resource's name.
If you want to add a group, type g:, gr:, or grp: followed by the group's name.

· Once the correct name is in the edit box, press Enter on your keyboard to include the name on 
the list of invited people and resources that you are creating. The name will then be added in the 
list box below.

· Choose  to search for people, groups or resources.

· Choose  to select a group for your list.
· To delete a name, select it from the list box and choose Delete.

4. If you have made this a recurring Day Event (using the Repeating tab of this dialog box) the list of 
dates on which this Day Event has been scheduled will appear in the list box. Should you make any 
changes to the information you have entered on the General tab after generating these dates, you 
can choose to make your changes apply either only to one selected date or to all dates.

· To make the changes apply to all dates, enter the changes you wish to make and choose Apply 
to All.

· To make changes only to selected dates, select the date and enter the changes you wish to 
make.

5. Do not choose Create until you are completely finished with creating your Day Event (which could 
demand that you use the other tabs of the dialog box).

NOTE: Each time you create or modify an Entry to which other users have been invited, your Agenda 
may display a message box asking you if you want to send the other users an e-mail message. (This 
depends on your Preferences, which you can set using Edit Menu, Preferences, Agenda, Notification.)

· If you want to send an e-mail message, choose Yes. Your Agenda will then display the Mail Message 
dialog box for you.

· If you do not want to send an e-mail message, choose No. Your Entry will still appear in the In-trays 



and Agendas of the other users.

See Also:

Creating a Day Event — Summary 
Creating a Day Event — Reminders 
Creating a Day Event — Repeating 
Adding Names 
Selecting a Group 



Off-line Preferences — Download Preferences
The Off-line Preferences dialog box (Edit Menu, Preferences, Off-line) lets you choose preferences for 
your Off-line Agenda.

The Download tab of the dialog box lets you set the range of Entries that will be downloaded to your Off-
line Agenda.

1. Select the period of time for which you want your Entries to be downloaded. 

· Enter how far back you want your Off-line Agenda to include Entries. Click the arrow to the right 
of the edit box and select one of the time intervals from the scroll-down list (days, weeks, months, 
or years). Then type in the appropriate number in the small edit box.

· Do the same as above to enter how far into the future you would like to extend your Off-line 
Agenda.

2. You can also choose to download all the Entries in your Agenda.
Select "Download all Entries" if you wish to use this option.

3. You must furthermore choose whether your Agenda should be downloaded each time you go off-line 
or quit the application. Choose one of the following options:

· Automatically download: your Agenda will automatically be downloaded when you leave or quit 
your On-line  Agenda.

· Prompt before downloading: you will be asked if you want to download to your Off-line Agenda 
when you leave or quit your On-line Agenda.

· Do not download: your Agenda will not be downloaded unless you choose to do so, using the 
Download to Local File command from the File Menu.

Choose OK only when you've finished with all the tabs of the dialog box.

See Also:

Off-line Preferences — Location 
Off-line Preferences — People/Resources 
Off-line Preferences — Groups 
Off-line Reconciliation Preferences 



Off-line Preferences — People/Resources
The Off-line Preferences dialog box (Edit Menu, Preferences, Off-line) lets you choose preferences for 
your Off-line Agenda.

The People/Resources tab of the dialog box lets you choose which users' Agendas will be included when 
you download your Off-line Agenda. 

Create a list of these users.

1. Type the user's name in the Add edit box.
· If you want to add a resource, type r:, re:, or res: followed by the resource's name.
· If you want to add a group, type g:, gr:, or grp: followed by the group's name.

2. Choose  to accept the addition. This will add the user to the list you are creating.

Choose  to cancel the addition. This will erase the user's name from the edit box, and that user 
will not be added to the list.

3. To delete a name, select it from the list box and choose Delete.

Choose OK only when you've finished with all the tabs of the dialog box.

NOTE: When you download the Agendas of other users, you will only be able to view Entries according to 
the access rights you have been granted by those users.

See Also:

Adding Names 
Off-line Preferences — Location 
Off-line Preferences — Download Preferences 
Off-line Preferences — Groups 
Off-line Reconciliation Preferences 



Off-line Preferences — Groups
The Off-line Preferences dialog box (Edit Menu, Preferences, Off-line) lets you choose preferences for 
your Off-line Agenda.

The Groups tab of the dialog box lets you choose which groups will be included in your Off-line Agenda.

1. If you don't want to include any groups, select No Groups.

2.  If you wish to download all groups with your Agenda, select All Groups.

3.  If you wish to download only certain groups, click the button next to Select Groups. Then decide what 
types of groups you wish to choose from: Private, Other (i.e. all the other group types) or both. Select 
the appropriate checkbox(es) and choose Load. Your Agenda will display a list of the available 
groups. 
To delete a group from the list displayed, select the group and choose Delete. The group is then 
removed from your list.

Choose OK only when you've finished with all the tabs of the dialog box.

NOTE: When you download a group, only a list of the group members' user names will be downloaded, 
not their Agendas. If you wish to download other users' Agendas, you have to use the People/Resources 
tab.

See Also:

Off-line Preferences — Location 
Off-line Preferences — Download Preferences 
Off-line Preferences — People/Resources 
Off-line Reconciliation Preferences 



Off-line Reconciliation Preferences
The Off-line Preferences dialog box (Edit Menu, Preferences, Off-line) lets you choose preferences for 
your Off-line Agenda.

The Reconciliation tab of the dialog box lets you control the way in which your On-line and Off-line 
Agendas will be reconciled. That is, the way in which your Off-line Agenda will be uploaded to your On-
line Agenda. You can choose to make decisions on a case-by-case basis, or let your Agenda 
automatically handle certain situations.

Set your preferences in each section of the tab.

1. When an Entry has been deleted in the Off-line Agenda but still exists in the On-line Agenda, the 
Agenda can either: 

· Show Reconciliation dialog box — this lets you review the deletion and decide whether to 
make it in your On-line Agenda; or

· Delete Entry in Host Agenda — the Agenda will automatically remove the Entry from your On-
line Agenda without asking you first.

Select one of the options.

2. When an Entry has been modified in both the Off-line and the On-line Agenda, the Agenda can either: 

· Show Reconciliation dialog box — this lets you review and confirm the change before it is 
made in your On-line Agenda; or

· Update Entry in Host Agenda — the Agenda will automatically update the Entry in your On-line 
Agenda without asking you first.

Select one of the options.

3. If Agenda Entries are created or modified both in the On-line and Off-line Agenda, scheduling conflicts 
can arise when you upload. The Agenda can either:

· Check for conflicts on upload — if a conflict between Off-line and On-line Agenda Entries arise 
when uploading, the Agenda will display information about the conflict and let you decide what 
should be done about it in the Conflicts Detected dialog box.

· Ignore conflicts on upload — the Agenda will not prompt you about any such conflicts when 
uploading.

Select one of the options.

4. Select the "Redownload Host Agenda after upload" check box if you want the reconciled Host Agenda 
to be automatically downloaded after each upload. This option ensures that the Off-line Agenda and 
the Host Agenda are identical after every upload. If you unselect this option, the two Agendas can 
differ.

Choose OK only when you've finished with all the tabs of the dialog box.

See Also:

Off-line Preferences — Location 
Off-line Preferences — People/Resources 
Off-line Preferences — Download Preferences 



Off-line Preferences — Groups 



Host Reconciliation
Making your Off-line Agenda file and your On-line Agenda consistent with one another when uploading is 
a process called reconciliation. 

The Host Reconciliation dialog box will appear each time the two Agendas do not correspond concerning 
an Entry (depending on how you have set your Off-line Reconciliation Preferences—Edit Menu, 
Preferences, Off-line).

The dialog box is broken up into four sections.

In the top left corner of the dialog box, an icon indicates what type of Entry that needs to be reconciled. 
Entries will appear as follows:

Agenda Entry

Day Event

Holiday

Task

Daily Note

Along the upper edge of the dialog box, information is displayed about the Entry's status in the Off-line 
and On-line Agendas (deleted, modified, or unmodified).

The two list boxes below this contain the details of the change the Agenda has found. 

· The upper list box shows the Entry as it appears in the Off-line Agenda.

· The lower list box shows the Entry as it appears in the On-line Agenda.

The box at the bottom asks how you wish to treat the inconsistency. If you want to replace the On-line 
Agenda's version of the Entry, choose Yes. To keep the On-line Agenda's version, choose No.

The Agenda will then continue uploading your Agenda file.



The Off-line Agenda
You can use your Agenda both on-line and off-line. This way you can work on your Agenda even when 
you cannot connect to the server. You can easily update your On-line Agenda by uploading your off-line 
file: your Agenda will help you reconcile any differences between the two quickly and easily. 

For more information on using the on-line and off-line features of your Agenda, see the topics below:

Signing In 
Off-line Agenda Configuration 
Off-line Preferences — Location 
Off-line Preferences — Download Preferences 
Off-line Preferences — People/Resources 
Off-line Preferences — Groups 
Off-line Reconciliation Preferences 
Host Reconciliation 



Associating a File
An attached file may not always be able to find an application that can open it. You must then associate 
the file with an application in the Associate dialog box. 

Sometimes an attached executable file can not automatically be identified as such, in that case you may 
be able to execute it from this dialog box. 

Choose one of the following three options.

· Associate the file with an application. Select Associate from the Action list box. Type the application's 
file name in the Associate with edit box. You can also use the Browse button to find the appropriate 
application. Choose OK.

· Execute the file from this dialog box without associating it first with an application. Try this only if you 
know that the file is executable despite of an unconventional file extension. A Warning will appear, 
asking you to reconfirm your action. Select Execute from the Action list box and choose OK.

· Open the file directly from this dialog box. Select Open from the Action list box. Type the application's 
file name in the Associate with edit box. You can also use the Browse button to find the appropriate 
application. Choose OK.



vCalendar Entries Found...
This pop-up dialog box will appear when you are importing vCalendar Entries into your Agenda. It allows 
you to handle individual Entries and view the details of an event before accepting or rejecting the Entry.

At the top of the dialog box, the number of vCalendar Entries being imported is displayed along with two 
arrow buttons. Clicking these buttons will scroll through the Entries being imported. For each Entry, the 
available information will be displayed, including:

· Type of Entry (the icon to the left);

· Title;

· Date (Start and Due dates for Tasks);

· Start and End times (Due time for Tasks);

· Access level;

· Importance level (Priority for Tasks);

· Location.

To view other details available about the Entry, click View Details....

To add the Entry currently displayed in this dialog box to your Agenda, click Add Entry. If there is more 
than one Entry, you can add all of them by clicking Add All/Add the Rest (this text will appear if you have 
already handled some of the Entries that were included in this dialog box).

If you do not want to add the Entry to your Agenda, click Reject Entry. The Entry will not be added to 
your Agenda. However, it will not be deleted from the .vcs file (the file from which you are importing the 
Entry).

Click Close to dismiss the dialog box when you are done.

See also:
The Import Utility 
Working with vCalendar Objects 



Working with vCalendar Objects
The Agenda can import and export vCalendar objects from files (with the extension .vcs). This allows you 
to share events with other users, post events on a Web site and receive events from other users or Web 
sites. 

There are three ways to import and export vCalendar Entries. You can use the Import and Export Utilities 
(File Menu), you can drag and drop the Entries into or out of your Agenda, or you can copy them via the 
Clipboard using the cut (Ctrl-X), copy (Ctrl-C) and paste (Ctrl-V) commands. Any kind of Entry (Agenda 
Entry, Daily Note, Day Event, Task, or Holiday) can be imported and exported from any view (Daily 
Agenda, Weekly Agenda, Monthly Agenda, In-tray, Task Display) in this way

Importing Entries
To add an Entry to your Agenda by dragging and dropping, drag the Entry into your Agenda window. A 
pop-up dialog box will appear, which will let you add the Entry to your Agenda. If you have more than one 
Agenda open (for example, your Agenda and the Agenda of another user on your system), the Entry you 
drag in will be added to the Agenda on which it is dropped.

When you import an Entry, it will be considered to be created and proposed by you. You will also be listed 
as the only attendee. If other people or resources were listed as attending the Entry, their names will 
appear on the Details tab, along with any additional information available about the Entry.

You can use the copy (Ctrl-C) and paste (Ctrl-V) commands (also available from the Edit Menu) to do the 
same thing by way of the Clipboard. Select a vCalendar object, copy it, then paste it into your Agenda.

For information about using the Import Utility, see The Import Utility .

Exporting Entries
You can export Entries in the same ways that you import them. To drag an Entry from your Agenda to 
another application (or your Windows 95/Windows NT 4.0 desktop), press the Control key and click the 
Entry with the left mouse button. Then drag the Entry to the desired location. (Pressing the Control key 
and clicking the Entry with the left mouse button copies the item—you will then drag this copy of the Entry 
to another location.) 

You can do the same thing from one Agenda to another as well. For example, if you want to invite a user 
to an Entry you have already created, and you have their Agenda open, you can drag the Entry from your 
Agenda to their Agenda: the Entry will appear in their Agenda as a new Entry, and the user will have been 
added to the list of people invited to the Entry.

You can use the cut (Ctrl-X) or copy (Ctrl-C) and paste (Ctrl-V) commands (also available from the Edit 
Menu) to do the same thing by way of the Clipboard. Select an Entry in your Agenda, copy it, then paste it 
into its new location (another Agenda or another application). Any application that can paste plain text or 
the vCalendar registered format to the clipboard can open a vCalendar object.

For information about using the Import Utility, see The Export Utility .

Using the Netscape Plug-in
vCalendar objects are appearing with increasing frequency on Web sites as a means of informing people 
about upcoming events. You can import these vCalendar objects to your Agenda using your Netscape 
browser. All you need to do is double-click the vCalendar object's icon. If your Agenda is not running at 
the time, you will be prompted to start it, so that the Entry can be imported. Once you have signed in to 



your Agenda, a pop-up dialog box will appear, which will let you add the Entry to your Agenda. See the 
section Importing Entries (above) for more information.

To take advantage of this Netscape feature, the Netscape vCalendar plug-in must be in the 
netscape\programs\plugins directory. The plug-in file for Windows 95 and Windows NT is npvcal32.dll. 
Windows 3.1 and 3.11 users must use the npvcal16.dll plug-in file.

See also:
vCalendar Entries Found... 
vCalendar Object Details 



vCalendar Object Details
Any details included in a vCalendar object will be displayed in this dialog box. 

This information may include a list of occurrences. It can also include comments or additional information 
about the event, such as its location or a list of other people or resources who have been invited to it.

Choose Close when you've finished with the dialog box.

NOTE: When you import or export an Entry, any people or resources invited to it will be listed in the 
Comments section of the vCalendar object that is created.

See also:
vCalendar Entries Found...
Working with vCalendar Objects 



The Resource Information Box
An Information box will appear on screen when you select a resource from a search and either double-
click the selected resource's name or choose Information.

The box contains the information available about the resource you have selected. The information 
displayed here is entered by the System Operator when they add a resource into the system.

The information displayed here can only be edited by the System Operator.

When you have finished, choose OK to return to the Search dialog box.

See Also:

Searching — Resources 
Searching — Groups 



Holidays
You can enter Holidays into the Agenda (if you have been given the authorization to do so).

On your Daily and Weekly Agenda pages, Holidays will be displayed in the Notes View. They will appear 

next to the date in the Monthly Agenda page. This icon indicates a Holiday: . Holidays received from 
others will appear in the New Entries folder of your In-tray, where you can decide whether or not to keep 
them in your Agenda.

For more details on Holidays, click one of the following topic headings:

Adding Holidays
Viewing a Holiday — General 
Viewing a Holiday — Reminders 
Viewing a Daily Note — Agenda Status 



Conflicts Detected
If Agenda Entries are created or modified both in the On-line and Off-line Agenda, scheduling conflicts 
can arise between these Entries. When you upload your Off-line Agenda, the Conflicts Detected dialog 
box is called up when such conflicts are detected (depending on the Off-line Reconciliation Preferences 
you have set—Edit Menu, Preferences, Off-line). 

The same kind of conflicts can occur when you import data from a palmtop to your Agenda. When these 
conflicts are detected while you are reconciling your Agenda with the palmtop, the Conflicts Detected 
dialog box will be called up (depending on the Palmtop Reconciliation Preferences you have set— Edit 
Menu, Preferences, Palmtop).

The dialog box shows you information about the conflict(s): 

· At the top of the dialog box, the off-line or palmtop Agenda Entry that is causing the conflict(s) is 
indicated.

· In the left-hand list box all the Agenda Entries in conflict with the off-line or palmtop Entry are listed. 

· When you select an Agenda Entry in the left-hand list box, all the invited people and resources for 
whom the selected and the off-line or palmtop Entry are in conflict will be listed in the right-hand list 
box.

Decide what to do about the conflict(s). Choose one of the following buttons:

· Ignore conflict: Choose this button to ignore the conflict. The off-line or palmtop Entry will be added 
to the Agenda regardless of the conflicts. 

· Reschedule: Choose this button to reschedule the off-line or palmtop Entry to another date and/or 
time. The Edit Entry dialog box will appear. Make the necessary changes and choose OK.

· Delete off-line/palmtop Entry: Choose this button to remove the off-line or palmtop Entry. It will not 
be added to your Host Agenda.

After you have made your choice, the uploading of your Off-line Agenda - or the reconciling of your 
palmtop with your Agenda - will continue.

See Also:

Off-line Reconciliation Preferences
Host Reconciliation 
Palmtop Reconciliation Preferences 
Palmtop Reconciliation 
Editing an Agenda Entry — General



Palmtop Reconciliation
Palmtop Reconciliation is the process of making the palmtop and your Agenda consistent with one 
another. When you import data from a palmtop, the Palmtop Reconciliation dialog box will open to let you 
start and end the reconciliation process. 

This dialog box may also be called up when you export data and your Agenda detects inconsistencies 
between the palmtop and your Agenda.

At the top of the dialog box, information about the palmtop file you are importing from (or exporting to) is 
displayed.

If you want to change your Palmtop Reconciliation preferences before starting the process, you can 
access them from this dialog box. Choose Options to call up the Palmtop Reconciliation Preferences 
dialog box.

To start the reconciliation process, click Start. Depending on your preferences, the Confirm Entry 
Deletion, Confirm Entry Modification, and Conflicts Detected dialog boxes may be called up during the 
process.

Once the Agenda has finished reconciliating (when the Status indicator has reached 100%), click Done to 
return to the Import Utility (or Export Utility) dialog box.

See Also:

Palmtop Reconciliation Preferences 
Palmtop Reconciliation — Confirm Entry Deletion 
Palmtop Reconciliation — Confirm Entry Modification 
Conflicts Detected 



Palmtop Reconciliation Preferences
Before you exchange data between your Agenda and your palmtop, you should set your Palmtop 
Reconciliation preferences. You do this in the Palmtop Reconciliation Preferences dialog box, which is 
called up when you choose Preferences from the Edit Menu and select Palmtop, or when you click 
Options in the Palmtop Reconciliation dialog box.

Here you control the way in which your palmtop calendar file and your Agenda will be reconciled when 
you import the palmtop data to your Agenda. You can choose to make decisions on a case-by-case basis, 
or let your Agenda automatically handle certain situations.

Set your preferences in each section of the dialog box.

1. Concerning Entries that have been deleted from the palmtop but are unmodified in your Agenda, you 
can either choose to confirm each Entry reconciliation before it is made, or let the Agenda reconcile 
all such Entries automatically. 

· If you select "Confirm before Reconciling", you will be able to review the Entry that has been 
deleted in the palmtop, and decide case-by-case whether to delete the Entry from the Agenda or 
not.

· If you select "Reconcile Automatically by:", you have to choose whether you want your Agenda to 
always delete the Entry from the Agenda, or to always keep the Entry in the Agenda. Select one 
of the subordinate buttons.

2. Concerning Entries that have been modified both in the palmtop and in your Agenda, you can 
similarly choose to confirm each Entry reconciliation before it is made, or let the Agenda reconcile all 
such Entries automatically. 

· If you select "Confirm before Reconciling", you will be able to review and compare the Palmtop 
and Agenda versions of the Entry that has been modified, and decide case-by-case which version 
to keep.

· If you select "Reconcile Automatically by:", you have to choose which of the versions you always 
want your Agenda to keep, the Palmtop or the Agenda version of the Entry. Select one of the 
subordinate buttons.

3. If Agenda Entries are created or modified both in the palmtop and in your Agenda, scheduling 
conflicts can arise when you exchange data between the two. As part of the palmtop reconciliation 
process, you can have your Agenda prompt you on such conflicts:

· Select "Check for conflicts on import" if you want the Agenda to display information about 
scheduling conflicts and let you decide what to do about them in the Conflicts Detected dialog 
box.

· Select "Ignore conflicts on import" if you don't want the Agenda to prompt you about any such 
conflicts when exchanging data with your palmtop.

4. Choose OK once you've set all your preferences.

See Also:

The Import Utility 
Palmtop Reconciliation 
Palmtop Reconciliation — Confirm Entry Deletion 
Palmtop Reconciliation — Confirm Entry Modification 
Conflicts Detected 



Serial Settings
This dialog box is called up when you choose Link Settings in the Export or Import Utility dialog boxes. It 
is used to select which of your PC's serial ports will be used to export data to or import data from your 
palmtop. If you have not exported or imported before, you also install the link between your Agenda and 
your palmtop here.

To select the serial port that will be used, click the arrow to the right of the Com Port edit box and select 
the port that your palmtop is connected to. Choose OK. 

If this is the first time you are exporting data to or importing data from your palmtop, open the DataComm 
application on your palmtop. Choose File Receive from the File Menu and enter the file name ul.exe. 
Then choose Link Install in this dialog box. You will not need to do this again, unless the batteries on 
your palmtop run down, erasing all the data and applications it contains.

See Also:

The Import Utility 
The Export Utility



Serial Settings
This dialog box is called up when you choose Link Settings in the Export or Import Utility dialog boxes. It 
is used to select which of your PC's serial ports will be used to export data to or import data from your 
palmtop. If you have not exported or imported before, you also install the link between your Agenda and 
your palmtop here.

To select the serial port that will be used, click the arrow to the right of the Com Port edit box and select 
the port that your palmtop is connected to. Choose OK. 

If this is the first time you are exporting data to or importing data from your palmtop, open the DataComm 
application on your palmtop. Choose File Receive from the File Menu and enter the file name ul.exe. 
Then choose Link Install in this dialog box. You will not need to do this again, unless the batteries on 
your palmtop run down, erasing all the data and applications it contains.

See Also:

The Import Utility 
The Export Utility 



Palmtop Reconciliation — Confirm Entry Deletion
Depending on the preferences you have set (Edit Menu, Preferences, Palmtop), the Confirm Entry 
Deletion dialog box may be called up when you are reconciling your palmtop and your Agenda.

This dialog box will be displayed when your Agenda detects an Entry that has been deleted in the 
palmtop, but has been left unmodified in your Agenda. It gives you all the information about the Entry and 
lets you decide whether or not to delete the Entry in your Agenda, in consequence of the deletion in the 
palmtop.

At the top of the dialog box, an icon indicates which kind of Entry has been deleted. Entries will appear as 
follows:

Agenda Entry

Day Event

Holiday

Task

Daily Note

Information about the Entry is listed in the dialog box. Click Details to see any description (comments for 
Tasks) that has been included with the Entry. Click Entry Data to return to the general information about 
the Entry. 

1. Choose whether to delete the Entry from your Agenda by selecting one of the buttons at the top of the 
dialog box:

· Select "Remove Entry from Agenda" to delete the Entry in your Agenda.
· Select "Keep Entry in Agenda" to keep the Entry. The Entry will then be re-exported to your 

palmtop, so that the latter is identical to your Agenda after the reconciliation. Thus, this overrides 
the earlier deletion in your palmtop.

2. Choose OK once you've selected the appropriate button. This will return you to the Palmtop 
Reconciliation dialog box.



Palmtop Reconciliation — Confirm Entry Deletion
Depending on the preferences you have set (Edit Menu, Preferences, Palmtop), the Confirm Entry 
Deletion dialog box may be called up when you are reconciling your palmtop and your Agenda.

This dialog box will be displayed when your Agenda detects an Entry that has been deleted in the 
palmtop, but has been left unmodified in your Agenda. It gives you all the information about the Entry and 
lets you decide whether or not to delete the Entry in your Agenda, in consequence of the deletion in the 
palmtop.

At the top of the dialog box, an icon indicates which kind of Entry has been deleted. Entries will appear as 
follows:

Agenda Entry

Day Event

Holiday

Task

Daily Note

Information about the Entry is listed in the dialog box. Click Details to see any description (comments for 
Tasks) that has been included with the Entry. Click Entry Data to return to the general information about 
the Entry. 

1. Choose whether to delete the Entry from your Agenda by selecting one of the buttons at the top of the 
dialog box:

· Select "Remove Entry from Agenda" to delete the Entry in your Agenda.
· Select "Keep Entry in Agenda" to keep the Entry. The Entry will then be re-exported to your 

palmtop, so that the latter is identical to your Agenda after the reconciliation. Thus, this overrides 
the earlier deletion in your palmtop.

2. Choose OK once you've selected the appropriate button. This will return you to the Palmtop 
Reconciliation dialog box.



Palmtop Reconciliation — Confirm Entry Modification
Depending on the preferences you have set (Edit Menu, Preferences, Palmtop), the Confirm Entry 
Modification dialog box may be called up when you are reconciling your palmtop and your Agenda.

This dialog box will be displayed when your Agenda detects an Entry that has been modified both in the 
palmtop and in your Agenda. It gives you all the information about both the Agenda version and the 
palmtop version of the Entry, and it lets you decide which one you want to keep in your Agenda.

At the top of the dialog box, an icon indicates which kind of Entry the dialog box concerns. Entries will 
appear as follows:

Agenda Entry

Day Event

Holiday

Task

Daily Note

Below, information about the two versions of the Entry is listed, with double-arrows indicating what has 
been modified. Click Details to see and compare the versions of any description (comments for Tasks) 
that has been included with the Entry. Click Entry Data to return to the general information about the 
Entry.

1. Choose which version of the Entry you would like to keep in your Agenda by selecting one of the 
buttons at the top of the dialog box:

· Select "Keep Agenda version" to keep the version of the Entry that was found in the Agenda. The 
Entry will then be re-exported to your palmtop, so that the latter is identical to your Agenda after 
the reconciliation.

· Select "Keep palmtop version" to keep the version of the Entry that was found in the palmtop.

2. Choose OK once you've selected the appropriate button. This will return you to the Palmtop 
Reconciliation dialog box.



Palmtop Reconciliation — Confirm Entry Modification
Depending on the preferences you have set (Edit Menu, Preferences, Palmtop), the Confirm Entry 
Modification dialog box may be called up when you are reconciling your palmtop and your Agenda.

This dialog box will be displayed when your Agenda detects an Entry that has been modified both in the 
palmtop and in your Agenda. It gives you all the information about both the Agenda version and the 
palmtop version of the Entry, and it lets you decide which one you want to keep in your Agenda.

At the top of the dialog box, an icon indicates which kind of Entry the dialog box concerns. Entries will 
appear as follows:

Agenda Entry

Day Event

Holiday

Task

Daily Note

Below, information about the two versions of the Entry is listed, with double-arrows indicating what has 
been modified. Click Details to see and compare the versions of any description (comments for Tasks) 
that has been included with the Entry. Click Entry Data to return to the general information about the 
Entry.

1. Choose which version of the Entry you would like to keep in your Agenda by selecting one of the 
buttons at the top of the dialog box:

· Select "Keep Agenda version" to keep the version of the Entry that was found in the Agenda. The 
Entry will then be re-exported to your palmtop, so that the latter is identical to your Agenda after 
the reconciliation.

· Select "Keep palmtop version" to keep the version of the Entry that was found in the palmtop.

2. Choose OK once you've selected the appropriate button. This will return you to the Palmtop 
Reconciliation dialog box.



Local File Upload
When you choose Upload from Local File from the File Menu, this dialog box is called up.

If you want to go ahead and start the uploading of your Off-line Agenda, choose Start Upload. To cancel 
the uploading, choose Cancel.

Once the upload starts you can follow the process in this dialog box.



Host Agenda Download
When you choose Download to Local File from the File Menu, this dialog box is called up.

If you want to go ahead and start the downloading of your On-line Agenda, choose Start Download. To 
cancel the downloading, choose Cancel.

Once the download starts you can follow the process in this dialog box.



Editing an Agenda Entry — Summary
Use the Edit Entry dialog box to make changes to an Agenda Entry that you have proposed. This dialog 
box is called up when you select the Agenda Entry on the Agenda page and choose Open Entry from the 
Edit Menu (or double-click the Entry).

If other users have been invited to the Agenda Entry, the changes you make will automatically appear in 
their Agendas as well. If you change the time or date of the Agenda Entry, it will appear as a new Entry in 
their In-tray.

The Summary tab of the dialog box provides a summary of your Agenda Entry. It lists certain information 
about the Entry and lets you change other information.

1. The following information is listed on this tab, but cannot be changed here:

· Title;
· Who proposed the Entry;
· People invited;
· The description of the Entry (Details);
· Creator.

2. You can change the location for your Agenda Entry in the Location box. If only one single resource 
has been included on the list of people and resources (on the General tab), it will automatically be 
entered in the Location edit box if you haven't already written a location for your Agenda Entry here.

3. You can adjust the importance level by clicking the arrow to the right of the Importance box and 
selecting the level.

4. You can adjust the access level by clicking the arrow to the right of the Access box and selecting one 
of the options. If you have invited others to the Agenda Entry you are editing, the access level you set 
for the Entry will apply to them as well. They will not be able to set a different access level for it in 
their Agendas.

Choose OK only when you have made all your changes (on all the tabs of the dialog box).

NOTE: Each time you create or modify an Entry to which other users have been invited, your Agenda 
may display a message box asking you if you want to send the other users an e-mail message. (This 
depends on your Preferences, which you can set using Edit Menu, Preferences, Agenda, Notification.)

· If you want to send an e-mail message, choose Yes. Your Agenda will then display the Mail Message 
dialog box for you.

· If you do not want to send an e-mail message, choose No. Your Entry will still appear in the In-trays 
and Agendas of the other users.

See Also:

Editing an Agenda Entry — General 
Editing an Agenda Entry — Details
Editing an Agenda Entry — Reminders
Editing an Agenda Entry — Linked Tasks
Editing an Agenda Entry — Reply 



Off-line Agenda Configuration
If you sign in to your Off-line Agenda without priorly having set it up while working On-line, the Off-line 
Agenda Configuration dialog box will be called up. You will have to configure your Off-line Agenda here 
before you can start using it.

1. Enter your user name (the name by which the system knows you) at the top of the dialog box.

2. Select the time zone for your Off-line Agenda.You can either select the name of the time zone in the 
edit box (scroll down and select the correct name), or select a region or country in the list box below.

3. Finally, you will have to enter the directory where you want to store your Off-line Agenda file in the edit 
box at the bottom of the dialog box. You can use the Browse button to look for and select the right 
directory.

4. When you've entered all this information, choose OK.



An Agenda
Displays the dialog box for opening your Agenda, that of another user, or an Agenda to which you have 
designate rights.



A Group Agenda
Displays the dialog box for creating a Group Agenda. A Group Agenda displays the Day Views of several 
users in one view.



A Group Agenda as a Designate
Lets you open a Group Agenda on behalf of a user for whom you have designate rights. A Group Agenda 
displays the Day Views of several users in one view.



Your Tasks
Opens your Task Display.



Modify Other's as Designate
Lets you open the Task Display of a user for whom you have designate rights.



View Other's Tasks
Lets you open the Task Display of another user.



Open In-tray
Opens the In-tray.



Close
Closes the active window.



Change Password
Lets you change your sign-in password.



Download to Local File
Downloads your On-line Agenda to your Off-line Agenda. Use this command when you have made 
changes to your Host Agenda and want to update your Off-line Agenda.



Upload from Local File
Uploads your Off-line Agenda to your On-line Agenda. Use this command when you have made changes 
to your Agenda while working off-line.



Go Off-line/On-line
Disconnects you from the Server and opens your Off-line Agenda if you are currently on-line. Connects 
you to the Server and opens your On-line Agenda if you are currently off-line.



Launch Browser
Launches your Netscape browser.



Turn Reminders On/Off
Turns the activated Pop-up Reminders on/off.



Export Data
Opens the Export Utility dialog box, which lets you export the Agenda data to a file, laptop or palmtop.



Import Data
Opens the Import Utility dialog box, which lets you import Agenda data from a file, laptop or palmtop.



Print
Prints the active document.



Print Set-Up
Lets you change the printer and printing options.



Quit
Quits the application; prompts to save the document.



Cut
Cuts the selected Entry from your Agenda and places it in the Clipboard, so that you can paste it into an 
editor or an e-mail message in vCalendar format.



Copy
Copies the selected Entry from your Agenda to the Clipboard, so that you can paste it into an editor or an 
e-mail message in vCalendar format. You can also duplicate an Entry in your Agenda through pasting it 
into your Agenda again.



Paste
Pastes a vCalendar object that is currently in the Clipboard into your Agenda.



New Agenda Entry
Lets you create a new Agenda Entry.



New Daily Note
Lets you create a new Daily Note.



New Day Event
Lets you create a new Day Event.



Open Entry
Edit or view the selected Entry.



Toolbar
Displays or hides the toolbar.



Status Bar
Displays or hides the status bar.



Cascade
Arranges the open windows in an overlapped fashion.



Tile Vertically
Arranges the open windows in vertical non-overlapped tiles.



Tile Horizontally
Arranges the open windows in horizontal non-overlapped tiles.



Arrange Icons
Arranges the icons of minimized windows.



Close All
Closes all windows open within your Agenda.



Window 1, 2, ...
Goes to the specified window.



Contents
Offers you an index to topics on which you can get help.



Using Help
Provides general instructions on using Help.



About...
Displays the version number of this application.



Search Directory
Look for people or resources in the directory. (This only displays information about the users you find. You 
cannot access users from here.)



Locate Person
Find out what a person has scheduled in his or her Agenda at a specific time (if you have the right to 
access the pertinent information).



Manage Groups
Add, delete or modify groups.



Access Rights
Set access rights for people or resources.



Agenda
Edit your Agenda preferences.



In-tray
Edit your In-tray preferences.



Scheduling
Edit your scheduling preferences.



General
Edit your general settings.



Off-line
Edit your off-line preferences.



Palmtop
Edit your palmtop reconciliation preferences.



User Information
Displays the system's information about you (or the user you have signed in as). If your system allows it, 
you can also change this information here.



Holidays
Modify the Holiday list (if you have the authorization to do so.)



New Task
Lets you create a new Task.



Open Selected Task
Opens the selected Task.



Duplicate Selected Task
Duplicates the selected Task.



Delete Selected Task
Deletes the selected Task.



Show All Tasks
Displays all existing Tasks.



Show Incomplete Tasks
Displays only incomplete Tasks.



Show Completed Tasks
Displays only completed Tasks.



Show Active Tasks
Displays only active Tasks.



Sort Tasks by Description
Sorts listed Tasks by description (alphabetically).



Sort Tasks by Due Date
Sorts listed Tasks by due date.



Sort Tasks by Start Date
Sorts listed Tasks by start date.



Sort Tasks by Priority
Sorts listed Tasks by priority.



Duplicate Entry
Makes a copy of the selected Entry.



Reschedule Entry
Move the selected Entry to another date and/or time.



Delete Entry
Deletes the selected Entry.



Refresh All
Refreshes all windows.



Month
Displays the Monthly Agenda page.



Week
Display the Weekly Agenda page.



Day
Displays the Daily Agenda page.



Find In-tray Entry
Finds the selected In-tray Entry in the Agenda.



Entry Defaults 
Edit your Default settings for Agenda Entries, Tasks, Day Events, and Daily Notes.



Print Selected Entry
Prints the selected Entry.



Print Selected Task
Prints the selected Task.



Communicator Components
Launches the specified Communicator component.



Communicator Components
Launches the specified Communicator component.



Communicator Components
Launches the specified Communicator component.



Communicator Components
Launches the specified Communicator component.



Communicator Components
Launches the specified Communicator component.



Communicator Components
Launches the specified Communicator component.



Communicator Components
Launches the specified Communicator component.



Communicator Components
Launches the specified Communicator component.



Communicator Components
Launches the specified Communicator component.



Communicator Components
Launches the specified Communicator component.



Decrease Time Slot
Reduces the amount of time contained in each time slot.



Increase Time Slot
Increases the amount of time contained in each time slot.



Icons On/Off
Displays or hides the icons in Agenda Entries and Tasks on your Agenda pages.



Event Colors
Lets you change the Agenda Entry color scheme.



The Checkmark
This icon indicates one of the following things, depending on the context:

- the user is attending the Entry (when an Entry's participants are displayed in the In-tray, or on a 
People/Resources list)
- there are no conflicting Agenda Entries (when you check conflicts for an Agenda Entry); 
- you have accepted a recurring Entry for this recurrence (when you're viewing a recurring Entry).



The "X"
This icon indicates one of the following things, depending on the context:

- the user is not attending the Entry (when an Entry's participants are displayed in the In-tray, or on a 
People/Resources list);
- there are conflicting Agenda Entries (when you check conflicts for an Agenda Entry);
- you have refused a recurring Entry for this recurrence (when you're viewing a recurring Entry).



The Question Mark
This icon indicates one of the following things, depending on the context:

- the user has not yet replied to the Entry (when an Entry's participants are displayed in the In-tray, or on 
a People/Resources list);
- no search has been done for conflicting Agenda Entries (when you are creating or editing an Agenda 
Entry);
- you have not yet replied to a recurring Entry for this recurrence (when you're viewing a recurring Entry).



The Mail Message Button
Clicking this button will bring up the Mail Message dialog box.
It allows you to send an e-mail message to other users.



The Calendar Button
Clicking the calendar button will bring up this box:

It allows you to select a specific date on which you would like to schedule an Entry or to which you would 
like to open your Agenda pages.
This button appears in many dialog boxes and on several toolbars within your Agenda.



The Clock Button
When this button appears within a dialog box, it calls up this box:

It allows you to set the time in the corresponding time box (for example the start time for an Agenda Entry 
you are scheduling).



The "X" Button
This button appears when you need to choose between accepting or refusing something that has been 
entered in an Edit box. 
Choosing this button will erase the information—it will not be entered.

For example, when you are adding a user to a list of people and resources, you will enter the name in the 
edit box. If you decide you do not want to add this name to the list you are creating, choose this button.



The Checkmark Button
This button appears when you need to choose between accepting or refusing something that has been 
entered in an Edit box. 
By choosing this button you accept the information.

For example, when you are adding a user to a list of people and resources, you will enter the name in the 
edit box. To add this name to the list you are creating, you must then choose this button.



The Search Button
Choosing this button will bring up the Search dialog box. It lets you search in the directory for the names 
of other people, resources or groups within the network.



The Question Mark Button
Choosing this button will bring up the Help Topic about Adding Names.
This button always appears with the edit box used for adding other people or resources to a list of users.



The Group Button
The Group button appears in many different dialog boxes, it calls up the Group Selection dialog box. 
Using this dialog box, you can add an entire group of people and/or resources to a list at once.



The Round Checkmark
This icon will appear in Agenda Entries on your Daily and Weekly Agenda pages.
If this icon appears on the upper right-hand corner of your Agenda Entry, you have indicated you will 
attend the event.



The Round "X"
This icon will appear in Agenda Entries on your Daily and Weekly Agenda pages.
If this icon appears on the upper right-hand corner of your Agenda Entry, you have indicated you will not 
attend the event.



The Round Question Mark
This icon will appear in Agenda Entries on your Daily and Weekly Agenda pages.
If this icon appears on the upper right-hand corner of your Agenda Entry, you have not yet indicated 
whether or not you will attend the event.



The Description/Comments Icon
This icon will appear in Agenda Entries and Tasks on your Daily and Weekly Agenda pages, as well as in 
your Task Display.
It indicates that there is a Description included with the Agenda Entry, or Comments included with the 
Task. To view the Description or the Comments, open the Entry and select the Details tab.



The Group
This icon will appear in Agenda Entries on your Daily and Weekly Agenda pages.
If this icon appears on the upper left-hand corner of your Entry, there are other users invited to the Entry.



The Bell
This icon will appear in Agenda Entries and Tasks on your Daily and Weekly Agenda pages, as well as in 
your Task Display. It indicates you have set a reminder for the Entry.
It also appears in the status bar, where it indicates that the Pop-up Reminders are turned on.



The Grid Button
This button appears on the Date Control Bar of your Monthly Agenda page. Clicking this button will return 
the calendar grid to its default setting. (This is useful if you have moved around several of the splitters or 
resized the window—it will regenerate an evenly sized calendar grid.)



The More Icon
This icon indicates that there are more Entries contained in the grid square than what is visible.
You can scroll down through the Entries to reach those that are not displayed.



The Day Event Icon
This icon indicates that the Entry next to it is a Day Event.
It can appear in the Notes View of the Daily and Weekly Agenda pages, the Month View of the Monthly 
Agenda page and in the In-tray.



The Note Icon
This icon indicates that the Entry next to it is a Daily Note.
It can appear in the Notes View of the Daily and Weekly Agenda pages, the Month View of the Monthly 
Agenda page and in the In-tray.



The Holiday Icon
This icon indicates that the Entry next to it is a Holiday.
It can appear in the Notes View of the Daily and Weekly Agenda pages, the Month View of the Monthly 
Agenda page and in the In-tray.



The Attending but Would Like to Reschedule Icon
This icon appears in several places. When you see it next to a user name, it indicates that the user will 
attend the event, but would prefer if it were scheduled for another time.
When you're viewing a recurring Entry, the icon can be found next to the dates of recurrences for the 
Entry. Here it indicates that you have answered that you will attend that recurrence, but would prefer if it 
were scheduled for another time.



The Not Attending but Would Like to Reschedule Icon
This icon appears in several places. When you see it next to a user name, it indicates that the user will 
not attend the event, but would attend if it were scheduled for another time.
When you're viewing a recurring Entry, the icon can be found next to the dates of recurrences for the 
Entry. Here it indicates that you have answered that you will not attend that recurrence, but would attend if 
it were scheduled for another time.



The Recurring Entry Icon
This icon indicates a recurring Entry in your In-tray when you're displaying the list of the Entry's 
recurrences.



The Agenda Entry Icon
This icon will appear next to Entries in your In-tray, indicating Agenda Entries. 



The Upcoming Day Event Icon
This icon is the reminder for an Upcoming Day Event.
It appears in the Notes View of your Daily and Weekly Agenda page.
You can open the corresponding Entry through double-clicking the reminder.



The Upcoming Agenda Entry Icon
This icon is the reminder for an Upcoming Agenda Entry.
It appears in the Notes View of your Daily and Weekly Agenda page. 
You can open the corresponding Entry through double-clicking the reminder.



The Upcoming Task Icon
This icon is the reminder for an Upcoming Task
It appears in the Notes View of your Daily and Weekly Agenda page. 
You can open the corresponding Entry through double-clicking the reminder.



The Upcoming Note Icon
This icon is the reminder for an Upcoming Daily Note.
It appears in the Notes View of your Daily and Weekly Agenda page. 
You can open the corresponding Entry through double-clicking the reminder.



The Task Icon
This icon will appear in the Task View of your Daily Agenda page and in the Task Display.
It indicates that the task is due in the future.



The Overdue Task Icon
This icon will appear in the Task View of your Daily Agenda page and in the Task Display.
It indicates that the Task's due date has passed, but the Task has not yet been marked off as completed.



The Completed Task Icon
This icon will appear in the Task View of your Daily Agenda page and in the Task Display.
It indicates that the Task has been completed.



The Drag & Drop Cursor
This cursor will appear when you click and hold the mouse button on an Entry you can drag to another 
location. 
You can move Entries in this way on the Weekly and Monthly Agenda page and in the In-tray.



The Cannot Drop it Here Cursor
This cursor will appear when you are dragging an Entry to another location, if you drag the Entry to a 
place where you cannot drop it. (For example, if you drag an Agenda Entry in the Month View and try to 
drop it on one of the splitters of the calendar grid.)



The View Resizing Cursor
Use this cursor to resize the views of your Daily, Weekly and Monthly Agenda pages. Click any of the 
splitters that divide the views, and you can drag the splitter to resize the view.



The Moving Cursor
Use this cursor to move a selected Agenda Entry on your Daily and Weekly Agenda pages. When you 
point at any part of the frame around a selected Agenda Entry (other than the two handles at the center of 
the upper and lower edges), this cursor will appear. Click the frame with this cursor, and you can drag the 
Entry to another time slot.



The Resizing Cursor
Use this cursor to change the duration of a selected Agenda Entry on your Daily and Weekly Agenda 
pages. When you point at either of the two handles that appear at the center of the upper and lower 
edges of a selected Agenda Entry, this cursor will appear. Click the handle with this cursor, and you can 
stretch or contract the Entry to change its duration.



The In-tray Button
Click this button on the toolbar to open your In-tray.



The Agenda Button
Click this button on the toolbar to open an Agenda.



The Task Button
Click this button on the toolbar to open your Task Display.



The View Day Button
Click this button on the toolbar to go to the Daily Agenda page.



The View Week Button
Click this button on the toolbar to open the Weekly Agenda page.



The View Month Button
Click this button on the toolbar to go to the Monthly Agenda page.



The Find Entry Button
Click this button on the toolbar to locate the selected In-tray Entry in your Daily Agenda pages.



Increase Time Slot Button
Click this button on the toolbar to increase the time slots in your Agenda pages. A time slot can last up to 
one hour.



Decrease Time Slot Button
Click this button on the toolbar to decrease the time slots in your Agenda pages. You can see your time in 
very fine detail this way. The shortest time slots will show your time in 5-minute intervals.



The Turn Icons On/Off Button
Clicking this button will turn off, or on, some of the icons that appear in the Daily, Weekly and Group 
Agenda pages, as well as the Task Display.



The New Agenda Entry Button
Click this button on the toolbar to open the New Agenda Entry dialog box.



The New Day Event Button
Click this button on the toolbar to open the New Day Event dialog box.



The New Task Button
Click this button on the toolbar to open the New Task dialog box.



The New Note Button
Click this button on the toolbar to open the New Daily Note dialog box.



The Browser Button
Click this button on the toolbar to start up your Netscape browser.



The Print Button
Click this button on the toolbar to call up the Print dialog box or print the current view (it will print the 
current view if you are in the Task Display or the In-tray.)



The About a Day Event Icon
This icon will appear in the Pop-Up Reminder dialog box, in the vCalendar Entry found dialog box, and in 
the Reconciliation dialog boxes, indicating that the dialog box refers to a Day Event.



The About an Agenda Entry Icon
This icon will appear in the Pop-Up Reminder dialog box, in the vCalendar Entry found dialog box, and in 
the Reconciliation dialog boxes, indicating that the dialog box refers to an Agenda Entry. 



The About a Task Icon
This icon will appear in the Pop-Up Reminder dialog box, in the vCalendar Entry found dialog box, and in 
the Reconciliation dialog boxes, indicating that the dialog box refers to a Task.



The Next Reminder Button
This button will appear in the Pop-Up Reminder dialog box. It will bring up the next Reminder, if you have 
more than one Reminder.



The Left Arrow
This button appears on the date control bars of the Daily, Weekly and Monthly Agenda pages, and on the 
Calendar. 
On the Daily Date Control bar, this button will take you to the previous day.
On the Weekly Date Control bar, this button will take you to the previous week.
On the Monthly Date Control bar and the Calendar, this button will take you to the previous month.



The Right Arrow
This button appears on the date control bars of the Daily, Weekly and Monthly Agenda pages, and on the 
Calendar. 
On the Daily Date Control bar, this button will take you to the next day.
On the Weekly Date Control bar, this button will take you to the next week.
On the Monthly Date Control bar and the Calendar, this button will take you to the next month.



The Double Left Arrow
This button appears on the date control bars of the Daily, Weekly and Monthly Agenda pages, and on the 
Calendar. 
On the Daily Date Control bar, this button will take you to the previous week.
On the Weekly Date Control bar, this button will take you to the previous month.
On the Monthly Date Control bar, this button will take you back six months.
On the Calendar, this button will take you back a year.



The Double Right Arrow
This button appears on the date control bars of the Daily, Weekly and Monthly Agenda pages, and on the 
Calendar. 
On the Daily Date Control bar, this button will take you to the next week.
On the Weekly Date Control bar, this button will take you to the next month.
On the Monthly Date Control bar, this button will take you forward six months.
On the Calendar, this button will take you forward a year.



The Colors Button
This button on the toolbar will call up the Agenda Entry Colors dialog box. It allows you to quickly change 
the color scheme of your Agenda Entries, without having to change your Agenda Preferences.



The Paperclip
This icon will appear on Agenda Entries and Tasks in your Daily and Weekly Agenda pages, as well as in 
your Task Display.
It indicates that there is a file attached to the Agenda Entry or the Task. To open the Attachment, go to the 
Details tab of the Entry.



New Entries Alert
This icon will appear in your status bar, indicating there are new Entries in your In-tray.



The Off-line Icon
This icon is displayed to the right on the Status bar. It indicates that you are currently working Off-line, i.e. 
without a connection to the server.



The On-line Icon
This icon is displayed to the right on the Status bar. It indicates that you are currently working On-line, i.e. 
with a connection to the server.



The Add/Delete Button
This button is displayed on the Date Control bar of the Group Agenda. Click it to call up the Selection for 
Group Agenda dialog box, where you can add or delete people and resources in your Group Agenda. 



The About a Note Icon
This icon will appear in the Pop-up Reminder dialog box, in the vCalendar Entry found dialog box, and in 
the Reconciliation dialog boxes, indicating that the dialog box refers to a Daily Note.



The Netscape Calendar Icon
This icon will appear on your screen when you minimize the Agenda's window.



The Alert Icon
When the Agenda's window is minimized, the Netscape Calendar icon will change to this Alert icon when 
new Entries have appeared in your In-tray.



The Upcoming Holiday Icon
This icon is a reminder for an Upcoming Holiday.
It appears in the Notes View of your Daily and Weekly Agenda page. 
You can open the corresponding Entry through double-clicking the reminder.



The Shorter Rows Button
Clicking this button will make the rows in your Agenda's Day and Week Views shorter, which allows you 
more overview without changing the time slots



The Taller Rows Button
Clicking this button will make the rows of your Agenda's Day and Week Views taller. This way you can 
see more details without changing the time slots.



There's More Entries Above
This icon appears in the Date Control Bar of the Daily, Weekly and Group Pages. It indicates that there 
are more Entries earlier, which are not being displayed. Scroll up to see these Entries.



There's More Entries Below
This icon appears in the Date Control Bar of the Daily, Weekly and Group Pages. It indicates that there 
are more Entries later, which are not being displayed. Scroll down to see these Entries.



The Holiday Reminder Icon
This icon will appear in the Pop-up Reminder dialog box, when the reminder is about a Holiday.



The Group Agenda Button
This toolbar button calls up the Selection for Group Agenda dialog box, where you select users for a 
Group Agenda. (A Group Agenda shows the Daily Agenda pages of several users in one view.)



The Closed Recurring Entry Icon
This icon indicates a recurring Entry in your In-tray when the list of the Entry's recurrences is not 
displayed.



The Red 'X'
This icon appears in the Month View of your Monthly Agenda page, next to Agenda Entries that you have 
refused.



Group Types
There are four group types: public, private, administrative and members only. Not all types will be 
available in every case or to every user. Some dialog boxes have an All button to display all groups. 

· Public groups are available for use to everyone on the system.

· Private groups are only available for use by their creators.

· Administrative groups are only available for use by those people who have been given the right to 
create and administer them (the System Operator controls this).

· Members Only groups are available for use only to the members of the group.



On-line
Connected to the server.



Off-line
Not connected to the server. You cannot view other users' Agendas, except those you have downloaded 
with your Off-line Agenda.



Organization unit 
This can be any subdivision of your organization and is related to your e-mail address. For more 
information, consult your e-mail software manual.



Domain
The domain makes up part of your e-mail address. For more information, consult your e-mail software 
manual.



E-mail
This is a contraction of the term electronic mail. It is the system that sends messages from one computer 
terminal to another.



Time slot
A time slot is the individual block of time represented on your Agenda's Day and Week Views as a 
rectangle. You can adjust the time each square represents (i.e. the size of the time slots) by: 

· using the Increase time slot or Decrease time slot buttons on the toolbar;

· using the Increase Time Slot or Decrease Time Slot commands on the Edit Menu; or,

· choosing Preferences from the Edit Menu, selecting Agenda, and setting the time increments on the 
Display tab of the Agenda Preferences dialog box.



Resource
A resource is an inanimate object that has its own Agenda, such as a conference room or a piece of 
equipment.



Server
The server is the computer to which the workstations of a network are connected. It is where the 
centralized database of all the user data is kept.



Search Parameter
Defines your search by restricting it to a specific set of information.



Default
The pre-set selection for an option. It is the option the program will use if you do not specify otherwise.



Entry
Anything that appears in the In-tray or your Agenda pages (Agenda Entries, Tasks, Daily Notes, Holidays, 
Day Events, etc.).



Time Selection

The Time Control is displayed when you click  next to a Time box.

This is another way of setting the time in a Time box: 

1. Select the left or right arrow, until the blue arrow is aligned with the desired time—the Time Control is 
set to move in one-hour intervals when you click the arrows. The time you have selected will be 
displayed in the corresponding Time box.

You can also click the blue arrow and drag it until it points at the desired time. When you choose to do 
this, the Time Control moves in 15-minute intervals.
Finally, if the desired time is visible in the Time Control, you can simply click it directly on the Time 
scale to select it.

2. Choose OK.



Importance level
Your Agenda can assign your Agenda Entries different levels of importance.
If you color code your Entries by Importance, they will appear as follows:

Extremely Important

Very Important

Normal Importance

Not very Important

Not Important



Attendance Status
The Attendance Status of an Agenda Entry indicates how you have (or have not) responded to it. Agenda 
Entries color coded by Attendance Status appear as follows:

Accepted Agenda Entries;

Unconfirmed Agenda Entries;

Refused Agenda Entries;

Accepted tentative Agenda Entries;

Unconfirmed tentative Agenda Entries;

Refused tentative Agenda Entries.



Ownership
An Agenda Entry is owned by the person or resource who proposed it. If you color code your Agenda 
Entries according to Ownership, they will appear as follows:

Agenda Entries owned (i.e. proposed) by you;

Agenda Entries that you have been invited to;

Tentative Agenda Entries owned (i.e. proposed) by you;

Tentative Agenda Entries that you have been invited to.

Please note that when you choose to color code Agenda Entries by ownership, and you open another 
user's Agenda, the Agenda Entries you (and not the Agenda's owner) have proposed will appear in blue. 
This makes it easier for you to spot Agenda Entries you can edit in other users' Agendas. (Even if you are 
in another user's Agenda, you can still edit an Entry you have proposed.) However, if you are working in 
someone else's Agenda as a designate, it will be the Agenda Entries proposed by the Agenda's owner 
that will appear in blue, since you are working in that person's Agenda as though you were the owner.



Access Level
This controls who can access an Entry's information. There are four levels of access:
Normal, Confidential, Personal, and Public.



Creator
The person who creates an Entry. An Entry's creator is not necessarily the person who proposes it, since 
they may have created it while working as a designate in someone else's Agenda.



Designate
Someone who has the right to modify the Entries of another user, in that user's name. Designates can 
perform those operations specified by the Access Rights that the other user has granted them. However, 
you can never set other users' (or your own) Access Rights while working as a designate for someone 
else.

To grant someone designate rights, choose Preferences from the Edit Menu and select Access Rights.



Tentative
Tentative Agenda Entries are not yet official and final. To confirm a tentative Agenda Entry, clear the 
Tentative check box on the General tab of the Edit Entry dialog box.



The Status Bar
The status bar is displayed at the bottom of the window. To display or hide the status bar, use the Status 
Bar command in the View Menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to navigate 
through menus. This area similarly shows messages that describe the actions of toolbar buttons as you 
depress them.
An icon in the middle of the status bar notifies you when new Entries come in from other users. 
On the far right-hand side of the status bar, an icon indicates whether you are currently On-line or Off-line.
Also on the right, a bell icon is displayed when the Pop-up Reminder feature is turned on.



The Toolbar
The toolbar is displayed across the top of the application window, below the menu bar. The toolbar 
provides quick mouse access to many tools used in your Agenda.

To hide or display the Toolbar, choose Toolbar from the View Menu.



Node
A node is a database located on a server. There may be, and often are, several nodes on one server.
Nodes are identified by a number.



Foreign user
A person who does not have an Agenda but is listed on the server. These users can be invited to Entries. 
They will receive their invitations by e-mail.



Remote user
This is a user whose Agenda is on a different server. They can be invited to Entries in the same way as 
local users.
However, a remote user cannot act as a designate.



Local user
A user on the same server.



Day Event
A Day Event is an Entry that lasts for, or is valid for, an entire day. However, it does not block out any time 
in your Agenda's Day View. You can still schedule Agenda Entries for all of the day when a Day Event has 
been scheduled. Day Events are displayed in the Notes View of you Agenda's Daily and Weekly pages 
and in the Month View. They can be either one-time events or recurring events, and you can invite others 
to your Day Events.



Daily Note
A Daily Note is a note you can enter into your Agenda. It does not have a time, but only a date that it is 
displayed on. Daily Notes can be up to 64 characters long, and are displayed in the Notes View of you 
Agenda's Daily and Weekly pages and in the Month View. They can be either one-time notes or recurring 
ones, and you can send others copies of your Daily Notes.



Task
You can enter Tasks in your Agenda. These can either be linked to an Agenda Entry or be independent. A 
Task can have a start date and due date, a start time and due time, as well as a Priority and Access 
Level.



Attachment
You can attach a file to an Agenda Entry or Task using the Details tab of the New Agenda Entry/Task or 
Edit Entry/Task dialog boxes. Attached files allow you to include necessary material with an Agenda Entry 
or Task. Currently, only one file may be attached to any given Agenda Entry or Task. Attachments are not 
supported when you are working off-line.



Agenda Entry
Agenda Entries are those Entries that are scheduled in your Agenda's Day or Week Views. The Event of 
an Agenda Entry may be a meeting, a course etc.—in short, anything that can be put into a time 
schedule. 
You can include the location of the meeting in your Agenda Entry. You can invite other users to your 
Agenda Entries and you can make them recurring. If you're not completely certain of all the details 
concerning your Agenda Entry (such as time, location etc.), you can make it tentative. If you delete an 
Agenda Entry, or make any changes to it, this will automatically be done in the invited users' Agendas as 
well.



Associate

In order for you to be able to open an attached file, it must be associated with an application capable of 
reading it. If your system cannot find an application to open an attached file, it will ask you to associate 
the file with the appropriate application.



Reconciliation
Reconciliation is the process in which you make two versions of the Agenda consistent with one another, 
through reconciling the Entries that cause inconsistencies (i.e. you decide which version of the Entry you 
want to keep). You may need to go through a reconciliation process when you upload your Off-line 
Agenda to your On-line Agenda, and when you import from or export to your palmtop.



Propose
An Entry is proposed by the person or resource in whose name it was created. That is, you propose an 
Entry if you create it while working in your own name (i.e. not working as someone else's designate). But 
Entries created by your designates while they are working in your name are also considered to be 
proposed by you.

For color coding purposes, you own the Agenda Entries that you have proposed. If you color code your 
Agenda Entries according to Ownership, they will appear as follows:

Agenda Entries owned (i.e. proposed) by you;

Agenda Entries that you have been invited to;

Tentative Agenda Entries owned (i.e. proposed) by you;

Tentative Agenda Entries that you have been invited to.
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